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Preface

This guide describes how to set up personalized content to enhance how users interact 
with your portal application.

Audience
Portal developers find information in this guide on creating property sets, user 
segments, campaigns, and other rule-based entities for user interaction. These entities 
define how personalized content is delivered to end users. Portal administrators use 
this guide to learn about changing and managing interaction entities using the Portal 
Administration Console. 

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
For more information, see the following documents in the WebLogic Portal 
documentation set:

■ Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal

■ Oracle Fusion Middleware User Management Guide for Oracle WebLogic Portal

■ Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal

Conventions
The following text conventions are used in this document:
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.



Part I
Part I Architecture

This section contains guidelines to help you plan the type of user interaction you will 
add to your portal. Developing a user interaction strategy can save you time during 
the other phases of the portal life cycle.

When you are planning how your users will interact with your portal, determine the 
following:

■ What type of personalized content to display 

■ How to set up and store content

■ If content will be controlled by the type of user

■ How long to display each type of content

■ How to cycle through content

■ If you want to send automatic e-mails or give automatic discounts

■ Where to store the user information you gather

For a detailed description of the architecture phase of the portal life cycle, see the 
Oracle Fusion Middleware Overview for Oracle WebLogic Portal. 

Part I contains the following chapters:

■ Chapter 1, "Introduction"

■ Chapter 2, "Planning an Interaction Strategy"

■ Chapter 3, "Setting up Content"
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1Introduction

Personalized content can include content or images targeted to specific users or 
audiences. For example, you can create dynamic images or links that are personalized 
for each user. You could dynamically guide users through a process (such as signing 
up for employee benefits or shopping online) that takes them to different places based 
on their personal preferences or characteristics. 

You can even record the path users take through your portal to gauge the effectiveness 
of the portal, its design, or your process flows. This Behavior Tracking provides 
information that can validate your strategies or help you make improvements.

This chapter includes the following sections:

■ Section 1.1, "Introducing Personalization"

■ Section 1.2, "Interaction Management in the Portal Life Cycle"

■ Section 1.3, "Getting Started"

1.1 Introducing Personalization
This section contains the following topics:

■ Section 1.1.1, "Using Interaction Management Tools"

■ Section 1.1.2, "Understanding the Features"

Developers use Oracle Enterprise Pack for Eclipse (OEPE) to set up Personalization 
features, such as Campaigns, Content Selectors, Placeholders, User Segments, and 
Rule Sets. Developers can also create rules for Personalization and events for Behavior 
Tracking. Portal administrators use the WebLogic Portal Administration Console to 
modify Campaigns, Content Selectors, Placeholders, and User Segments to fit the 
needs of the portal's audience.

Developing Interaction Management features often involves setting up related pieces. 
For example, if you want to target users with personalized content in a Campaign, you 
have to add content to WLP's Virtual Content Repository, create Placeholders that 
display the content, set up properties (such as User Profile or session properties) that 
are used to define the conditions under which users will be targeted with Campaign 
content, and finally, create the Campaign.

This chapter describes the tools you can use to create Interaction Management features 
and the logic that drives the tools. Each tool uses a rules engine to match users with 
appropriate content.
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1.1.1 Using Interaction Management Tools
You can use the following tools to create and maintain Interaction Management 
features in the portal life cycle:

1. Oracle Oracle Enterprise Pack for Eclipse – Developers create the following 
items:

■ User Segments, Property Sets, Content Selectors, Placeholders, Campaigns and 
Behavior Tracking – Create these Personalization features and then use Java 
Server Page (JSP) tags or controls to enable the feature in a Page Flow or JSP.

■ JSP Tags – Use JSP tags to display personalized content to users. For example, 
Campaigns show web content using a JSP tag called a Placeholder: 
<ph:placeholder name="myPlaceholder1"/>. You can add JSP 
Placeholder tags (identified by the name attribute) anywhere in your portal's 
JSPs. For more information on Java classes, see the Oracle Fusion Middleware 
JSP Tag Java API Reference for Oracle WebLogic Portal.

■ Java Controls – Use Java controls (predefined Java functionality) in your Page 
Flows and Web Services to display personalized content. For example, you can 
use the Rules Executor control to help determine a user's path through a Page 
Flow based on specific conditions, such as User Profile values or session 
properties. For more information on controls, see the Oracle Fusion Middleware 
Java API Reference for Oracle WebLogic Portal. 

2. Java API – Developers can also utilize a full API to programmatically develop 
Interaction Management functionality.

3. WebLogic Portal Administration Console – Portal Administrators can modify 
values and some properties for User Segments, Property Sets, Content Selectors, 
Placeholders, and Campaigns. They can also change the target audience that will 
see Personalization features, or modify Campaign dates. Administrators can use 
the Administration Console to test the new features you have developed and 
adjust the target audience. If you need to modify or fine tune any of them, you can 
use Oracle Enterprise Pack for Eclipse to return to the Development phase and 
make changes. You must redeploy your portal application to see the changes in the 
Staging environment.

1.1.2 Understanding the Features
Oracle Enterprise Pack for Eclipse provides the following features to help you deliver 
personalized content:

■ Property Sets – A Property Set Editor lets developers define User Profile 
properties, request properties, session properties, and custom events to create 
conditions that uniquely identify users. For example, you can create a NewHire 
property to target new users with benefit enrollment information. An Employee 
property set could have an attribute (or property) called NewHire, as well as 
HireDate.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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■ User Segments – User Segments help you dynamically categorize users based on 
conditions or criteria that define the target visitor. For example, you can define 
conditions that dynamically identify gender, occupation, movie fans, or pet lovers. 

■ Content Selectors – A Content Selector targets users with personalized web 
content from the WLP Virtual Content Repository. For example, you can display a 
list of recommended movies to users identified as movie fans.

■ Campaigns – Campaigns let you target specific users with a single piece of 
personalized content or automatically send them a predefined e-mail.  Campaigns 
run for a limited time and drive online behavior and Personalization to achieve a 
specific business goal.

■ Placeholders – Campaigns use Placeholders to display personalized content on a 
portal page. A Placeholder is a predefined location in a JSP that displays a single 
piece of web content retrieved from the WLP Virtual Content Repository. A 
Placeholder uses queries to retrieve and display content, and can rotate the content 
to display something different on each browser refresh. Campaigns are targeted to 
Placeholders.

■ Events and Behavior Tracking – Events let you create actions that happen in a 
user's interaction with your portal, or respond to actions that occur. Events, such 
as a user clicking a button or registering in your portal, can trigger a Campaign. 
You could generate an event when a user logs in or logs out. You can also use a 
Campaign to respond in real time to an event. For example, if a user clicks an 
image, an event is generated. You would know which image is clicked and you 
can display other information in another portlet. For example, you clicked a 
camera image and camera accessories display in another portlet.

See Chapter 2 for more details and examples of each type of interaction.

The following terms are used in this guide:

■ Authentication – Registers (verifies) the user and logs the user into the portal.

■ Authorization – Determines what the user can access.

1.2 Interaction Management in the Portal Life Cycle
This section contains the following topics:

■ Section 1.2.1, "Architecture"

■ Section 1.2.2, "Development"

■ Section 1.2.3, "Staging"

■ Section 1.2.4, "Production"

The tasks in this guide are organized according to the portal life cycle. The portal life 
cycle contains four phases: Architecture, Development, Staging, and Production. 
Adding Personalization and user interaction to your portal is an important part of the 
portal life cycle. For more information about the portal life cycle, see the Oracle Fusion 
Middleware Overview for Oracle WebLogic Portal.

1.2.1 Architecture
In the Architecture phase, you plan the type of interaction that your portal users will 
experience. Architects decide who to target, what type of personalized content users 
will see, how often the content changes, and how to update the content. For more 
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information about the portal life cycle, see the Oracle Fusion Middleware Overview for 
Oracle WebLogic Portal.

The following chapters provide guidance on Architecture tasks:

■ Chapter 2 describes when to use different types of Personalization and explains 
the relationships between the Interaction Management features.

■ Chapter 3 describes the properties you can add to content items in the WLP 
Virtual Content Repository that support Interaction Management functionality.

1.2.2 Development
In the Development phase, developers use Oracle Enterprise Pack for Eclipse to create 
user property sets and properties, User Segments, Placeholders, Content Selectors, 
Campaigns, and Behavior Tracking to add Personalization without custom coding. 
Developers can also work directly with the Java API to add Personalization.

Personalization features allow you to target users with personalized web content, 
display a single piece of web content retrieved from the WLP Virtual Content 
Repository, or automatically send a user a predefined e-mail.

Developers can also categorize users based on specific characteristics or criteria and 
then target those User Segments.

Tools: Oracle Enterprise Pack for Eclipse and the Java API.

The following chapters provide instructions on Development tasks:

■ Chapter 4 provides instructions on how to set up conditions that drive Interaction 
Management and the choices you need to make.

■ Chapter 5 describes how to dynamically group users based on conditions you 
define.

■ Chapter 6 describes Content Selectors and how to use them to display multiple 
personalized content items from the virtual content repository.

■ Chapter 7 describes Placeholders and how to use them to display single content 
items from the Virtual Content Repository. This chapter describes how to use 
Placeholders by themselves to display non-personalized content and how to use 
them with Campaigns to display personalized content.

■ Chapter 8 provides the setup steps and things to consider when building a 
Campaign.

■ Chapter 9 describes the event framework and when to use predefined Behavior 
Tracking events. The chapter also discusses when and how to create regular events 
and custom events for Behavior Tracking, and how to use events in a Campaign.

■ Chapter 10 explains how to customize rules to create advanced Personalization. 
This type of Personalization can help you do things like control each user's path 
through a Page Flow or use runtime information to determine conditional logic.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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1.2.3 Staging
In the Staging phase, portal administrators use a browser to test the Content Selectors, 
Placeholders, Campaigns, and so on that developers created in the Development 
phase. If any of the functionality needs to change, you can use the Administration 
Console to make changes, or return to the Development phase and use Oracle 
Enterprise Pack for Eclipse and make changes. Developers can also utilize the Java 
API. Developers must redeploy the portal application to see the changes in the Staging 
environment. The Development phase and the Staging phase often occur 
simultaneously.

Tools: Administration Console.

The following chapters provide instructions on Staging tasks:

■ Chapter 11 shows how to change the values in your User Profile property sets.

■ Chapter 12 describes how to change User Segment properties (conditions) to 
dynamically group users.

■ Chapter 13 provides the steps to edit a Content Selector property, so that you can 
change the content that is displayed.

■ Chapter 14 shows how to manage the content that populates Placeholders. 

■ Chapter 15 gives instructions on making changes to a Campaign, including the 
start or stop date and modifying the query user name.

1.2.4 Production
After developers test the portal application in the Staging phase, portal administrators 
use the Production phase to fine-tune the live production environment. For example, 
in the Production phase, administrators could use the Administration Console to 
modify Placeholders, Content Selectors, or Campaigns. They can change a Campaign's 
effective dates, update web content, or add a new User Segment to attract a different 
audience.

If you need to change any of these features, developers can use Oracle Enterprise Pack 
for Eclipse to return to the Development phase and make changes. Developers must 
redeploy the portal application to see the changes in the Staging and Production 
environments.

Tools: Administration Console.

1.3 Getting Started
If you are new to portal development, see the Oracle Fusion Middleware Overview for 
Oracle WebLogic Portal for more information about the portal life cycle.

You can also consult the following information:

■ Oracle Fusion Middleware Overview for Oracle WebLogic Portal

■ Oracle Fusion Middleware Security Guide for Oracle WebLogic Portal

■ Oracle Fusion Middleware User Management Guide for Oracle WebLogic Portal
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2Planning an Interaction Strategy

This chapter describes when to use different types of Personalization and explains the 
relationships between the Interaction Management features.

This chapter includes the following sections:

■ Section 2.1, "Choosing the Type of Interaction Management to Develop"

■ Section 2.2, "Checklist for Planning Your User Interaction Strategy"

■ Section 2.3, "Checklist for Planning Your Campaign Strategy"

■ Section 2.4, "Planning Your Behavior Tracking Strategy"

■ Section 2.5, "Updating Interaction Management Features"

■ Section 2.6, "Upgrading Interaction Features from Portal 8.1"

2.1 Choosing the Type of Interaction Management to Develop
Use Table 2–1 to determine which type of Interaction Management to develop.

This section contains the following topic:

■ Section 2.1.1, "Understanding Conditions"
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Table 2–1 Types of Interaction Management

If you want to ...do this

Display different graphics – each 
time an employee visits the 
Intranet portal, display a different 
picture from the company picnic.

This action displays a binary 
property from a single content item 
from the virtual content repository 
that can change each time a user 
visits your portal or clicks Refresh.

■ Create a generic rotation of content for all users by creating a 
Placeholder and adding a default query for the Placeholder that 
displays the range of content you want.

■ Create a targeted rotation of content for each user based on each user's 
characteristics by creating a Placeholder and a Campaign.

■ Set up the Campaign with content actions that put different types of 
content in the Placeholder for different types of users.

■ Define the necessary conditions and rules to use in the Campaign.

You can also use the <ad:adTarget> JSP tag as an alternative to a 
Placeholder to manually embed a content query in a JSP.

See Chapter 7 for more information.

Display a graphic specific to the 
user type – when a certain type of 
user visits the portal, display a 
graphic specific to the user type.

For example, if a manager user 
views the portal, show the 
manager the performance review 
reminder graphic. If a regular 
employee user views the portal, 
show the employee the benefits 
open enrollment graphic.

This action displays a binary 
property from a single content 
node from the Virtual Content 
Repository that shows the same 
content node for each type of user.

Target specific users differently by creating a Placeholder with a default 
query for all users or a Placeholder used by a Campaign to target specific 
users differently. Use one of the following ways to show the same content 
node without content rotation:

■ Set up your content with properties and values that can uniquely 
identify each piece of content.

■ Create highly focused content queries in the Placeholder or the 
Campaign to retrieve those single unique content items.

See Chapter 7 and Chapter 8 for more information.

Show each user a unique list of 
recommended books – the list is 
based on the user's characteristics.

This action displays multiple 
content nodes and properties from 
the virtual content repository 
simultaneously.

Show multiple content nodes from the Virtual Content Repository 
simultaneously by creating Content Selectors and adding them to your JSPs.

See Chapter 6 for more information.

Show content that matches a user's 
characteristics – provide different 
sections of HTML content in a JSP 
but show users only the sections 
that match their characteristics.

This action displays personalized 
content from an inline section of a 
JSP.

Display personalized inline JSP content by creating User Segments and 
using the <pz:div> JSP tag to wrap personalized content.

You can also use the following JSP tags to display inline JSP content based 
on the device that is viewing the content (for example, a handheld device or 
a PC): <cscm:default>, <cscm:not-default>, <cscm:recognized>, 
<cscm:not-recognized>, <cscm:when>, and <cscm:when-not>. The 
cscm tags are Portal Multichannel JSP tags. The are contained in the 
client_taglib.jar file.

See Chapter 6 and the Oracle Fusion Middleware JSP Tag Java API Reference for 
Oracle WebLogic Portal for more information.

Send users automatic e-mails. Create and store e-mail message files and create a Campaign that uses an 
e-mail action. See Chapter 8.

Use rules in Page Flows and Web 
Services to provide a personalized 
user experience

Use the Rules Executor control in your Page Flows and Web Services. See 
Chapter 10. 

Note: Page flows are a feature of Apache Beehive, which is an optional 
framework that you can integrate with WLP. See "Apache Beehive and 
Apache Struts Supported Configurations" in the Oracle Fusion Middleware 
Portal Development Guide for Oracle WebLogic Portal.
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2.1.1 Understanding Conditions 
Interaction Management uses a variety of conditions that identify users and what they 
are doing. 

When you build Interaction Management functionality, you use conditions to perform 
the following actions:

1. Specify the exact characteristics that identify the users you want to target

2. Define the actions that occur when users that match those conditions visit your 
portal

Figure 2–1 illustrates how personalized content is dynamically displayed to users with 
a Content Selector. Conditions are captured, specific users are identified, and actions 
occur for those users.

Figure 2–1 Simple Example of Interaction Management Logic and Flow 

A rules engine runs behind the scenes on a server in a portal domain, reads all 
available conditions in memory, evaluates those conditions against the rules you 
created, and executes the actions you defined if the conditions match your rules.

For example, the following list contains some of the conditions that a Campaign can 
use to determine which users to target with personalized content:

■ Dynamically predefined groups of users (User Segments).

■ Properties in a User's Profile (such as personal preferences).

■ Specific properties in the HTTP request or session.

■ An event that occurs (such as performing a click).

■ Date and time factors.

2.2 Checklist for Planning Your User Interaction Strategy
Adding Personalization to your portal can involve setting up several related pieces. 
The checklist in Table 2–2 includes items that you should consider when planning a 
personalized portal. 
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Table 2–2 User Interaction Strategy Checklist

Check box Planning Item Description

[ ] 1. Create content Determine the content you want to display, when it should display, 
and set specific properties on your content items. For example, you can 
use Oracle Enterprise Pack for Eclipse to add properties to your 
content that can make an image clickable, end a Campaign after a 
specific number of clicks, start a movie, provide a clickable URL, and 
so on. See Chapter 3 for instructions. You should also consult the 
Oracle Fusion Middleware Content Management Guide for Oracle WebLogic 
Portal for information on creating and maintaining a virtual content 
repository.

[ ] 2. Set up Property Sets and 
properties

Property sets use properties to create conditions that uniquely identify 
users. The properties you create in Oracle Enterprise Pack for Eclipse 
are used in the conditions you define for your Personalization logic. 
For example, you could create a NewHire property set to target these 
users with benefit enrollment information.

Oracle Enterprise Pack for Eclipse provides editors to help you define 
the following properties to create conditions that identify users:

■ User Profile properties determine which user information to save. 
User Profile properties can also be used to define Visitor 
Entitlement and Delegated Administration roles.

■ Request properties capture and use specific HTTP request 
information to trigger Personalization.

■ Session properties capture and use specific HTTP session 
information to trigger Personalization.

■ Custom Events can trigger Personalization and Campaigns and 
track user behavior.

Based on the logic conditions, each user is dynamically served 
personalized, accurate web content, and automatic e-mails. See 
Chapter 4 for instructions.

[ ] 3. Set up users Access existing users in external databases or add new users to your 
portal. For instructions on setting up and managing users, see the 
Oracle Fusion Middleware User Management Guide for Oracle WebLogic 
Portal.

[ ] 4. Create User Segments You can create User Segments to dynamically categorize users based 
on conditions or criteria that define the target visitor. Those conditions 
can include characteristics, such as occupation, browser type, User 
Profile values, or other user properties.

For example, you could classify all users who ordered more than five 
on-demand movies in the last 30 days If visitors match the defined 
characteristics, they automatically become members of that User 
Segment and are shown specific web content with Content Selectors or 
are targeted with Campaign Actions.

User Segments can be used over and over in Content Selectors, 
Placeholders, and Campaigns. See Chapter 5 for instructions.

[ ] 5. Create Content Selectors A Content Selector lets you target specific groups of people with 
content items from the WLP Virtual Content Repository. For example, 
after you create a User Segment to trigger Personalization, you can 
create a Content Selector that defines the content that is shown to users 
in a specific User Segment. You could display a list of recommended 
movies to users identified as movie fans. For instructions, see Chapter 6.
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One of the most important benefits of using Interaction Management is that the logic is 
decoupled from your source code. The files you create (Campaigns, Placeholders, 
Content Selectors, and so on) contain the Personalization logic and content queries, 
and your code references those files. For example, Campaigns show web content using 
a JSP tag called a Placeholder.

The next step is to define your Campaign to use the existing Placeholders, each of 
which can display content unique to the Campaign and to the individual users. 
Campaigns can change and new ones can be added, but you never have to change 
your JSP code. The Placeholders you need in the JSPs stay the same.

2.3 Checklist for Planning Your Campaign Strategy
Campaigns provide a broad set of features for delivering personalized functionality, 
such as displaying personalized web content, and triggering e-mail messages. For 
detailed information about campaigns, see Chapter 8.

The following sample use cases illustrate some ways to use Campaigns to deliver 
personalized content and functionality:

■ A company provides open benefits enrollment for its employees, where employees 
can change their current benefits choices. In the internal Human Resources portal, 
the company creates a Campaign that runs from November 1 - 30. During that 
time the Campaign displays an Open Enrollment graphic in the portal header 

[ ] 6. Create Placeholders A Placeholder displays a single personalized content item on a JSP. The 
content item is dynamically retrieved from the WLP Virtual Content 
Repository.

A Placeholder uses queries to retrieve and display one piece of content 
at a time. For example, if a user is identified as a bird lover, a 
Placeholder in a Campaign can display an image of a bird with a store 
discount. The image can change with a browser refresh to show other 
birds as well. You can also use Placeholders by themselves to display 
specific types of non-personalized content that is not provided by a 
Campaign. See Chapter 7.

[ ] 7. Create Campaigns A Campaign lets you target specific users with a single piece of 
personalized content at a time, automatically send them a predefined 
e-mail.

Campaigns run for a limited time and drive online behavior and 
Personalization to achieve a specific business goal. Your Marketing 
Department generally drives the content of a Campaign. For 
instructions, see Chapter 8.

[ ] 8. Set up Behavior 
Tracking

You can use events to trigger Campaigns, persist event data in the 
database, and other actions. Events are generated when users interact 
with a web interface, such as logging in, clicking or viewing a graphic, 
clicking a button, navigating to another page in a portal, and so on. 
These events that occur in a user's path through your portal are logged 
to the database, so you can analyze the user behavior in your portal. 
For example, you could determine how many users have registered in 
a portal and then create a Campaign that automatically sends each 
user a welcome e-mail when the registration event occurs.

You can also be notified of custom events at runtime and respond 
accordingly. You might decide to forward events to another system or 
make runtime decisions on the basis of those events.

See Chapter 9 for more information.

Table 2–2 (Cont.) User Interaction Strategy Checklist

Check box Planning Item Description
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region and when employees make changes to their benefits and click Submit, a 
confirmation e-mail is automatically sent.

■ A large online retailer is running a holiday special for its external customers. The 
retailer creates a Campaign that provides a one-time discount of 30% off the cost of 
books when the total cost of books in any order is $100 or more.

■ A mobile devices ISP creates a Campaign that shows targeted add-on services that 
are specific to each type of mobile device when users click the New Stuff! link.

If you plan to use a Campaign in your portal, use the checklist in Table 2–3. 

Note: Campaigns and Behavior Tracking are not currently supported 
for anonymous, non-trackable users. See the Oracle Fusion Middleware 
User Management Guide for Oracle WebLogic Portal.

Table 2–3 Campaign Strategy Checklist

Check box Planning Item Notes

[ ] 1. Create a Portal application See the Oracle Fusion Middleware Tutorials for Oracle WebLogic Portal. 

[ ] 2. Set up content When you show personalized content with a Campaign (using a 
content rule), the content is retrieved from the WLP Virtual 
Content Repository and displayed in a Placeholder. There are 
many properties you can add to your content that enable necessary 
and helpful features for Campaigns For example, to increase the 
chances of a specific content item being shown in a Placeholder, 
create an adWeight property (as an Integer) for your content items. 
The greater the adWeight number you enter for a content item, the 
greater the chances that it will be displayed in a Placeholder if it is 
retrieved by a query.

For more information on setting up content for use in Interaction 
Management, see Chapter 3.

[ ] 3. Decide if you will use Goal 
Setting

Goal Setting ends a Campaign based on the number of content 
items displayed or clicked. For more information on Goal Setting, 
see Section 8.2.1, "Planning Your Campaign Logic" and 
Section 8.2.2.1, "Setting Goal Definitions."

[ ] 4. Create Placeholders Campaigns use Placeholders to display personalized web content. 
If you display personalized content through Campaigns, create the 
Placeholders that will hold your Campaign queries and display the 
web content.

For more information on Placeholders, see Chapter 7.

[ ] 5. Create User Segments If you want to trigger a Campaign based on users who are grouped 
dynamically based on specific characteristics, create User 
Segments. For more information on User Segments, see Chapter 5.
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2.4 Planning Your Behavior Tracking Strategy
WebLogic Portal's event framework provides many options for generating and 
handling events, to track the behavior of visitors to your portal. This section provides 
guidelines to help you determine the pieces of the event framework you want to use to 
implement the functionality you need.

This section contains the following topics:

■ Section 2.4.1, "Understanding When to Use a Predefined Event"

■ Section 2.4.2, "Understanding When to Create a Custom Event"

■ Section 2.4.3, "Understanding When to Create a Custom Event Listener"

2.4.1 Understanding When to Use a Predefined Event
WebLogic Portal provides many predefined Behavior Tracking events you can use in 
your applications, described in Section 9.3, "Using Predefined Events." Each event 
collects specific attributes and structures those attributes as XML, and the Behavior 
Tracking listener puts the XML in a buffer to insert into the BT_EVENT database table.

Most of the predefined events also have predefined event property sets in Oracle 
Enterprise Pack for Eclipse, stored in the portal application's /data/src/events 
directory. These property sets let you use events in your Campaign definitions to 
trigger Campaign actions when the events occur or when events have specific attribute 
values.

The following list explains when to use WebLogic Portal's predefined events:

■ You want to store event data as XML in the BT_EVENT table

■ The predefined events capture specified attributes

■ The events capture the attributes you want, but you want to handle the events in a 
customized way by creating your own event listener

■ You want to use the events in your Campaign

[ ] 6. Create Property Sets If you plan to trigger a Campaign based on properties from users, 
events, HTTP sessions, or HTTP requests, perform the following 
relevant procedures:

■ Create User Profile properties

■ Register Custom Events

■ Create Session Properties

■ Create Request Properties

For more information on how these properties are used in 
Interaction Management, see Section 4.1, "Setting up a Property 
Set."

[ ] 7. Set up e-mail messages You can send automatic e-mails in a Campaign. Follow the steps in 
Section 8.2.5, "Setting Up Automatic E-Mail Messages."

[ ] 8. Trigger the Campaign Set up a Regular or Behavior Tracking event that start your 
Campaign. A commonly used event is SessionLoginEvent. For 
instructions, see Section 8.4, "Triggering a Campaign."

See Section 9.11, "Using Events in Campaigns" and Section 9.11.1, 
"Registering Events for Campaigns" for instructions.

Table 2–3 (Cont.) Campaign Strategy Checklist

Check box Planning Item Notes
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2.4.2 Understanding When to Create a Custom Event
If none of WebLogic Portal's predefined events capture the specific combinations of 
attributes you need, create a custom event. There are two types of custom events you 
can create: Behavior Tracking events and regular events.

See Chapter 9 for instructions on setting up events.

2.4.2.1 Planning Behavior Tracking Events
Create a custom Behavior Tracking event when none of Portal's predefined events 
captures the event attributes you want and you want to use Portal's Behavior Tracking 
framework to persist event data as XML in the BT_EVENT table. You can use these 
events in Campaigns and create a custom listener that performs special handling on 
the event, but unless you want to use the Behavior Tracking framework to store event 
data as XML, you do not need to create a custom Behavior Tracking event.

If you do not want to use the Behavior Tracking service, create a custom regular event.

2.4.2.2 Planning Regular Events
Create a custom regular event when none of WebLogic Portal's predefined events 
captures the event attributes you want and you do not want to use the Behavior 
Tracking service for persisting event data as XML in the BT_EVENT table.

The following list describes when to create a custom regular event:

■ You want to capture a specific set of attributes with an event and use that event to 
trigger Campaigns

■ You want to capture a specific set of attributes with an event and execute custom 
functionality when that event occurs (using a custom event listener)

2.4.3 Understanding When to Create a Custom Event Listener
WebLogic Portal provides two listeners: a Campaign listener and a Behavior Tracking 
listener.

The Campaign listener tells the Campaign service when an event has occurred (with 
the exception of the ignored events in the wps.jar file's listener.properties 
file). The Campaign service reads the current request and executes Campaign actions if 
the request data matches the conditions of any of your Campaigns. If your Campaign 
definitions include any event conditions, which you were able to supply with event 
property sets, the Campaign service evaluates those as well to determine if it must 
execute Campaign actions.

The Behavior Tracking listener listens for only the Behavior Tracking events that are 
registered with the Behavior Tracking service. When it receives an event it is interested 
in, it moves the XML document for that event into a buffer for later persistence into the 
BT_EVENT table at an interval you determine.

Create a custom event listener if you want to execute functionality not provided by the 
Campaign listener or the Behavior Tracking listener. For example, if you want to 
perform your own event data persistence, modify a User Profile, redirect the user to 
another part of a Page Flow, or provide any other type of real-time response to the 
event, create a custom event listener that provides the functionality you want.
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See Chapter 9 for more information.

2.5 Updating Interaction Management Features
After you create Property Sets, User Segments, Content Selectors, Placeholders, and 
Campaigns in Oracle Enterprise Pack for Eclipse, you can modify the settings and 
queries for those components in the WebLogic Portal Administration Console For 
instructions, see Chapter 11, Chapter 12, Chapter 13, Chapter 14, and Chapter 15.

If you need to create new Interaction Management features or modify properties, use 
Oracle Enterprise Pack for Eclipse and then iteratively push your updates to the 
running server. For more information, see the Oracle Fusion Middleware Production 
Operations Guide for Oracle WebLogic Portal.

2.6 Upgrading Interaction Features from Portal 8.1
When you run the Oracle WebLogic Upgrade Wizard, the wizard upgrades your 
WebLogic Portal 8.1 or 9.2 interaction features, such as Content Selectors, Placeholders, 
Campaigns, and so on.

When you run the Oracle WebLogic Upgrade Wizard and it detects your Portal 8.1 or 
9.2 installation, you can select the Upgrade RDBMSAuthenticator option. Selecting 
this option replaces the existing authentication provider with the new 
SQLAuthenticator authentication provider and upgrades all content, including 
personalization features. You can also choose to manually upgrade your 
personalization features from Portal 8.1 SP4, SP5, or SP6 to the Portal 10.x RDBMS user 
store later. For step-by-step instructions on running the Oracle WebLogic Upgrade 
Wizard, see the Oracle Fusion Middleware Upgrade Guide for Oracle WebLogic Portal.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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Targeting users with personalized content is an important part of Interaction 
Management. You can use Placeholders and Campaigns to control the type of content 
you display and how long the content appears. The first step is to add content types 
and content to your WLP Repository.

This chapter includes the following sections:

■ Section 3.1, "Adding Content"

■ Section 3.2, "Determining Content Priority"

3.1 Adding Content
Use the Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal 
to learn how to add content to your WLP Repository. You can set up a hierarchy of 
folders and add content types (each of which contain properties). Content types 
determine the metadata you associate with a content file and how the content is 
retrieved in a search.

You can create your own custom content types, or use the following five content types 
that ship with WebLogic Portal:

■ Ad Content Type

■ Article Content Type

■ Book Content Type

■ Image Content Type

■ Message Content Type

Plan your content types carefully. You can add a property definition to the content 
type after you have instances of the type. However, you cannot modify or delete 
existing property definitions of the type. Content type properties describe the content 
and help you manage that content. The more properties you associate with content 
items, the more granular your search results can be.

Adding specific properties to content items in your repository can make an image 
clickable, end a Campaign after a specific number of clicks, start a movie, provide a 
clickable URL, and so on. You can also perform repository management with content 
properties by viewing the date (a Content Type property) that the item was added to 
the repository.

Content type properties can be any of the following data types: Boolean, Long Integer, 
Number with a Decimal, String, Date/Time, Binary, Nested Content Type, or Link. See 
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the Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal for 
more information.

If you create Visitor Entitlements on a Content Management resource, these 
entitlements can prevent a portal visitor from seeing content they would normally see 
according to Personalization rules.

3.2 Determining Content Priority
A Placeholder—the JSP tag in a JSP that displays general content or personalized 
content for a Campaign—displays one piece of content at a time. When a content 
query in a Placeholder (a default Placeholder query or a query put in the Placeholder 
by a Campaign) returns multiple possible content items to a Placeholder, the 
Placeholder determines which content item to display. Use a content type property 
called adWeight to change the chance of displaying content in a Placeholder when the 
content items are retrieved with a query.

The adWeight property is an Integer property type. The higher the adWeight number 
you assign to a content item, the better the chance it will display in the Placeholder. 
See Chapter 7 for instructions on using the adWeight property.

Tip: You should set up your content type properties before you 
create Placeholders and Campaigns that access this content.



Part II
Part II Development

Developers use Oracle Enterprise Pack for Eclipse in the Development phase to create 
user property sets and properties, User Segments, Placeholders, Content Selectors, 
Campaigns, and Behavior Tracking. Portal administrators can use the WebLogic Portal 
Administration Console to update some of these features' properties and values.

Developers can use these property sets, User Segments, Placeholders, and Campaigns 
that they create in the Development phase to personalize a portal by performing some 
of the following tasks:

■ Target users with personalized web content (property sets and Content Selectors).

■ Display a single piece of web content retrieved from the WLP Virtual Content 
Repository (Placeholders).

■ Send a user an automatic predefined e-mail (Campaign).

■ Categorize users based on specific characteristics or criteria and then target those 
segments (User Segments).

For a detailed description of the development phase of the portal life cycle, see the 
Oracle Fusion Middleware Overview for Oracle WebLogic Portal. 

Part II contains these chapters:

■ Chapter 4, "Creating a Property Set"

■ Chapter 5, "Creating a User Segment"

■ Chapter 6, "Creating a Content Selector"

■ Chapter 7, "Creating a Placeholder"

■ Chapter 8, "Building a Campaign"

■ Chapter 9, "Setting Up Events and Behavior Tracking"

■ Chapter 10, "Creating Advanced Personalization with Rules"





4

Creating a Property Set 4-1

4Creating a Property Set

Developing user interaction that uses Personalization and Campaigns can involve 
several steps. For example, if you want to target users with personalized content in a 
Campaign, you will add content to WLP's Virtual Content Repository, create 
Placeholders that display the content, set up properties (such as User Profile or Session 
properties) that are used to define the conditions under which users will be targeted 
with Campaign content, and then create the Campaign.

This chapter describes how to create these property sets that have conditions to 
identify users. The properties are used in the conditions you define for your 
Personalization logic. Each user is dynamically served personalized web content, or 
automatic e-mails based on the logic conditions.

Oracle Enterprise Pack for Eclipse provides editors to help you define the following 
properties and events to create conditions that identify and track users:

■ User Profile properties – Determine which user information to save. User Profile 
properties can also be used to define Visitor Entitlement and Delegated 
Administration roles.

■ Request properties – Capture and use specific HTTP request information to 
trigger Personalization. Request properties are associated with a request and are 
not persisted between requests. Request properties can also be used to define 
Visitor Entitlement and Delegated Administration roles.

■ Session properties – Capture and use specific HTTP session information to trigger 
Personalization. Session properties are associated with a session and are not 
persisted between sessions. Session properties can also be used to define Visitor 
Entitlement and Delegated Administration roles.

■ Custom Events – Trigger Personalization and Campaigns and track user behavior. 
You must register custom events so that your application recognizes them.

Developers use Oracle Enterprise Pack for Eclipse to create property sets and 
properties. Portal administrators can use WebLogic Portal Administration Console to 
update the values in the property set. See Section 2.2, "Checklist for Planning Your 
User Interaction Strategy" for information on designing a property set, and see 
Chapter 11 to learn how to update property set values.

This chapter includes the following sections:

■ Section 4.1, "Setting up a Property Set"

■ Section 4.2, "Adding Properties or Conditions to a Property Set"

■ Section 4.3, "Modifying Properties and Conditions"

■ Section 4.4, "Deleting a Property or a Property Set"



Setting up a Property Set

4-2 Oracle Fusion Middleware Interaction Management Guide for Oracle WebLogic Portal

For information on setting up and managing users that will use Interaction 
Management features, see the Oracle Fusion Middleware User Management Guide for 
Oracle WebLogic Portal.

4.1 Setting up a Property Set
You can use Oracle Enterprise Pack for Eclipse to create a property set in for a User 
Profile, User Segment, HTTP session or request data, date and time condition, or an 
event.

For example, a User Profile consists of additional attributes you collect and store about 
a user. Each piece of metadata in a User Profile is called a property. User properties can 
range from statically-defined properties, such as a user's phone number and e-mail 
address, to dynamically-created and persisted properties (web site tracking 
information for the user, for example).

You could create a property set called human resources that contains properties, such 
as gender, hire date, and e-mail-address. User Profile properties appear as 
input fields in the WebLogic Portal Administration Console when you edit a User 
Profile value. (You can also assign Group Profile property values to groups.) The 
properties you create are also used to define rules for Personalization, as well as 
Delegated Administration and Visitor Entitlement roles. Users and groups can have 
multiple profiles, if a a profile equates to a property set. WebLogic Portal provides a 
default User Profile property set called CustomerProperties.usr that contains 
common properties.

There are specific properties you can set on content items to enhance Personalization 
in your applications. See Chapter 6 for more information. For general information on 
Content Management, see the Oracle Fusion Middleware Content Management Guide for 
Oracle WebLogic Portal.

After you create the necessary Personalization properties and conditions and set up 
users and content, you can create Interaction Management functionality for your 
portal. For example, after you create a User Segment to trigger Personalization, you 
can create a Content Selector that defines the content that is shown to users in a 
specific User Segment.

The following section describes how to create a property set for a User Profile, User 
Segment, HTTP Session or Request, event, Community, or remote portlet. Property 
sets are application-scoped; any additional scoping or namespacing must be 
performed by the application.

Property Sets and other Interaction Management features use a variety of conditions 
that identify users and what they are doing. For more information on conditions, see 
Section 2.1.1, "Understanding Conditions."

This section contains the following topics:

■ Section 4.1.1, "Creating a User Profile Property Set"

■ Section 4.1.2, "Creating a User Segment Property Set"

■ Section 4.1.3, "Creating a Session Property Set"

■ Section 4.1.4, "Creating a Request Property Set"

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be 
named differently.
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■ Section 4.1.5, "Creating a Community or Remote Portlet Property Set"

■ Section 4.1.6, "Creating an Event Property Set"

4.1.1 Creating a User Profile Property Set
Consult the Section 2.2, "Checklist for Planning Your User Interaction Strategy" for 
more details on designing a property set.

Perform the following steps to create a property set for a User Profile:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, right-click the 
<data>\src\userprofiles folder in the Package Explorer View and choose New > 
User Property Set.

2. In the New User Property Set window, enter a name for the User Profile property 
set in the File name field. Keep the .usr file extension. 

3. Click Finish. The User Profile Editor appears. 

4. Add properties to the property set by following the instructions in Section 4.2, 
"Adding Properties or Conditions to a Property Set."

4.1.2 Creating a User Segment Property Set
You can target visitors with web content or automatic e-mails by defining and using 
groups called User Segments (similar to segments of a population). User Segments 
dynamically group users based on characteristics, such as group membership, browser 
type, profile values, and other user properties. If users match the characteristics, they 
automatically and dynamically become members of that User Segment. You can use 
User Segments in Content Selectors, Placeholders, and Campaigns.

Perform the following steps to create a User Segment:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, right-click the 
<data>\src folder in the Package Explorer View and choose New > User Segment.

2. In the New User Segment window, enter a name for the User Segment in the File 
name field. Keep the .seg file extension. 

3. Click Finish. The User Segment Editor appears. 

4. In the Design Palette tab, drag the conditions you want to use into the User 
Segment Editor. See Figure 4–1.
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Figure 4–1 This User Segment is Called birdlover.seg

5. When you add a condition to the User Segment, click the condition link to set the 
conditions.

For example, if you drag the condition The visitor has specific characteristics into the 
User Segment Editor, click the link in the Editor to select the User Profile 
properties and their values that make a user a member of the User Segment.

Properties for the user, HTTP session, and HTTP request conditions are based on 
the User Profile, HTTP sessions, and HTTP request properties you create. 

Choose conditions based on the descriptions in Table 4–1.

Table 4–1 Conditions that Identify Users to Target and the Actions that Will Occur

Condition Description

Bind a variable If you pick a type and bind a variable to it, the action can invoke a method where 
the bound variable is used as an argument. 

Invoke an instance method You can use it as a condition to trigger an action. If you invokes an instance 
method on a variable with specific arguments, then an action that you specify 
occurs.

The visitor is a member of a 
predefined User Segment

If the visitor to your web site belongs to a predefined User Segment, execute the 
specified action. For example, if the visitor belongs to the Gold Customer User 
Segment, show the visitor a specific piece of web content (action).

The visitor has specific 
characteristics

If a visitor's characteristics are compared to values you specify and those 
comparisons evaluate as true, execute a specified action. For example, if the 
visitor's salary (characteristic) is greater than or equal to (comparison) $50,000 
(value), send the visitor an e-mail (action).

The visitor's HTTP request 
has specific properties

If the HTTP request's properties are compared to values you specify and those 
comparisons evaluate as true, execute a specified action.

The visitor's HTTP session 
has specific properties

If the HTTP session's properties are compared to values you specify and those 
comparisons evaluate as true, execute a specified action. An HTTP session is 
information your organization might want to track to learn about a visitor's 
browsing session on the web site.

An application property has 
specific values

After you create an application-defined Property Set (see Section 4.1.5, "Creating a 
Community or Remote Portlet Property Set") and some properties, you can use the 
An application property has specific values condition. You must have an existing 
property set in place to use this condition.
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6. Save the User Segment file by choosing File > Save. 

4.1.2.1 Setting Dates and Times
When you set date and time conditions, the dates and times represent the time in your 
region. For example, if you are creating a Campaign action that will be triggered at 8 
p.m., that means 8 p.m. in your region. For a time zone that is two hours behind you, 
the action will be triggered at 6 p.m. in that time zone.

This also affects dates you set. The date you set becomes effective at midnight in your 
time zone. In a time zone that is six hours ahead of yours, that date becomes effective 
for that time zone at 6 p.m. your time the day before.

Time changes also affect time-triggered actions. For example, you created a Campaign 
that begins October 1 at noon and ends October 31 at noon. If a change to standard 
time (one hour earlier) occurs on October 29, the Campaign will actually end on 

An event has specific 
characteristics

If an event's characteristics are compared to values you specify and those 
comparisons evaluate as true, execute a specified action.

An event has occurred (e.g., 
login, click, etc.)

After an event occurs (for example, a user logged into the portal or clicked a link), 
an action occurs.

The date is If the current date is equal to the one you specify, execute a specified action. For 
example, if the date is equal to July 22, 2006, send users an e-mail about an 
upcoming sale (action). The current date refers to the date at the point that the 
condition is evaluated for a user visiting the web site. For more information, see 
Section 4.1.2.1, "Setting Dates and Times."

It is after a given date If the current date is after a date you specify, execute a specified action. For 
example, if the date is after December 18, 2005, offer users a discount (action). The 
current date refers to the date at the point that the condition is evaluated for a user 
visiting the web site. For more information, see Section 4.1.2.1, "Setting Dates and 
Times."

It is after a given date and 
time

If the current date and time are after a date and time you specify, execute a 
specified action. For example, if the date and time are after July 22, 2006 at 3 p.m., 
send users an e-mail about an upcoming sale (action). The current date and time 
refer to the date and time at the point that the condition is evaluated for a user 
visiting the web site. For more information, see Section 4.1.2.1, "Setting Dates and 
Times."

It is between two times If the current time falls within a range of times you specify, execute a specified 
action. For example, if the time is between 3 p.m. and 5 p.m., offer users a discount 
(action). The current time refers to the time at the point that the condition is 
evaluated for a given user visiting the web site. For more information, see 
Section 4.1.2.1, "Setting Dates and Times."

It is between two dates If the current date falls within a range of dates you specify, execute the specified 
action. For example, if the date is between December 18, 2005 and December 18, 
2006, show users a sale ad (action). The current date refers to the date at the point 
that the condition is evaluated for a given user visiting the web site. For more 
information, see Section 4.1.2.1, "Setting Dates and Times."

It is between two date/times If the current date and time fall within a range of dates and times you specify, 
execute the specified action. For example, if the date and time is between July 22, 
2005 at 3 p.m. and July 22, 2006 at 3 p.m., show users a sale ad (action). The range 
of dates is inclusive. The current date and time refer to the date and time at the 
point that the condition is evaluated for a user visiting the web site. For more 
information, see Section 4.1.2.1, "Setting Dates and Times."

The visitor is selected in a 
random sample

If the visitor to your web site is selected in a random sample, execute the specified 
action. This condition applies only to Campaigns and Rule Sets.

Table 4–1 (Cont.) Conditions that Identify Users to Target and the Actions that Will Occur

Condition Description
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October 31 at 11 a.m. If you want the Campaign to end at noon on the new standard 
time, set the end time to 1 p.m.

4.1.3 Creating a Session Property Set
Session properties capture and use specific HTTP session information to trigger 
Personalization and Campaigns. Session properties are associated with a session and 
are not persisted between sessions. An example of a Session property set could be 
PortalA.

Perform the following steps to create a Session property set:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, right-click the 
<data>\src folder in the Package Explorer View and choose New > Other.

2. Select the WebLogic Portal folder, the Property Sets folder, the Session Property 
Set folder, and click Next.

3. Enter a name for the Session property set in the File name field. Keep the .ses file 
extension. 

4. Click Finish. The Session Editor appears. 

5. Add properties to the property set by following the instructions in Section 4.2, 
"Adding Properties or Conditions to a Property Set."

Use code in a JSP or Java Page Flow to populate the session.

4.1.4 Creating a Request Property Set
Request properties capture and use specific HTTP request information to trigger 
Personalization. Request properties are associated with a request and are not persisted 
between requests.

Request properties can also store values that are populated programmatically. For 
example, the DefaultRequestPropertySet.req property set in the 
<project>\data\src\request\ directory is included with every portal web project, and 
contains properties called User-Agent and Client Classification. These properties are 
populated automatically when a device accesses a portal, providing a key component 
of the framework that delivers appropriate web content to mobile devices. 

Perform the following steps to create a Request property set:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, right-click the 
<data>\src\request folder in the Package Explorer View and choose New > 
Request Property Set

Note: Because of the different dates and times on which actions will 
be triggered around the country or world, it is important to tell users 
that dates and times are effective for your time zone. This type of 
information allows users to calculate when in their time zone they can 
take advantage of your promotions.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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2. In the New Request Property Set window, enter a name for the Request property 
set in the File name field with the .req file extension. 

3. Click Finish. The Request Property Set Editor appears. 

4. Add properties to the property set by following the instructions in Section 4.2, 
"Adding Properties or Conditions to a Property Set."

4.1.5 Creating a Community or Remote Portlet Property Set
You can create an application-defined property set to store profile data for entities that 
are not users or groups. These entities include Communities and remote portlets, or a 
custom entity created by an application programmer. 

Perform the following steps to create a property set for an Application-defined 
property set:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, right-click the 
<data>\src folder in the Package Explorer View and choose New > Other.

2. In the New Select a Wizard window, expand the WebLogic Portal folder and 
expand the Property Sets folder.

3. Select the Application-Defined Property Set and click Next.

4. Enter a name for the Community or remote portlet property set in the File name 
field. Keep the .propset file extension.

5. Click Finish. The Application-Defined Property Set Editor appears. 

6. Add properties to the property set by following the instructions in Section 4.2, 
"Adding Properties or Conditions to a Property Set."

4.1.6 Creating an Event Property Set
You must register custom events that you create so that your portal application 
recognizes the events. After you register your events, you can use them to trigger 
Personalization and Campaigns and track user behavior in your portals.

Events need event listeners to listen for them. Register the event listeners for your 
custom event in the <PORTAL_APP>\META-INF\wps-config.xml file.

Perform the following steps to create an Event property set:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, right-click the 
<data>\src folder in the Package Explorer View and choose New > Other.

2. In the New Select a Wizard window, expand the WebLogic Portal folder and 
expand the Property Sets folder.

3. Select Event Property Set and click Next.

4. Enter a name for the Event property set in the File name field, keeping the .evt 
file extension. 

5. Click Finish. The Event Editor appears. 

6. In the New Event Property Set window, enter a name for the Event property set in 
the File name field. Keep the .evt file extension. 

7. Click Finish. The Event Editor appears. 

8. Add properties to the property set by following the instructions in Section 4.2, 
"Adding Properties or Conditions to a Property Set."
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4.2 Adding Properties or Conditions to a Property Set
After you create a property set for a User Profile, HTTP Session or Request, 
Community, or WSRP, add the properties you want to it. The following steps assume 
you have created a property set according to the instructions in Section 4.1, "Setting up 
a Property Set."

Perform the following steps to add a property to a property set:

1. In Oracle Enterprise Pack for Eclipse, open the property set file you created in 
Section 4.1, "Setting up a Property Set."

2. In the Design Palette tab, drag one of property types into the Property Set Editor 
window, as shown in Figure 4–2.

Figure 4–2 A Single Restricted Property Lets You Pick a Value From a List that You Define

The type defines the number of values that can be entered for the property. 
Following are descriptions of each type.

■ Single Unrestricted – A single unrestricted property can have only one value, 
but you can enter any value. For example, date of birth.

■ Single Restricted – A single restricted property can have only one value, and 
you are restricted to selecting that value from a predefined list. For example, a 
Gender property can be Male or Female.

■ Multiple Unrestricted – A multiple unrestricted property can have multiple 
values, and you can enter any value. Generally, this property is used for a 
single category, such as names of your children. Other examples are a favorite 
color or preferred browser.

■ Multiple Restricted – A multiple restricted property can have multiple values, 
and you are restricted to selecting the values from a predefined list. Other 
examples are city and state. You could also use a check all that apply type 
data.

3. Select the Properties tab and enter the following:
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■ Click the drop-down list and select the Data Type for the property value. For 
example, if you select Boolean, your property's Values can be only true or 
false. (Properties with a Boolean data type are automatically set to Single 
Restricted.) 

■ Enter a Description and a Property Name.

■ In the Selection Mode and Value Range fields, you can change the property 
type. For example, you can change a property from Single Unrestricted to 
Multiple Restricted. 

■ Use the Values field to enter values for Restricted types or to set the default 
value for Unrestricted types. Click the ellipsis icon (...) to enter values. (In the 
Enter Property Value dialog box that appears for a Restricted type, enter a 
value and click Add after each entry. Click OK after you enter all values.) See 
Figure 4–3.

Figure 4–3 This Property Has Three Possible Values

4. Save the properties by choosing File > Save. 

4.3 Modifying Properties and Conditions
You can edit properties and values in Oracle Enterprise Pack for Eclipse or you can 
edit just the property values in the WebLogic Portal Administration Console.

This section contains the following topics:

■ Section 4.3.1, "Editing Properties"

■ Section 4.3.2, "Editing Property Values"

■ Section 4.3.3, "Retrieving Properties from External Data Stores"

Note: Any change to the Data Type, Selection Mode, or Value 
Range fields removes anything previously entered in the Values 
field.

Caution: You can also use the Property control to create and manage 
properties. However, properties created with this control do not 
appear in the WebLogic Portal Administration Console. The 
properties must be modified and updated programmatically.
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4.3.1 Editing Properties
Perform the following steps in Oracle Enterprise Pack for Eclipse to modify properties 
or conditions and their values for User Profiles, User Segments, HTTP session or 
request data, date and time conditions, or events:

1. In Oracle Enterprise Pack for Eclipse, double-click the property set file.

2. In the Properties tab, change the property or its default value.

3. Save your change by choosing File > Save.

You can also use the <profile:setProperty> JSP tag in your JSPs or the Property 
control in your Page Flows to modify existing property values for users.

4.3.2 Editing Property Values
Portal administrators can use the WebLogic Portal Administration Console to modify a 
property's value. For instructions, see Section 11.1, "Editing a Property Value."

4.3.3 Retrieving Properties from External Data Stores
If you created a Unified User Profile (UUP) to access external user or group properties, 
you can use those properties to define rules for Personalization, Delegated 
Administration, or Visitor Entitlement.

After you create a UUP to access the properties stored in an external user store, such as 
an LDAP server, you can access those external properties only through WebLogic 
Portal's JSP tags, controls, or API. After you deploy a UUP, when the Administration 
Console focuses on the associated property set, it will call on the UUP to read values. 
A UUP must implement writable interfaces if you want to be able to write to the UUP 
properties.

If you want to use those external properties in defining rules for Personalization, 
Delegated Administration, or Visitor Entitlement, you must retrieve those properties 
in the WebLogic Portal Administration Console. Simply defining rules requires access 
only to the property set "schema", which you created in Section 4.1.1, "Creating a User 
Profile Property Set." When the rules are evaluated, the actual values are fetched. You 
do not have to use the Administration Console.

A password is not considered a property.

Perform the following steps to retrieve user or group properties from an external data 
store:

1. Create a UUP for the external data store. See the Oracle Fusion Middleware User 
Management Guide for Oracle WebLogic Portal for instructions. 

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

Note: The properties you retrieve from an external user store may be 
read-only, and their values cannot be updated in the WebLogic Portal 
Administration Console. To make those properties writable, your 
custom UUP must implement writable properties.
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2. To create the User Profile property set for the external data store, locate the name 
of the property set to create. In your enterprise application root directory, inside 
the p13n_app.jar file, copy the /META-INF/p13n-profile-config.xml file 
to your own application's /META-INF directory.

3. Modify the p13n-profile-config.xml file in the /META-INF directory of 
your own application. See the instructions in the Oracle Fusion Middleware User 
Management Guide for Oracle WebLogic Portal.

4. Add properties to the property set that exactly match the property names in the 
external store you want to surface. If you are using the LDAP UUP provided by 
WebLogic Portal, the property set might be named ldap.usr

5. Save the property set file.

4.4 Deleting a Property or a Property Set
You can delete individual properties from a property set, and you can delete an entire 
property set.

Perform the following steps to delete a property from a property set:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, double-click the 
property set file.

2. In the Editor window, select the property. For example, a User Segment could 
contain the condition The visitor has specific characteristics.

3. Right-click the property and choose Delete.

Perform the following steps to delete a property set:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, double-click the 
property set file.

2. Right-click the property set and choose Delete.

You can also use the <profile:removeProperty> JSP tag in your JSPs or the 
Property control in your Page Flow to remove existing property values from a user's 
profile.

Note:  "Apache Beehive and Apache Struts Supported 
Configurations"Page flows are a feature of Apache Beehive, which is 
an optional framework that you can integrate with WLP. See in the 
Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic 
Portal.
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5Creating a User Segment

You can use User Segments to dynamically group users based on conditions you 
define. Instead of creating groups of users, you can create groups of characteristics, 
such as gender, browser type, and date or time. If a user matches the characteristics, 
the user automatically and dynamically becomes a member of that User Segment. You 
can then target these groups with web content, and automatic e-mails based on the 
User Segment.

You can define User Segment conditions that identify gender, occupation, movie fans, 
or pet lovers. For example, you could classify all users who ordered more than five 
on-demand movies in the last 30 days. After you identify and group users into User 
Segments, you can target segments with personalized actions through Campaigns and 
Content Selectors. 

Developers can use Oracle Enterprise Pack for Eclipse to create User Segments. Portal 
administrators can use the WebLogic Portal Administration Console to change the 
User Segment conditions to dynamically group users. Developer time is not required 
to update User Segments.

This chapter includes the following sections:

■ Section 5.1, "Creating a User Segment"

■ Section 5.2, "Modifying a User Segment"

5.1 Creating a User Segment
You can target visitors with web content and automatic e-mails by defining and using 
groups called User Segments (as in segments of a population). Instead of being groups 
of hard-coded users, User Segments are groupings of characteristics, such as gender, 
the type of browser being used, and date or time information. If users match the 
characteristics, they are automatically and dynamically members of that User 
Segment. When you use User Segments in Content Selectors and Campaigns, users 
that belong to those User Segments are targeted with the web content, or e-mail that 
you determine. 

Perform the following steps to create a User Segment:

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently.
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1. Start the WebLogic server by choosing Run As > Run on Server in Oracle 
Enterprise Pack for Eclipse. For instructions on configuring the WebLogic Server, 
see the Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

2. In the Portal Perspective, right-click the 
<data>\src\segments\GlobalClassifications folder in the Package Explorer View 
and choose New > User Segment.

3. In the New User Segment window, enter a name for the User Segment in the File 
name field and use the .seg file extension. 

4. Click Finish. The User Segment Editor appears.

5. In the Design Palette tab, drag the conditions you want to use into the User 
Segment Editor. See Figure 5–1.

Figure 5–1 Add a Condition to the User Segment

6. For each condition you add to the User Segment, click the condition link to set the 
conditions.

For example, if you drag the condition The visitor has specific characteristics into the 
User Segment Editor, click the corresponding characteristics hyperlink in the User 
Segment Editor. The Visitor Characteristics window lets you select the User Profile 
properties and their values that will make a user a member of the User Segment. 
See Table 4–1, " Conditions that Identify Users to Target and the Actions that Will 
Occur".

Properties for the user, HTTP session, and HTTP request conditions are based on 
the User Profile, HTTP session, and HTTP request properties you created. For 
more information on conditions, see Section 2.1.1, "Understanding Conditions."

7. Save the file by choosing File > Save. 
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This section contains the following topic:

■ Section 5.1.1, "Setting Dates and Times"

5.1.1 Setting Dates and Times
When you set date and time conditions, the dates and times represent the time in your 
region. For example, if you are creating a Campaign action that will be triggered at 8 
p.m., that means 8 p.m. in your region. For a time zone that is two hours behind you, 
the action will be triggered at 6 p.m. in that time zone.

The time zone also affects dates you set. The date you set becomes effective at 
midnight in your time zone. In a time zone that is six hours ahead of yours, that date 
becomes effective for that time zone at 6 p.m. your time the day before.

Time changes also affect time-triggered actions. For example, you created a Campaign 
that begins October 1 at noon and ends October 31 at noon. If a change to standard 
time (one hour earlier) occurs on October 29, the Campaign will actually end on 
October 31 at 11 a.m. So if you want the Campaign to end at noon on the new standard 
time, set the end time to 1 p.m.

5.2 Modifying a User Segment
After you create a User Segment in Oracle Enterprise Pack for Eclipse, you can edit a 
User Segment using the following methods:

■ Oracle Enterprise Pack for Eclipse – Developers can use Oracle Enterprise Pack 
for Eclipse to modify a User Segment. See Chapter 12 for instructions.

■ WebLogic Portal Administration Console – Portal administrators can use the 
Administration Console to edit a User Segment's value. See Chapter 12 for 
instructions.

Note: You can use User Segments in Content Selectors and 
Campaigns.

Tip: Because of the different dates and times on which actions will be 
triggered around the country or world, it is important to tell users that 
dates and times are effective for your time zone. This type of 
information allows users to calculate when in their time zone they can 
take advantage of your promotions.
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6Creating a Content Selector

Content Selectors use rules to target specific groups of people with content items from 
the WLP Virtual Content Repository. Content Selectors return and display content. For 
example, if a user logs in and is identified in the User Profile as a book fan, a Content 
Selector can display a list of recommended books.

Developers can use Oracle Enterprise Pack for Eclipse to create and update Content 
Selectors and place them in a JSP. Portal administrators use the Administration 
Console to make changes to the Content Selectors that display content in your portal. 
You can retrieve both published and versioned content in a content selector. For more 
information about publishing content, see Adding Content to a WLP Repository in the 
Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal.

Users do not have to be authenticated (logged in) to be targeted by Content Selectors. 
For example, the presence of specific HTTP request or session properties, or specific 
date and time conditions can trigger content to be displayed. You can, for example, 
display targeted holiday content to users who visit your portal in the month of 
December and view your portal with a specific type of web browser.

However, authenticated users (as well as anonymous tracked users) have profile 
information associated with them that you can use to target them with personalized 
content. A book fan is an example of this type of User Profile data.

This chapter includes the following sections:

■ Section 6.1, "Setting Up Content to Display"

■ Section 6.2, "Creating a Content Selector"

■ Section 6.3, "Using the <pz:div> Tag Instead of a Content Selector"

■ Section 6.4, "Deleting a Content Selector Query"

6.1 Setting Up Content to Display
Content Selectors retrieve content properties, which are usually text or numeric values. 
For example, you want your Content Selectors to retrieve information about books. 
Book content can be assigned many properties, such as title, author, publication date, 
ISBN, and a URL to the publisher's web site. You may want your Content Selector to 
display a bulleted list of titles and link each title to the publisher's web site. This list 
and link is accomplished through using just the text values of the content properties.

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently.
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However, your book content could also have a binary property that stores an image of 
the book's cover. The Content Selector can also display that binary property—the 
actual image—using the ShowProperty servlet, as described in Section 7.2.1, 
"Creating a Placeholder File." The type of binary content that Content Selectors can 
display is dependent on the MIME types you have configured. By default, WebLogic 
Portal provides MIME support for displaying images and other types of files. See 
Section 7.1.1, "Displaying Additional MIME Types in a Placeholder" for more 
information on other types.

6.2 Creating a Content Selector
Content Selectors are scoped to the enterprise application, so you can include a 
Content Selector in any JSP within the enterprise application.

A Content Selector consists of the following two parts:

1. Content Selector file – The Content Selector file that you create in Oracle 
Enterprise Pack for Eclipse contains the following parts:

a. Personalization rules – The conditions that define when the Content Selector 
runs its query and displays the content. The following conditions can be used 
to trigger a Content Selector:

– The visitor is a member of a predefined User Segment

– The visitor has specific characteristics (User Profile properties)

– Specific HTTP session or request properties exist

– Date and time conditions

b. A content query that retrieves a specific set of content properties.

2. The <pz:contentSelector> JSP tag – This companion tag performs the processing 
and is also created in Oracle Enterprise Pack for Eclipse. Content returned from 
Content Selectors is usually displayed in portlets. When a user views a portlet or a 
portal desktop that contains a Content Selector, the Content Selector's rules and 
logic look for a match of properties, such as User Profile information. If the 
properties match the Content Selector rules, the Content Selector runs a query and 
retrieves and displays all content matching the query.

Use the following guidelines when you create Content Selectors.

■ Create a Content Selector for each audience you want to target. If you have five 
audiences you want to target with content, create five Content Selectors, then add 
five <pz:contentSelector> tags to your JSP, each of which references its own 
Content Selector file.

■ When a Content Selector is triggered and runs its query, the results (node objects) 
are returned to the <pz:contentSelector> JSP tag and stored in the tag's id 
attribute. At this point, you need other tags or code to process and display the 

Tip: During development, the rules files reload when they change 
(just like JSPs), so you can quickly develop with Content Selectors. 
However, when the server is in production mode, Content Selectors 
are loaded into the database (from the file-based definitions in the 
application) where they can be modified in the WebLogic Portal 
Administration Console without redeploying the application or 
restarting the server. 
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content. The tags described in Table 6–6 are useful tags for displaying retrieved 
content.

■ The Search.setSortCriteria method only works for searching published 
content. This method is not supported for searching versioned content.

■ To display binary content retrieved by Content Selectors, use the ShowProperty 
servlet. The following code example shows how to use the ShowProperty 
servlet:

<pz:contentSelector rule="classic" id="nodes"/>
<utility:notNull item="<%=nodes%>">
<ul>
<utility:forEachInArray array="<%=nodes%>" id="node" 
type="com.bea.content.Node">
<img src="<%=request.getContextPath() + "/ShowProperty" + node.getPath()%>">
</utility:forEachInArray>
</ul>
</utility:notNull>

The <img> HTML tag's source path is constructed to use the path to the content item 
in the Virtual Content Repository. The path includes the ShowProperty servlet to 
render the binary file. In the node.getPath() method, node is a specific content 
item stored by the <utility:forEachInArray> tag's id attribute. If the 
<utility:forEachInArray> id attribute value was foo, the method would look 
similar to the following: foo.getPath().

This section contains the following topics:

■ Section 6.2.1, "Creating the Content Selector File"

■ Section 6.2.2, "Using a JSP Tag to Display a Content Selector File"

6.2.1 Creating the Content Selector File
Perform the following steps to create a Content Selector file:

1. Start the WebLogic server by choosing Run As > Run on Server in Oracle 
Enterprise Pack for Eclipse. For instructions on configuring the WebLogic Server, 
see the Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

2. In the Portal Perspective, right-click the 
<data>\src\contentselectors\GlobalContentSelectors folder in the Package 
Explorer View and choose New > Content Selector.

3. Enter a name for the Content Selector in the File name field, using the .sel file 
extension, as shown in Figure 6–1.
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Figure 6–1 Create a New Content Selector

4. Click Finish. The Content Selector Editor appears. 

5. Select the Properties tab to change the description for the Content Selector.

6. Select the Design Palette tab to see the Available Conditions under which the 
Content Selector will run. As you select conditions, corresponding links appear in 
the top of the Editor window. 

7. In the Content Selector Editor window, click the corresponding links to create the 
conditions you selected, and enter the appropriate information. 

8. In the Content Selector Editor window, click the query's empty content search link 
to define the query. This requires a connection to WLP's Virtual Content 
Repository, which is set up in the WebLogic Portal Administration Console.

9. You can define the query in advanced mode using WebLogic Portal's expression 
syntax (on the Advanced tab) or in graphical mode (on the Query tab):

■ Advanced mode – In the Content Search window, select the Advanced tab and 
build a query using the instructions in Section 6.2.1.1, "Building a Content 
Query with Expressions." The Advanced tab provides code coloring to 
highlight context errors in your queries. You can reuse existing queries by 
pasting them into the Advanced tab.

■ Graphical mode – Use the following steps in the Query tab to build a content 
query by selecting content properties, comparators, and values to retrieve 
content items. 

a. In the Content Search window, select the Query tab. 

b. Select a property set and a property within the content type, and click Add. 
One of the default property sets is Standard Versioned, which retrieves 
versioned content. Use the Standard Versioned properties to narrow your 
content search. For example, you can retrieve only the latest version of a 
graphic by selecting the cm_latestVersion property.
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c. In the Content Search Values dialog that appears, use one of the following 
tabs: 

– Values tab – To define the query based on a comparison to a value you 
enter. For example, the query could be set to retrieve content with an 
investorRiskLevel property that is marked as high. You could also 
retrieve binary content with a name of IRACampaign. See Figure 6–2 for 
an example and Table 6–6 for more details.

Figure 6–2 A Content Query that Retrieves a Binary File Called IRACampaign

Properties tab – To define the content query based on the property value that 
is dynamically fed in from another type of property, such as a user profile 
property. For example, instead of creating a query based on static content 
properties, you can create a query that reads in the value of the current user's 
investorRiskLevel to populate the query. The query would be different for 
each user. 

10. Click Add. The query descriptor is added in the Content Search window. 

11. You can add more value phrases to the query, then set the appropriate option in 
the For multiple descriptors area at the bottom of the window. 

12. Click OK in the Content Search window to add the query to the search. 

13. You can preview the content that will be retrieved by the query by clicking the 
Content Preview tab. If you defined the query to use values from a User Profile 
property, the retrieved content will be different for each user, so you must enter 
the user name of an existing user in the Preview User field to see which content 
will be retrieved for that user. By default, you preview published content. If you 
want to preview versioned content, click Controls whether this will preview 

Note: The properties you select are system content properties, rather 
than property set properties like user profile or session properties. 
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versioned or published content, as shown below. (Click the Menu icon next to 
this icon to toggle between versioned content and published content.)

For more information about publishing content, see Adding Content to a WLP 
Repository in the Oracle Fusion Middleware Content Management Guide for Oracle 
WebLogic Portal.

14. Save the Content Selector file by choosing File > Save. 

15. To use the Content Selector, add the <pz:contentSelector> tag to the relevant 
JSPs. See Section 6.2.2, "Using a JSP Tag to Display a Content Selector File" for 
more information on using the <pz:contentSelector> tag to display text 
content (including text binaries, such as HTML files) and non-text binaries 
(graphics).

Figure 6–3 shows a Content Selector file called classic.sel. The condition that 
triggers the Content Selector is a user with a property set of SalesRegion with a value 
of Americas. The content that is retrieved is any content with a binary file name that 
contains IRACampaign.

Figure 6–3 Content Selector File in Oracle Enterprise Pack for Eclipse

Users do not have to be authenticated to be targeted by Content Selectors.

6.2.1.1 Building a Content Query with Expressions
You can use the WebLogic Portal Expression language in WebLogic Portal 
Administration Console to build content queries. You can build queries with the 
Advanced Query window from content-related JSP tags and when you are creating 
queries for Placeholders, Campaigns, and Content Selectors.

Tip: Content Selectors can display binary content, such as images. 
See the Oracle Fusion Middleware Content Management Guide for Oracle 
WebLogic Portal for instructions.

Tip: When library services (for example, versioning and workflow 
status) are enabled for a WLP Repository, system properties are 
always available to queries unless the content item has a retired status. 
You can search for both published and versioned content. If you want 
to retrieve content based on its content type, you must use the 
cm_objectClass system property in your content query. If your 
queries use only system properties, the query retrieves all content 
items with matching system properties that are not retired.
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The query compares a content property to a value that you enter. A query contains the 
following three parts: <property><comparator><value>.

If the comparison is true, all matching content items are retrieved.

For example, employee_type == 'manager'. This query retrieves any content 
item from the WLP Virtual Content Repository with a property called 
employee_type that contains the exact (==) String manager.

Queries are often made up of multiple clauses using and (&&) and or (||) logic. For 
example:

This section contains the following topics: 

■ Section 6.2.1.1.1, "Using Rules to Build a Query"

■ Section 6.2.1.1.2, "Selecting Properties"

■ Section 6.2.1.1.3, "Using Comparators"

■ Section 6.2.1.1.4, "Supplying Values"

6.2.1.1.1 Using Rules to Build a Query  Use the following rules when you build a query:

■ Queries are case sensitive. 

■ Queries can be simple, one-clause queries, or they can be more complex, 
multi-clause queries. In complex queries, parentheses control the order of 
evaluation for multiple query clauses, and clauses are evaluated using and (&&) 
and or (||) logic. 

■ In a Placeholder, only one content item can be displayed at a time. If you are using 
a Placeholder to run queries from a Campaign (as well as its own default queries), 
you can run several queries, but only one query at a time. The query is determined 
by the Placeholder's weighting system. After the query runs, the query can return 
multiple content items, but the Placeholder displays only one of the retrieved 
content items.

6.2.1.1.2 Selecting Properties  The following two types of properties exist for content:

Query Description

(genre == 'rock' || genre 
== 'alternative') &&

platinum_records > 2

This query retrieves any content item with a genre 
property that has an exact value of rock or (||) 
alternative and (&&) with a platinum_records 
property value greater than 2. The parentheses 
separates one section of the query from the next, 
controlling the order of evaluation.

(genre=='rock' || 
genre=='country') && 
artist=='dead'

This query retrieves any content item with a genre 
property that has an exact value of rock or 
country and an artist property value of dead.

Tip: With your development server running, create a test 
Placeholder or Content Selector in Oracle Enterprise Pack for Eclipse 
and construct queries for it using the Advanced tab in the Content 
Search window. The retrieved content is displayed in the Content 
Preview tab. If you utilize the userProperty() format to retrieve values 
for your query, you must enter a user name in the Preview User field 
of the Content Preview tab to retrieve the values for that user and 
display the retrieved content items. 
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■ User-defined content properties.

■ System content properties. See Table 6–6 for a list of system content properties.

You can use both properties in a query.

User-defined content properties are stored in sets called types, which are defined in the 
WebLogic Portal Administration Console. For example, you can create a type called 
Book and add properties, such as title, author, pub_date, and isbn.

System content properties are automatically associated with all content items and are 
automatically assigned values for a content item when the content item is added to the 
content repository. System properties can be used to retrieve published content or 
versioned content. These properties, which are also listed in the 
com.bea.content.expression.Search class, include the items listed in 
Table 6–1.

Table 6–1 System Content Properties

Property API
Type of 
Content Description

cm_uid Node.id.uid Published and

Versioned

The unique ID for a content item. You 
can view a content item's unique ID 
by selecting the content item in the 
Administration Console and viewing 
its description. 

cm_createdDate Node.createDate Published The date on which a content item was 
created. You can view Creation Date 
information for content items by 
selecting their content folder in the 
Administration Console and selecting 
the Summary tab. 

cm_createdBy Node.createdBy Published The user who created the content 
item. You can view Created By 
information for content items by 
selecting the content folder in the 
Administration Console and selecting 
the Summary tab.

cm_modifiedDate Node. modifiedDate Published and

Versioned

The date the content item was last 
modified. You can view Modified 
Date information for content items by 
selecting their content folder in the 
Administration Console and selecting 
the Summary tab.

cm_modifiedBy Node.modifiedBy Published and

Versioned

The user who last edited the content. 

cm_nodeName Node.name Published and

Versioned

The name of the content item, as 
shown in the Administration Console.

cm_path Node.path Published The Virtual Content Repository path 
to the content item. For example, 

/WLPRepository/ 
juvenilebooks/ 
TheCrazyAdventure. 
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cm_isHierarchy Node.type == 
Node.HIERARCHY

Published Identifies a content folder rather than 
a content item. Content folders can 
contain content items and child 
content folders. When using this 
property in queries, compare it using 
a Boolean value of true or false. 

cm_isContent Node.type == 
Node.CONTENT

Published Identifies a content item rather than a 
content folder. Content items contain 
properties from the type with which 
they are associated. When using this 
property in queries, compare it using 
a Boolean value of true or false. 

cm_objectClass Node. objectClass. 
name

Published The content type associated with a 
content item. You can view Type 
information for content items by 
selecting the Types tab in the 
Administration Console and selecting 
the Summary tab.

cm_objectClassInstance The instance of an object 
class

Published Finds all instances of a given object 
class and all of its children.

cm_value The value Published and

Versioned

A metadata search for any property 
with a given value. This property is 
similar to a wildcard search.

cm_contentType BinaryValue. 
contentType

Published and

Versioned

The MIME type for content item 
binary properties. For example, 
image/jpeg. You can view the 
MIME type of a content item by 
selecting it in the Administration 
Console and looking at the Primary 
Property Data Type field.

cm_binarySize BinaryValue. size 

(For Node Properties)

Published and

Versioned

The size of the binary value of content 
items. You can view the size of a 
content item's binary value by 
selecting the content item in the 
Administration Console, selecting the 
Properties tab, and clicking 
Download File. Click Save and 
right-click the displayed binary file to 
view the file properties.

When you use this property in a 
query, specify binary size in bytes. 

cm_binaryName BinaryValue. name 

(For Node Properties)

Published and

Versioned

The file name of the binary value of a 
content item. You can view the name 
of a content item's binary value by 
selecting the content item in the 
Administration Console and viewing 
the Name value in the Summary tab.

cm_assignedToUser VirtualNode Versioned The user to which the node is 
assigned. For example, 
cm_assignedToUser = 'joe'.

cm_checkedOut VirtualNode Versioned If the node is checked out. For 
example, cm_checkedOut = false.

Table 6–1 (Cont.) System Content Properties

Property API
Type of 
Content Description
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When you construct a query, you can specify property names by themselves without 
quotes. For example: title <comparator> <value>. However, if a property name 
contains spaces, double quotes, or dashes, you must enclose the property name within 
a toProperty() format. For example: toProperty('Favorite Author') <comparator> 
<value>.

The query looks for the property name in all content types and returns any content 
item with that property value (if the content item meets the conditions of the query). 
However, you can also isolate a property within a specific type. For example, if you 
have a books type and an articles type that both contain a title property, you can 
retrieve content items with a specific title from within only the book type using the 
cm_objectClass property.

For example: title likeignorecase '*Adventure' && cm_objectClass = 
'books'

6.2.1.1.3 Using Comparators  Comparators provide the logic that compares a query's 
property to the value you enter. If a content item meets the conditions of the query, the 
content item is returned. Table 6–2 contains a list of the comparators you can use in 
your queries. 

cm_latestVersion N/A Versioned The latest version of the content. For 
example, cm_latestVersion = 
true.

cm_role VirtualNode Versioned The role to which the node is 
assigned. For example, cm_role = 
'Admin'.

cm_version Version Versioned The version number of the content. 
This value is a string. For example, 
cm_version = '5'.

cm_versionComment Version Versioned Text describing the changes to the 
version. For example, 
cm_versionComment = Includes 
updates from Marketing.

Table 6–2 Available Comparators

Comparator Description (Property Formats on Which the Comparator Can Act)

= or == Checks to see if a single-value property (including a single value 
containing a list) is exactly equal to the case-sensitive value you enter 
(Boolean, date and time, numeric, and string values). For example, genre 
== 'fantasy' retrieves any content item that has case-sensitive 
fantasy as the value for the genre property.

!= Checks to see if a single-value property (including a single value 
containing a list) is not equal to the case-sensitive value you enter 
(Boolean, date and time, numeric, and string values). For example, genre 
!= 'mystery' retrieves any content item that does not have 
case-sensitive mystery as the value for the genre property.

> Checks to see if a single-value property is greater than the value you 
specify (date or time and numeric values). For example, pub_date > 
toDate('MM-dd-yyyy', '01-01-2000') retrieves any content item 
with a pub_date property set to a value later than January 1, 2006.

Table 6–1 (Cont.) System Content Properties

Property API
Type of 
Content Description
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< Checks to see if a single-value property is less than the value you specify 
(date or time and numeric values). For example, books in series < 
3. Because the property name contains spaces, you must use 
toProperty(), as shown in toProperty('books in series') < 
3 to retrieve any content item with a value less than 3 for the books in 
series property.

>= Checks to see if a single-value property is greater than or equal to the 
value you specify (date or time and numeric values). For example, 
toProperty('books in series') >= 3 retrieves any content item 
with a value greater than or equal to 3 for the books in series property. 
The property value of the sample content item is 1.

<= Checks to see if a single-value property is less than or equal to the value 
you specify (date or time and numeric values). For example, 
toProperty('books in series') <= 3 retrieves any content item 
with a value less than or equal to 3 for the books in series property. 

like Checks to see if a single-value property is like the case-sensitive value 
you enter. You can use wildcard characters * (one or more characters) or ? 
(single character). For example, author like 'P?nm*' retrieves any 
content that contains case-sensitive Penman, Panmen, or any other 
variation with a different character between the P and the n and any 
characters after the m for the author property.

Note: If you do not put the asterisk (*) at the end, the content item is not 
retrieved, because more text follows the name Penman in the property 
value.

likeignorecase Checks to see if a single-value property is like the value you enter. You 
can use the wildcard characters * and ?. Character case is ignored. For 
example, author likeignorecase 'pen*' retrieves any content 
with an author value that begins with pen in any case combination, such 
as penman, Penman, Penfield, and so on.

contains Checks to see if a multi-value property contains exactly the single value 
you specify (date or time, numeric, and string values). In some 
implementations, this comparator may also work against single-value 
properties. For example, genre contains 'fantasy' retrieves any 
content containing an genre property value of exactly fantasy.

containsall Checks to see if a multi-value property contains all of the exact values 
you specify (date or time, numeric, and string values). For example, 
genre containsall ('fantasy', 'children') retrieves any 
content that contains genre property values of fantasy and children. 
In some implementations, this comparator can also work against 
single-value properties. 

containsany Checks to see if a multi-value property contains any of the exact values 
you specify (date or time, numeric, and string values). For example, 
genre containsany ('fantasy', 'children', 'scifi') 
retrieves any content that contains genre property values of fantasy, 
children, or scifi. In some implementations, this comparator can also 
work against single-value properties.

in Checks to see if a single-value property contains any of the values you 
enter. If the value you enter is not a list of possible values (is a single 
value), in is the same as = or == (date or time, numeric, and string 
values). For example, isbn in ('pending', 'not_available') 
retrieves any content that contains the isbn property value of pending or 
not_available.

Table 6–2 (Cont.) Available Comparators

Comparator Description (Property Formats on Which the Comparator Can Act)
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6.2.1.1.4 Supplying Values  Values represent the content you want the query to return. 
By supplying values to a query, you are telling the query which content to retrieve or 
ignore based on the values stored on the content items.

For example, if you have a content type called book with a property called title, all 
content items you associate with the book type have a title field. Each title value is 
unique, so in a query, you can enter the unique value you want, resulting in the query 
retrieving a specific content item (or ignoring the content item, depending on the 
comparator you use).

You can enter values in two ways:

1. Hard code values in the queries – Use hard-coded values so that you get 
predictability with your queries. Hard-coded values let you pinpoint the specific 
content you want to retrieve. 

2. Get values from User Profiles and other types of property sets (Session and 
Request) – When you populate values from User Profile, session, or request 
property sets, the value in each specified User Profile, session, or request property 
is inserted programmatically into the query, letting you create personalized 
queries based on the current user's preferences or the current session or request.

For example, in a query where a content property is author, you can get the value 
of the user's FavoriteAuthor profile property to supply the value for the query, 
letting the query retrieve content associated with the user's favorite author.

Use the following guidelines to build values in queries:

■ Enclose string literal values in single quotes. For example: 'pending'. 

■ To supply a single or double quote, use a backslash for the quoting character 
(unicode characters are not supported). For example, if a book title is stored 
with double quotes, such as "The Crazy Adventure", enter the value like 
this: '\"The Crazy Adventure\"'. If the title is stored with single quotes, 
enter the value like this: title = '\'The Crazy Adventure\'' .

■ Unicode (such as "\u6565"), octal (such as "\7", "\65", "\377"), and 
standard Java escape sequences (such as "\n", "\r", "\b") are allowed in the 
string literals. 

■ Boolean literals are either the true or false keyword (lowercase, without 
quotes). 

■ Number literals are Java form (scientific notation is supported).

Date or time literals are presented in toDate('formatStr', 'dateStr') 
format, where formatStr is the date and time format you want to use (such 
as 'MM/dd/yyyy') and dateStr is the actual date and time you enter (such 
as '01/01/2006').

The formatStr must be a valid java.text.SimpleDateFormat string. If 
you omit the formatStr, the toDate() expects the date and time you enter 
to be in the following format: 'MM/dd/yyyy HH:mm:ss z' (where z is the 
time zone, such as MDT). For example: toDate('12/01/2004 06:00:00 
MDT').

To specify date values only, enter the format you want for the formatStr. For 
example, for a date value only, specify toDate('MM/dd/yyyy', 
'12/01/2004'). You can also specify only the month and year, such as 
'MM-yyyy'.

Use the now keyword to specify the time at which the expression is being 
parsed at run time. 
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■ To supply query values from user, request, or session properties, use the 
following format: <type>Property(<propertyset>, <propertyname>), 
where the type is user, request, or session. For example: 
userProperty('userpreferences', 'FavoriteAuthor'). 

6.2.1.1.5 Creating Complex Queries  You can combine multiple independent query 
clauses, tying them together with and (&&) and or (||) logic and controlling the order 
of evaluation with parentheses the way you would with algebraic expressions. This 
lets you create more complex queries. You can also include not logic (!) in complex 
queries by using the exclamation point in front of a parenthetical grouping.

See the Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal 
for more information about queries.

6.2.1.1.6 Using Sample Queries  Figure 6–4 shows the properties set on a book stored in 
WLP's Virtual Content Repository.

Figure 6–4 Properties on a Book

The example queries in Table 6–3, Table 6–4, and Table 6–5 use properties in the 
sample content item, and the description for each sample query tells you if the query 
will retrieve the content item.
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Table 6–3 Example Queries

Query
Will Retrieve 
Sample? Description\

genre == 'fantasy' Yes Retrieves any content item that has case-sensitive 
fantasy as the value for the genre property.

will_visit_schools == true Yes Retrieves any content item with the 
will_visit_schools property set to true. There 
are no single quotes around true, and true is 
lowercase.

genre != 'mystery' Yes Retrieves any content item that does not have 
case-sensitive mystery as the value for the 
genre property.

pub_date > toDate('MM-dd-yyyy', 
'01-01-2005')

Yes Retrieves any content item with a pub_date 
property set to a value later than January 1, 
2005.

books in series < 3 No Because the property name contains spaces, you 
must use toProperty(), as shown in the next 
example.

toProperty('books in series') < 3 Yes Retrieves any content item with a value less than 
3 for the books in series property.

toProperty('books in series') >= 3 No Retrieves any content item with value greater 
than or equal to 3 for the books in series 
property. The property value of the sample 
content item is 1.

toProperty('books in series') <= 3 Yes Retrieves any content item with value less than 
or equal to 3 for the books in series property. 

author like 'P?nm*' Yes Retrieves any content that contains case-sensitive 
Penman, Panmen, or any other variation with a 
different character between the P and the n and 
any characters after the m for the author 
property. Without an asterisk (*) at the end, the 
content item would not be retrieved, because 
more text follows the name Penman in the 
property value.

author likeignorecase 'pen*' Yes Retrieves any content with an author value that 
begins with pen in any case combination, such 
as penman, Penman, Penfield, and so on.

genre contains 'fantasy' Yes Retrieves any content containing an genre value 
of exactly fantasy.

genre contains 'child*' No The contains comparator does not allow 
wildcard characters.

genre containsall ('fantasy', 
'children')

Yes Retrieves any content that contains genre 
property values of fantasy and children. 

genre containsall ('fantasy', 
'children', 'scifi')

No Retrieves any content that contains genre 
property values of fantasy, children, and 
scifi. The sample content item contains 
fantasy and children, but not scifi.

genre containsany ('fantasy', 
'children', 'scifi')

Yes Retrieves any content that contains genre 
property values of fantasy, children, or 
scifi.

isbn in ('pending', 
'not_available')

Yes Retrieves any content that contains the isbn 
property value of either pending or 
not_available.
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Table 6–4 Complex Queries

Query
Will Retrieve 
Sample? Description

toProperty('books in series') >= 3 
&& pub_date > 
toDate('MM-yyyy','1-2005')

No Retrieves books that are part of a trilogy that 
were published after January 2005.

(genre contains 'children' || 
keywords like '*children*') && 
will_visit_schools == true

Yes Retrieves books with a genre value set to 
children or has *children* in the keyword 
value; and whose author is available to visit 
schools.

((genre contains 'children' || 
keywords like '*children*') && 
will_visit_schools == true) && isbn 
!= 'pending'

No Retrieves books with a genre value set to 
children or has *children* in the keyword 
value; and whose author is available to visit 
schools; and with an isbn value that does not 
equal pending (meaning the book is not yet 
published). The parenthetical nesting controls 
the order of evaluation.

(title likeignorecase '*adventure' 
|| genre contains 'fantasy') && 
(pub_date >= toDate('MM-yyyy', 
'01-2005') || isbn == 'pending')

Yes Retrieves books whose title contains 
*adventure or whose genre contains 
fantasy; and whose pub_date is after January 
2005 or whose isbn is still pending (not yet 
published).

(genre containsany 
userProperty('userpreferences', 
'BookGenre') && (keywords 
likeignorecase '*pixies')) || 
author likeignorecase 
userProperty('userpreferences', 
'FavoriteAuthor')

Depends Reads the User's Profile properties and uses 
specific property values to supply the values in 
the query. The query provides personalized 
content retrieval, because retrieved content is 
based on user preferences.

For example, if the current user has her 
BookGenre property set to mystery and her 
FavoriteAuthor set to Penman, Piper, this 
query will return the sample content. Even 
though the BookGenre value doesn't match in 
the first clause, the FavoriteAuthor in the or 
(||) second clause does match.

If you are using the Property control or the 
setProperty JSP tag to set user property sets 
and properties programmatically (rather than 
creating property sets in Oracle Enterprise Pack 
for Eclipse), you can still use userProperty() 
in your queries.

Table 6–5 Other Useful Queries (Not Related to the Sample Content)

Query Description

language == 
userProperty('userpreferences', 
'userPreferredLang')

This approach lets you serve language-appropriate 
content to each user based on the user language 
preference (userPreferredLang) stored in a property 
set. You could also use sessionProperty() to get the 
language preference from the session; or you could use 
requestProperty('DefaultRequestPropertySet
', 'Locale'), which returns the user's locale string, 
such as en-US.

((UserAge <= 35 && colors contains 'red' 
|| UserAge > 35 && !(colors contains 
'black')) && mimeType == 'text/html') 
&&toProperty('Launch Date') < now && 
!(expireDate > toDate('MM-yyyy', 
'12-2004'))

This query uses not logic, as shown in the !(colors 
contains 'black') clause.
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6.2.2 Using a JSP Tag to Display a Content Selector File
After you have created a Content Selector file (see Section 6.2.1, "Creating the Content 
Selector File"), you must use the <pz:contentSelector> JSP tag to display the 
content. The following JSP tag uses the classic Content Selector shown in 
Figure 6–3:

<pz:contentSelector rule="classic" id="nodes"/>

The JSP tag has two required attributes:

■ The rule attribute – Contains the name of the Content Selector file (without the file 
extension). This attribute tells the JSP tag which personalization rules and query to 
use.

■ The id attribute – When a Content Selector runs its query, the content is retrieved 
from the virtual content repository as an array of content properties. The id 
attribute, which is a String you enter when you set up the JSP tag, serves as a 
container that holds the array. At this point, you must use other JSP tags to handle 
the array and display the content. For details on what you can do with the array of 
properties to display the content, see Section 7.1.1, "Displaying Additional MIME 
Types in a Placeholder."

There are other attributes you can set on the <pz:contentSelector> tag. See the 
Oracle Fusion Middleware JSP Tag Java API Reference for Oracle WebLogic Portal for more 
information on the class.

6.2.2.1 Adding a Content Selector to a JSP
After you create a Content Selector file in Oracle Enterprise Pack for Eclipse, you can 
use any of the following three methods to add the Content Selector to a JSP in Oracle 
Enterprise Pack for Eclipse:

■ Drag a Content Selector from the Design Palette onto a page of an open portal file. 
See the instructions in Section 6.2.2.1.1, "Dragging a Content Selector to a Portal 
File."

■ Open the JSP to which you want to add the Content Selector, and drag the Content 
Selector file from the Design Palette into the JSP. The JSP tag is added 
automatically, the rule attribute is automatically populated with the name of the 
Content Selector, and the id attribute is included (without a value). The include 
statement for the tag library is automatically added. See Figure 6–5.
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Figure 6–5 Adding a Content Selector to a JSP in Oracle Enterprise Pack for Eclipse

■ Drag the <pz:contentSelector> JSP tag from the JSP Design Palette window 
(in the Portal Personalization category) into an open JSP and populate the tag's 
attributes manually. Get to the JSP Design Palette by choosing Window > Show 
View > Design Palette. The include statement for the tag library is 
automatically added.

6.2.2.1.1 Dragging a Content Selector to a Portal File  Perform the following steps to drag a 
Content Selector to an open portal file:

1. In the Portal Perspective, locate a Content Selector file.

2. Drag a Content Selector from the Design Palette onto a page of an open portal file. 
When you do this, three things occur:

a. The Portlet Wizard appears, letting you quickly create a portlet that will 
display the Placeholder.

b. The resulting portlet is automatically added to the portal page.

c. A JSP file is automatically created for the Content Selector.

The JSP file contains the Content Selector JSP tag with the rule and id attributes 
automatically populated, and the include statement for the tag library is 
automatically added. Other JSP and HTML tags are also added automatically, as 
shown in Example 6–1.

Example 6–1 JSP File with Other JSP and HTML Tags

<pz:contentSelector rule="modern" id="nodes"/>
<utility:notNull item="<%nodes%">
<ul>
   <utility:forEachInArray array="<%=nodes%>" id="node"  
      type="com.bea.content.Node">
      <li><cm:getProperty id="node" name="cm_nodeName"
         conversionType="html"/></li>
   </utility:forEachInArray>
</ul>
</utility:notNull>

Table 6–6 describes the JSP tags you can use with a Content Selector.
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6.2.2.1.2 Using More than One Content Selector  You can use multiple Content Selectors 
with conditional logic to get hierarchical personalized content, where you try to match 
the most specific to the least specific, or for mutually exclusive Content Selectors. 
Example 6–2 demonstrates how to use multiple Content Selectors for personalized 
content.

Example 6–2 Using the <pz:contentSelector> JSP Tag for Multiple Content Selectors

<%@ taglib uri="http://www.bea.com/servers/portal/tags/content" prefix="cm"%>
<%@ taglib uri="http://www.bea.com/servers/p13n/tags/utility" prefix="utility"%>
<%@ taglib uri="http://www.bea.com/servers/portal/tags/ad" prefix="ad"%>
<%@ taglib uri="http://www.bea.com/servers/portal/tags/personalization"
   prefix="pz"%>
<pz:contentSelector rule="FemaleContent" id="nodes" sortBy="cm_nodeName desc"/>
<% if (nodes == null || nodes.length <= 0) { %>
<pz:contentSelector rule="MaleContent" id="nodes" sortBy="cm_nodeName desc"/>
<% }%>
<% if (nodes == null || nodes.length <= 0) { %>
   Sorry, you don't get a free lunch today.
<% }%>
   Found <%=nodes.length%> Node(s):
<dl>
<utility:forEachInArray array="<%=nodes%>" id="node"
   type="com.bea.content.Node">
<dt><cm:getProperty id="node" name="title" conversionType="html"/></dt>
<dd><ad:render id="node" /></dd>
</utility:forEachInArray>
</dl>

6.3 Using the <pz:div> Tag Instead of a Content Selector
The <pz:div> JSP tag can provide in-line HTML Personalization. You can populate a 
JSP with sets of in-line content and wrap it with the tag. The tag uses a rule attribute 
that takes the name of an existing User Segment. Only members of that User Segment 
can see the in-line content. For example, you created a User Segment called 
bookfanUserSegment.seg in Oracle Enterprise Pack for Eclipse that makes anyone 
a member who has a bookfan User Profile property set value set of true. The following 
sample code illustrates this:

<pz:div rule="bookfanUserSegment">
   <p>Only users who are book nerds will see this text!</p>
</pz:div>

Table 6–6 JSP Tags for Content Selectors

JSP Tag Description

<utility:notNull> Checks to see if the array actually contains content.

<ul> Provides a container for listing content items in a bulleted 
list.

<utility:forEachInArray> Iterates through the array and isolates each content item 
until all items in the array have been processed. Each item 
is given its own <li> bullet.

<cm:getProperty> Takes each content item from 
<utility:forEachInArray> and designates which 
content property is going to be displayed.
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User Segment rules (conditions) are the same as those available to Content Selectors, 
so the <pz:div> tag provides a similar level of Personalization. The difference is that 
Content Selectors retrieve their content from the virtual content repository, while the 
<pz:div> tag encloses its content in-line in the JSP.

6.4 Deleting a Content Selector Query
Deleting a Content Selector query removes the query from the Content Selector in 
Oracle Enterprise Pack for Eclipse and the Administration Console.

Developers perform the following steps to remove a query in a Content Selector:

1. In the Portal Perspective, open the Content Selector file in the 
<data>\src\contentselectors\GlobalContentSelectors folder in the Package 
Explorer View. 

2. Click the query link in the Content Selector Editor. 

3. Select the query in the Content Search dialog. 

4. Click Remove. 

5. Click OK.

6.5 Deleting a Content Selector
Removing a Content Selector removes it from Oracle Enterprise Pack for Eclipse and 
from the Administration Console.

Perform the following steps to delete a Content Selector:

1. In the Portal Perspective, open the Content Selector file in the 
<data>\src\contentselectors\GlobalContentSelectors folder in the Package 
Explorer View.

2. Right-click the Content Selector and choose Delete.

3. Click Yes to confirm the deletion. 

6.6 Modifying a Content Selector
You can use the following methods to edit the content that a Content Selector displays:

■ Oracle Enterprise Pack for Eclipse – Developers can use Oracle Enterprise Pack 
for Eclipse to modify a Content Selector's conditions and queries. For instructions, 
see Chapter 13.

Tip: Content Selectors can display binary content, such as images. 
See the Oracle Fusion Middleware Content Management Guide for Oracle 
WebLogic Portal for instructions.

Note: The steps in this chapter refer to the <data>\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently.

Tip: You should also delete any <pz:contentSelector> tags in your 
JSPs that reference the Content Selector you deleted.
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■ Administration Console – Portal administrators can use the Administration 
Console to edit a Content Selector's properties or description. For instructions, see 
Chapter 13.
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7Creating a Placeholder

A Placeholder is a predefined location in a JSP that displays a single piece of web 
content at a time that is dynamically retrieved from the WLP Virtual Content 
Repository. If more than one content query is registered for a Placeholder, the 
Placeholder uses predefined queries and logic to determine which query to run and 
which content item to display. If a content query does not return data, the Placeholder 
runs another registered query, if there is one. Each query has a priority, or weight that 
determines the specific content to display. 

For example, a Placeholder for a pet store could use a Campaign query to determine if 
the user is a bird lover and then display a special bird offer, as shown in Figure 7–1.

Figure 7–1 Placeholders can Display Default Content and Campaign Content

A Placeholder is made up of two parts:

1. A Placeholder file you create in Oracle Enterprise Pack for Eclipse

2. A companion JSP tag that performs the processing

When you create a Placeholder, you select the content to display, choose a query for 
the Placeholder, and then create the Placeholder itself.

This chapter includes the following sections:

■ Section 7.1, "Selecting Content for a Placeholder"

■ Section 7.2, "Creating a Placeholder"

■ Section 7.3, "Modifying a Placeholder"
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■ Section 7.4, "Using the <ad:adTarget> Tag Instead of a Placeholder"

7.1 Selecting Content for a Placeholder
Placeholders use a document's MIME-type attribute to generate the appropriate 
HTML tags that the browser requires. By default, Placeholders generate the 
appropriate HTML tags only for the following MIME types:

■ Images – A Placeholder generates an <img> tag with attributes that the browser 
needs to display the image. If you want images to be clickable, you must specify 
the target URL and other link-related information as ad attributes in your Content 
Management system.

■ Other types – A Placeholder passes the text directly to the JSP.

This section contains the following topics:

■ Section 7.1.1, "Displaying Additional MIME Types in a Placeholder"

■ Section 7.1.2, "Adding Content to a Placeholder"

7.1.1 Displaying Additional MIME Types in a Placeholder
To display content, Placeholders refer to a document's MIME type and then generate 
the HTML tags that a browser requires for the specific document type. For example, to 
display an image-type document, an ad placeholder must generate the <img> tag that 
a browser requires for images. By default, ad Placeholders can generate the 
appropriate HTML only for the MIME types listed in the Section 7.1, "Selecting 
Content for a Placeholder" section for images and other types of files.

■ Images – A Placeholder generates an <img> tag with attributes that the browser 
needs to display the image. If you want images to be clickable, you must specify 
the target URL and other link-related information as content properties in the 
Virtual Content Repository. 

■ Other types– A Placeholder passes the text directly to the JSP. 

If you are familiar with basic Java programming, you can write classes that enable 
Placeholders to generate HTML for additional MIME types. A video clip is an example 
of an additional MIME type.

Perform the following tasks to display additional MIME types in a Placeholder:

1. Create a utility or EJB project and add the Portal Web Application Services facet to 
the project. For general instructions, see Section 9.8.1.1, "Creating a Regular Event 
Class."

2. Create and compile a Java class to generate HTML.

3. Register the new class.

7.1.1.1 Creating and Compiling a Java Class to Generate HTML
To generate the HTML that the browser requires to display the MIME type, use Oracle 
Enterprise Pack for Eclipse to create a utility or EJB project, add the Portal Web 
Application Services facet to the project with the web project's Properties dialog. (You 
can also add this facet to an existing utility or EJB project that is part of your EAR file.) 

Caution: The <EMBED> tags do not always work correctly in all 
browsers. The behavior depends on the plug-ins you have configured.
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The next steps is to create a Java class that implements the 
com.bea.p13n.ad.AdRenderableContentProvider interface. For information 
on this interface, see the Oracle Fusion Middleware Java API Reference for Oracle 
WebLogic Portal.

7.1.1.2 Registering the New Class
After you save the class in a directory that is in your CLASSPATH, you must notify 
WebLogic Portal of its existence. You can do this manually or with the Administration 
Console. Choose Section 7.1.1.2.1, "Method 1" or Section 7.1.1.2.2, "Method 2" to add 
the class to your CLASSPATH.

7.1.1.2.1 Method 1  Perform the following steps to manually add the class to your 
CLASSPATH:

1. To add the class manually, stop the WebLogic Server. 

2. Create a backup copy of your application's META-INF\wps-config.xml file. 

3. Open the wps-config.xml file in a text editor and find the <AdService> 
element. 

4. Add the following as a sub-element of <AdService>: 

<AdContentProvider
Name="MIME-type"
Provider="YourClass.class"
Properties="optional-properties-for-your-class"
>
</AdContentProvider>

Provide the following values for the attributes of the AdContentProvider 
element:

■ Name – The name of the MIME type that you want to support. 

■ Provider – The name of the compiled Java file. If you saved the file below a 
directory that your CLASSPATH environment variable names, you must 
include the file's path name, starting one directory level below the directory in 
CLASSPATH.

■ Properties – Any additional properties or parameters want to pass to your 
object. 

For example, if you added <PORTAL_APP>/classes to the system CLASSPATH, 
save your class to support AVI files as 
<PORTAL_APP>/classes/myclasses/MimeAvi.class. The following code 
sample shows sample attribute values:

<AdContentProvider
Name="video/x-msvideo" 
Provider="myclasses.MimeAvi"
Properties="" 
>
</AdContentProvider>

5. Save your changes to the wps-config.xml file.

6. Restart the WebLogic Server.

You can also add the class to the CLASSPATH using the steps in Section 7.1.1.2.2, 
"Method 2."
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7.1.1.2.2 Method 2  Rather than manually adding the class to your CLASSPATH and 
activating the content provider, you can use the Administration Console to perform 
the following steps:

1. In Oracle Enterprise Pack for Eclipse, start the Administration Console by 
choosing Run > Open Portal Administration Console.

2. In the Administration Console, choose Configuration & Monitoring > Service 
Administration. 

3. Select Interaction Management in the Resource Tree and click Ad Service in the 
Browse tab.

4. In the Ad Content Providers section, click Add Ad Content Provider.

5. Enter a Description and a Name for the new content provider. In the Content 
Provider field, specify the name of the class that generates the HTML elements 
that the browser requires to display an ad of this MIME type. If you write your 
own class, it must implement the 
com.bea.p13n.ad.adRenderableContentProvider interface.

6. Click Update. 

7. After you add the content provider, you can add additional properties.

7.1.2 Adding Content to a Placeholder
You can add specific properties to content items that support using content in 
Placeholders. See Chapter 3.

7.2 Creating a Placeholder
Creating a Placeholder involves two steps:

1. Create a Placeholder file in Oracle Enterprise Pack for Eclipse.

2. Use companion <ph:placeholder> JSP tags in any relevant JSPs. See the Oracle 
Fusion Middleware JSP Tag Java API Reference for Oracle WebLogic Portal for more 
information on the Java class.

Each <ph:placeholder> JSP tag must use its name attribute to reference a 
Placeholder you have created in Oracle Enterprise Pack for Eclipse.

This section contains the following topics:

■ Section 7.2.1, "Creating a Placeholder File"

■ Section 7.2.2, "Building a Content Query"

■ Section 7.2.3, "Determining Which Query and Content to Display"

■ Section 7.2.4, "Adding a Placeholder to a JSP"

7.2.1 Creating a Placeholder File
A Placeholder is a predefined location in a JSP that displays a single piece of web 
content retrieved from the WLP Virtual Content Repository. A Placeholder uses 
queries to retrieve and display content.

By default, Placeholders support the following MIME types: HTML, XML, plain text, 
and images. To display additional MIME types in Placeholders, see Section 7.1.1, 
"Displaying Additional MIME Types in a Placeholder."
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Content returned from a Placeholder is displayed in a portlet. When a user views a 
portlet or a portal desktop containing a Placeholder, the Placeholder's rules and 
back-end logic run a query, retrieve zero or more pieces of content matching the query, 
and display one of the returned items. If no content is retrieved, none is displayed.

The queries for a Placeholder originate from two different locations:

■ From the Placeholder itself – When you create a Placeholder in the Placeholder 
Editor, you can also define default queries to run in the Placeholder. Default 
queries run for all anonymous and authenticated visitors. 

■ From a Campaign – When you create a Campaign in the Campaign Editor, one 
option is to display targeted personalized content in a Placeholder for a specific 
type of visitor.

Because a Placeholder can contain multiple queries, the Placeholder can display a 
different piece of content each time a user accesses the JSP containing the Placeholder. 
The following procedure includes a step that lets you set a query's priority to increase 
or decrease the chances that the query is run instead of other queries present in the 
Placeholder.

Placeholders are scoped to the enterprise application, so you can include Placeholders 
in any JSPs within the enterprise application.

Perform the following steps to create a Placeholder:

1. Start the WebLogic Server in Oracle Enterprise Pack for Eclipse by choosing Run 
As > Run on Server. For instructions on configuring the WebLogic Server, see the 
Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

2. In the Portal Perspective, right-click the <data>\src\placeholders folder in the 
Package Explorer View and choose New > Content Placeholder.

3. In the New Placeholder File window, enter a name for the Placeholder in the File 
name field. Keep the .pla file extension. 

4. Click Finish. The Placeholder Editor appears.

5. In the Design Palette tab, drag the New Query into the Placeholder Editor to 
define a default query, as shown in Figure 7–2.

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently.
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Figure 7–2 Define a Default Query by Dragging the New Query into the Placeholder Editor

Every query you add to the Placeholder in this way is a default query 
(non-Campaign). Campaigns can also put queries in this Placeholder, but Campaign 
queries are not defined in the Placeholders themselves. They are defined in the 
Campaigns. 

Figure 7–3 Click Show List to View Hidden Tabs

6. In the Property Editor window, set values for the following: 

■ Name – Enter a name for the query. The query name is used only for display 
purposes.

Note: If you do not see the Design Palette tab, click Show List to 
see other tabs that are not visible, as shown in Figure 7–3.
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■ Priority – Select the query's priority relative to other queries. A query with a 
higher priority is more likely to be run. 

7. To define the query, click the empty content search link in the New Query item 
you added. You can define the query using WebLogic Portal's expression syntax 
(on the Advanced tab) or in graphical mode (on the Query tab).

■ Advanced Mode – In the Content Search window, click the Advanced tab and 
build a query using the instructions in Section 6.2.1.1, "Building a Content 
Query with Expressions."

■ Graphical Mode – Begin with Step a and build a content query by selecting 
content properties, comparators, and values to retrieve content items. 

a. In the Content Search window, select the Query tab.

b. Select a content type in the Property set field, select a content property in the 
Property field, and click Add as shown in Figure 7–4. This example shows a 
content type of ad and a property of adTargetUrl. The adTargetUrl property 
makes an image clickable and provides a target for the clickthrough, expressed 
as a URL. See the Oracle Fusion Middleware Content Management Guide for Oracle 
WebLogic Portal for more information.

Figure 7–4 Choose a Content Type and a Content Property

8. In the Content Search Values window that appears, select one of the following 
tabs:

Values Tab – Define the query based on a comparison to a value you enter. For 
example, the query could be set to retrieve content with an investorRiskLevel 
property that is marked as high. The example in Figure 7–5 sets the query to 
retrieve an adTargetUrl of a web site.

Properties Tab – To define the content query based on the property value that is 
dynamically obtained from another type of property, such as a User Profile 
property. For example, instead of creating a query based on static content 
properties, you can create a query that reads the value of the current user's 

Note: The properties you select are content properties (types) rather 
than property set properties, such as User Profile or session 
properties. 
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investorRiskLevel to populate the query. The query would be different for each 
user. 

Figure 7–5 Select an Item for the Comparison Field and Enter a Value

9. Click Add. The query descriptor is added to the Value Phrases section. 

You can add more value phrases to the query and then set the appropriate option 
in the For multiple value phrases section at the bottom of the window. 

10. Click OK in the Content Search Values window.

11. Create additional queries as needed in the Content Search window. You can add 
more value phrases to the query in the Content Search window, and then set the 
appropriate option in the For multiple descriptors section at the bottom of the 
window. Click OK when you are done.

12. Click OK on the Content Search dialog. 

13. You can preview the content that will be retrieved by the query by selecting the 
Content Preview tab below the Editor. If you defined the query to use values from 
a User Profile property, the retrieved content will be different for each user, so you 
must enter the user name of an existing user in the Preview User field to see the 
content that will be retrieved for that user.

14. The Content Preview window shows content that the query will retrieve. 
However, since a Placeholder can show only one piece of content at a time, the 
single piece of content that is displayed varies depending on which query is run 
(determined by the priority you set for a query and the settings for Campaign 
queries) and the adWeight property setting on content. 

15. You must add the adWeight property to a content type as a single-value Integer. 
Content with a higher adWeight number has a higher likelihood of being selected 
for display in a Placeholder.

16. Save the Placeholder file. 
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17. Add the Placeholder JSP tag called <ph:placeholder> to the relevant JSP. You 
must add the Placeholder filename to the Placeholder tag and run the JSP to see 
the results. 

7.2.1.1 Choosing the Type of Placeholder Query to Run
Placeholders can run two types of queries: default queries and Campaign queries.

Both types of queries have the same structure but originate from different places:

■ Default Query – When you create a Placeholder file in Oracle Enterprise Pack for 
Eclipse, you can also add one or more queries to that Placeholder file that always 
remain with the Placeholder (unless you change or remove the queries in Oracle 
Enterprise Pack for Eclipse). These are called default queries. They return content 
from the virtual content repository regardless of who is viewing the portlet or JSP 
in your portal.

A Placeholder can run a default query every time a user loads a page that includes 
the Placeholder. For example, you define a header for a particular shell that 
contains a JSP file with a Placeholder. If that Placeholder contains a default query, 
a user is likely to see different content in the header each time the user visits or 
refreshes the desktop.

If a Campaign also targets the Placeholder, you can configure the Placeholder to 
show only content from that Campaign, or integrate Campaign content along with 
default query content. 

■ Campaign Queries – When you create a Campaign in Oracle Enterprise Pack for 
Eclipse, one of the things you might want to do is trigger Campaign-specific 
content to appear in a specific place on the desktop. Campaigns use Placeholders 
to display personalized content. When you define a content action in a Campaign, 
one of the steps is to select an existing Placeholder to run the Campaign query you 
define. Campaign content queries are dynamically placed by a Campaign when 
certain actions (events) occur. For example, a user who belongs to a certain User 
Segment logs into the desktop.

You can set default queries to not run when a query placed by a Campaign is 
present in the Placeholder.

Figure 7–6 shows the location on a page where the Placeholder displays an image, 
either from a default query or a Campaign query. The image is retrieved from the WLP 
Virtual Content Repository through a query. A Placeholder uses different factors to 
determine which query to run and then which retrieved content item to display.

Note: An alternative to using Placeholders is using the 
<ad:adTarget> JSP tag to hard-code a content query within the tag. See 
Section 7.4, "Using the <ad:adTarget> Tag Instead of a Placeholder" for 
more information.

Tip: You should create a default query for a Placeholder, because it 
ensures that a content item always appears in the Placeholder.
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Figure 7–6 Placeholders can Display Default Content or Campaign Content

7.2.2 Building a Content Query
You can use the WebLogic Portal Expression language in Oracle Enterprise Pack for 
Eclipse to build content queries. The advanced query-building window is available 
from content-related JSP tags and when building queries for Placeholders, Campaigns, 
and Content Selectors.

If more than one content query is registered for a Placeholder, for example, the 
Placeholder uses predefined queries and logic to determine which query to run and 
which content item to display. If a content query does not return data, the Placeholder 
runs another registered query, if there is one. Each query has a priority, or weight that 
determines the specific content to display.

A query contains three parts: <property> <comparator> <value>.

7.2.2.1 Using Expressions
The following two types of properties are available for content, and you can use both 
in queries:

■ User-defined content properties

■ Explicit (system) content properties

See Section 6.2.1.1, "Building a Content Query with Expressions" for instructions and a 
list of explicit content properties.

7.2.2.2 Using Comparators
Comparators provide the logic that compares a query's property to the value you 
enter. If a content item meets the conditions of the query, the content item is returned. 
See Section 6.2.1.1.3, "Using Comparators" for instructions.

7.2.2.3 Using Values
Values represent the content you want the query to return. By supplying values to a 
query, you're telling the query which content to retrieve (or ignore) based on the 
values stored on the content items. See Section 6.2.1.1.4, "Supplying Values" for 
instructions.
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7.2.2.4 Following Guidelines for Complex Queries
You can combine multiple independent query clauses, tying them together with and 
(&&) and or (||) logic and controlling the order of evaluation with parentheses the 
way you would with algebraic expressions. This lets you create more complex queries. 
See the Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal 
for instructions and a list of example queries.

7.2.3 Determining Which Query and Content to Display
Placeholders perform a two-step process to choose which content to display. This 
section describes the following tasks:

1. How a Placeholder chooses which query to run

2. Once a query runs, how a Placeholder chooses which content item to display from 
the query

7.2.3.1 Choosing a Query to Run
When you add a default query to a Placeholder or create a Campaign query in Oracle 
Enterprise Pack for Eclipse, you can assign each query a priority: highest, high, 
normal, low, or lowest. The higher the priority, the higher the likelihood that the 
query will be run instead of other queries.

If a query does not find any documents, the Placeholder chooses another query and 
runs it.

You can also define default queries so that they do not run when Campaign queries 
are present. For instructions, see Chapter 14.

7.2.3.2 Choosing Which Content Item to Display
Depending on how broadly you define a query and on the number of documents in 
your Content Management system, a query could return multiple content items. By 
default, a Placeholder randomly selects a content item to display. To make this 
selection less of a random choice, you can add a property called adWeight to your 
content items, as described in Section 3.2, "Determining Content Priority."

The higher the adWeight number you assign to a content item, the better the chance 
that the content item will be displayed in a Placeholder when the content item is 
retrieved by a query.

7.2.4 Adding a Placeholder to a JSP
After you create a Placeholder file in Oracle Enterprise Pack for Eclipse, you can use 
any of the following methods to add the Placeholder to a JSP in Oracle Enterprise Pack 
for Eclipse:

■ Drag a Placeholder from the Design Palette onto a page of an open portal file. 
When you do this, three things happen:

1. The Portlet Wizard appears, letting you quickly create a portlet that displays 
the Placeholder.

2. The resulting portlet is automatically added to the portal page.

3. A JSP file is automatically created for the Placeholder. The JSP file contains the 
Placeholder JSP tag with the name attribute automatically populated with the 
name of the Placeholder. The include statement for the tag library is 
automatically added.



Modifying a Placeholder

7-12 Oracle Fusion Middleware Interaction Management Guide for Oracle WebLogic Portal

■ Open the JSP where you want to add the Placeholder, and drag the Placeholder 
file from the Design Palette into the JSP in either Design View or Source View. The 
JSP tag is added automatically, the name attribute is automatically populated with 
the name of the Placeholder, and the tag library include statement is 
automatically added.

■ Drag the <ph:placeholder> JSP tag from the JSP Design Palette (the Portal 
Content Placeholder category) into an open JSP and populate the tag's name 
attribute manually. The tag library include statement is added automatically. In 
Figure 7–7, the Placeholder file is called foo, and the JSP tag references the 
Placeholder file. 

Figure 7–7 The Two Parts of a Placeholder: a Placeholder File and a JSP Tag

7.3 Modifying a Placeholder
You can use either of the following two ways to modify a Placeholder:

■ Developers can use Oracle Enterprise Pack for Eclipse – For instructions on 
modifying Placeholder properties or queries in Oracle Enterprise Pack for Eclipse, 
Chapter 14.

■ Portal administrators can use the WebLogic Portal Administration Console – For 
instructions on modifying Placeholder values in Administration Console, see 
Chapter 14.

See Section 14.4, "Managing Placeholders for Optimal Performance" for information on 
changing Placeholders to improve performance.

7.4 Using the <ad:adTarget> Tag Instead of a Placeholder
You can also use the <ad:adTarget> JSP tag to display a content item on a JSP. This 
tag does not rely on a definition file like a Placeholder does. You simply add a query 
using the tag's query attribute. The query retrieves one or more content items (the 

Tip: During the development phase of your project when you are 
updating content frequently, consider disabling or flushing the portal 
caches. To do this, use the Portal Cache Manager tool. To start this 
tool, select Run > Portal Cache Manager in Oracle Enterprise Pack for 
Eclipse. 
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same types of content items that Placeholders can display), and the tag chooses which 
content item to display in the same manner as the <ph:placeholder> tag. 
Campaigns do not put queries into an <ad:adTarget> tag, so the tag cannot display 
personalized content. You can also use <pz:contentQuery> and <cm:search> tags 
to execute runtime queries and return content that can be displayed.

For more information on the class for the <ad:adTarget> JSP tag, see the Oracle 
Fusion Middleware JSP Tag Java API Reference for Oracle WebLogic Portal.

The following code sample shows how to set up rotating banner-style content:

<%@ taglib uri="http://www.bea.com/servers/portal/tags/ad" prefix="ad"%>
<ad:adTarget query=" color == userProperty('GeneralInfo', 'FavoriteColor') "/>

Tip: You can get rotating banner-style content on your portal by 
picking one content item and cycle through the matching items on 
subsequent requests. You can use the <ad:adTarget> JSP tag, which 
uses the AdConflictResolver to pick which content to show. That will 
get each node's adWeight property (converted to a number) as the 
relative weight of each node and then use a random number to pick 
which content to use. The higher the weight, the more likely the 
content is to be displayed. If the item doesn't have an adWeight 
property, it assumes a value of 1. 
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8Building a Campaign

WebLogic Portal's Campaigns help you accurately target visitors and trigger multiple 
actions—or even simultaneous actions—in a browsing session. Campaigns deliver the 
right content to the right user at the right time.

You can use Campaigns to personalize your portal in the following ways:

■ Display personalized web content – When you use a Campaign to display 
personalized content, the content (for example, an image) is retrieved from the 
WLP Virtual Content Repository through a query and displayed in a Placeholder 
on a JSP. The JSP can exist in a portlet or in a desktop header region.

■ Send predefined e-mails automatically – The Campaign service reads User 
Profile properties to obtain a user's e-mail address, and then sends a predefined 
e-mail to that user.

Marketing goals generally drive the content of a Campaign. For example, you might 
want people who log in with a certain browser type at lunch time to view content 
related to lunch specials. A bank might determine which portfolio to recommend, or a 
travel site would recommend a specific hotel chain.

Campaigns are flexible, because they let you create business logic without requiring 
code changes. For example, Campaigns show web content using a JSP tag called a 
Placeholder that is similar to the following: <ph:placeholder 
name="myPlaceholder1"/>. Add JSP Placeholder tags (uniquely identified by the 
name attribute) anywhere in your portal's JSPs. Then define your Campaigns to use 
the existing Placeholders, each of which can display content unique to the Campaign 
and to the individual users. You can change and add new Campaigns, but you never 
have to change your JSP code. The Placeholders you need stay the same.

In addition to providing flexibility and Personalization, Campaigns begin at a specific 
time and end when their purpose has been fulfilled (when specific goals are achieved 
or a time deadline is reached). Campaigns can even be set up to run only once for each 
visitor. 

Structurally, a Campaign contains at least one scenario. Each scenario contains one or 
more actions that show personalized content, send an automatic e-mail, or provide a 
personalized discount. The advantage of scenarios as containers for actions is that you 
can use User Segments to determine which users are eligible to be targeted with the 
actions in a scenario (but you are not required to assign User Segments to scenarios). 
For example, you could create a Campaign with two scenarios: one that targets its 

Note: A Campaign can also work for tracked anonymous users. See 
Section 8.2.6, "Targeting a Campaign to Tracked Anonymous Users."
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actions only to males and the other that targets its actions to females. Table 8–1 shows 
how the logic works in a scenario for females.

The chapter includes the following sections:

■ Section 8.1, "Performing the Prerequisite Tasks"

■ Section 8.2, "Building a Campaign"

■ Section 8.3, "Testing a Campaign"

■ Section 8.4, "Triggering a Campaign"

■ Section 8.5, "Turning Off a Campaign"

■ Section 8.6, "Resetting a Campaign"

8.1 Performing the Prerequisite Tasks
Complete the following tasks before you create a Campaign:

1. Read the Section 2.3, "Checklist for Planning Your Campaign Strategy."

2. If you decided to use Session or Request properties to trigger Campaign actions, 
verify that you performed the following tasks:

■ In the JSP containing the event to be fired, get the request attribute through a 
variable or set it directly in the JSP

■ In the JSP containing the event to be fired, get or set any event properties you 
want to use

■ If you want to use session properties to trigger Campaign actions, verify that 
the firing event is in the same session containing the session properties you 
want to use

For more information on Session or Request properties, see Section 4.1.3, "Creating 
a Session Property Set" or Section 4.1.4, "Creating a Request Property Set."

3. Determine if you plan to use goal setting to end your Campaign. Goal Setting can 
end a Campaign based on the number of content items displayed or clicked. See 
Section 8.2.2.1, "Setting Goal Definitions" and Section 8.2.2.2, "Adjusting Goal 
Definitions" for instructions.

8.2 Building a Campaign
Developers create Campaigns and administrators use those Campaigns as templates to 
modify Campaign characteristics and create new Campaigns with similar 
characteristics.

Table 8–1 A Campaign Scenario that Targets Females Who Recently Visited the Web 
Site

Query/Response Action

Question: Are You a Member of the Female User Segment and Have Not Visited 
the Site in the Last 30 Days?

Yes: Your User Profile indicates that you are female and have visited the site 
in the last 30 days. If this Campaign is triggered, you are targeted with 
any of the actions in this scenario that apply to you.

No: Your User Profile indicates that you are a male. If this Campaign is 
triggered, you are not targeted with any of the actions in this scenario.
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Building a Campaign requires that you plan your Campaign logic for scenarios and 
actions, create a Campaign file, add then add the scenarios and actions.

This section contains the following topics:

■ Section 8.2.1, "Planning Your Campaign Logic"

■ Section 8.2.2, "Creating a Campaign File"

■ Section 8.2.3, "Adding a Scenario to a Campaign"

■ Section 8.2.4, "Adding an Action to a Scenario's Rule"

■ Section 8.2.5, "Setting Up Automatic E-Mail Messages"

■ Section 8.2.6, "Targeting a Campaign to Tracked Anonymous Users"

8.2.1 Planning Your Campaign Logic
A Campaign uses units called actions to perform specific Personalization tasks. 
Actions are triggered by specific conditions you set, and the actions are grouped into 
scenarios.

For example, a Campaign Action can be triggered by the following conditions: When a 
user logs in between January 1 and January 31, and that user is a member of the non-manager 
User Segment, trigger the Campaign to do something. The action could then do the 
following: When the Campaign is triggered, send an automatic e-mail reminding the user to 
complete an annual performance review.

A Campaign can contain multiple scenarios, each of which can contain multiple 
actions. An action is triggered when all of the following items are true:

■ An event is fired and the Campaign service is listening for it. See Section 9.11.1, 
"Registering Events for Campaigns" for more information. 

■ The conditions of the action are met, or a user belonging to a specific User 
Segment logs in, which triggers a scenario to fire all of its actions. 

■ The Campaign is set to active and has not expired (through a date deadline or if its 
goals were met). 

Table 8–2 shows Campaign Action rules that are created in Oracle Enterprise Pack for 
Eclipse.

This rule is evaluated only if an event occurs for which the Campaign service is 
listening. (This event does not need to be used directly in the Campaign rule.) For 
example, if the Campaign service is configured to listen for the Oracle-provided 
UserRegistrationEvent (which it is by default), then when a UserRegistrationEvent 
occurs, the event takes a snapshot of the Request object and the Campaign rules are 
evaluated.

The following list is the order in which the previous Campaign action rules are 
evaluated:

Table 8–2 Campaign Action Rules

Rule Action

When all of the following conditions 
apply:

An HTTP request has the following properties: 
RequestPropertyOne is equal to success

Any of the following events has occurred: SessionLoginEvent

Do the following: Content Action, E-mail Action, or Discount Action
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■ Is there a request property called RequestPropertyOne with a value of success?

■ Is this a SessionLoginEvent?

■ Are all of these conditions true?

Because a UserRegistrationEvent woke up the Campaign service and took a snapshot 
of the request object, the Campaign Action is not triggered, because the rule requires 
that all of its conditions evaluate to true. The SessionLoginEvent rule is false 
(because it was the UserRegistrationEvent that woke up the Campaign service).

If the rule was defined differently so that any of the conditions evaluating to true 
would trigger the action (rather than all conditions), the Campaign action fires if the 
request property evaluates to true.

8.2.2 Creating a Campaign File
The steps in this chapter refer to the data\src folder in the Package Explorer View. 
Your data and src directories might be named differently.

Perform the following steps to create a Campaign file and set Campaign properties:

1. Start the WebLogic Server in Oracle Enterprise Pack for Eclipse by choosing Run 
As > Run on Server. For instructions on configuring the WebLogic Server, see the 
Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal. 

2. In the Portal Perspective, right-click the <data>\src\campaigns folder in the 
Package Explorer View and choose New > Campaign.

3. Enter a name for the Campaign in the File name field, using the .cam file 
extension.

4. Click Finish. Select the Campaign in the Campaign Editor when it appears.

5. Select the Properties tab and set the following properties for the General property. 
These properties help determine if the Campaign will run. Use the following 
description to set each property:

■ Active – Set the value to true if you want the Campaign to be run. Set the 
value to false if you do not want the Campaign to run. 

■ Description – Enter a detailed description of the Campaign. The description is 
appended to the text in the Description window. 

■ Is Complete – Read-only value of true or false. If the conditions for the 
Campaign are all complete, the Is Complete property is set to true. If the 
field is false, you should check each action and scenario to determine which 
properties are missing.

■ Name – Read-only. The name of the Campaign (the Campaign filename). 

■ Sponsor – Enter the name of the organization or person sponsoring the 
Campaign. 

6. If you are displaying personalized content in a Campaign, expand the Goals 
property in the Properties tab and set the following properties:

■ Description – Enter a description about the goals that will end a Campaign 
prior to its stop date. Click OK in the Property Text Editor dialog box when 
you are done.

■ Goal Definitions – End a Campaign prior to the Campaign stop date when 
specific images are viewed or clicked in a portal. Goal Setting can end a 
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Campaign based on the number of content items displayed or clicked. See 
Section 8.2.2.1, "Setting Goal Definitions" for instructions.

7. Expand the Timing property in the Properties tab and set the following 
properties:

■ Start Date – Click the ellipsis icon [...] and set the month, day, and time (in 
your time zone) you want the Campaign to start. Click OK.

■ Stop Date – Click the ellipsis icon [...] and set the month, day, and time (in 
your time zone) you want the Campaign to end. Click OK.

See Figure 8–1. 

8. Choose File > Save to save your work.

Figure 8–1 Sample Properties for a New Campaign

8.2.2.1 Setting Goal Definitions
Perform the following steps to define a Campaign goal:

1. In the Portal Perspective, select the Campaign you created in Section 8.2, "Building 
a Campaign."

2. In the Properties tab, expand the Goals property.

3. In the Goal Definitions field, click the ellipsis button [...], as shown in Figure 8–2.

Figure 8–2 Click the Ellipsis Button to Get to the Edit Campaign Goals Window

The Edit Campaign Goals window appears.

1. In the Edit Campaign Goals window, click New. 

2. In the Campaign Goals section, enter a number in the Count field for the number 
of times the content item must be viewed or clicked to meet the goal. 
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3. Select an item from the drop-down list in the Count Type field that determines 
whether the content item must be viewed (Impressions) or clicked 
(Click-throughs).

4. Select an item from the drop-down list in the Type field. The type determines if the 
content impression or clickthroughs must be on content displayed by this 
Campaign (From this Campaign only) or on the content displayed by the 
Campaign or outside of the Campaign (From anywhere). 

5. Select an item from the Logic field to determine if the count can be reached by 
adding the impressions or clickthroughs for all selected content items (Summing 
the path counts) or if it can be reached when any one content item in the list 
must reach the count number (Against any one path). 

6. In the Goal Paths section, add content items to use in the goal. To populate the 
Goal Paths list, do one or both of the following: 

■ In the Add Path to Goal field, enter the repository path to a content item in 
WLP's Virtual Content Repository, and click Add. 

■ In the Retrieve Query Paths field, select a content action you have already 
defined in your Campaign. The content action has an associated query that 
will retrieve specific content items from the Virtual Content Repository. Click 
Get to retrieve a list of content items that the query will retrieve. Select the 
content items you want and click Add. 

7. Create additional goals as required. Each goal you add in the Campaign Goals 
section has associated content items in the Goal Paths section. For example, you 
can add a goal that states, If a piece of content is viewed (Impressions) three times (the 
Count), the goal is met. 

8. If you create more than one goal, select the appropriate End the campaign option 
below the Campaign Goals section. 

9. Click OK in the Edit Campaign Goals window. 

10. Save the Campaign by choosing File > Save. 

11. After you save the Campaign, you are prompted to reset the Campaign by 
selecting options in the Reset Campaign dialog box and clicking OK, as shown in 
Figure 8–3.

Note: For a content item to use clickthrough functionality, it must 
have one of the following properties set: adTargetUrl, 
adTargetContent, or adMapName. The property value for any of 
these properties is a URL that, when clicked, takes the user to the 
location you want. In a portal, URLs are relative to the portal Web 
project root directory. See Section 8.2.2.3, "Creating URLs to Portal 
Resources" for more information. 
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Figure 8–3 You Can Reset a Campaign by Selecting the Reset All Options Check Box

8.2.2.2 Adjusting Goal Definitions
The following examples goals show how you can modify Goal Setting and the 
consequences:

■ Determine how frequently the Campaign service checks to see if goals have been 
met by performing the following steps:

1. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

2. In the Resource Tree, expand the Interaction Management folder and then 
select Campaign Service.

3. In the Configure tab, click Configuration Settings for Campaign Service. 

4. Set the Goal Check Time to the frequency you want. The default is 300000 
milliseconds (five minutes). Less-frequent goal checks improve performance, 
but the Campaign service takes longer to determine if goals were met. For 
testing, set the value to 0 so that there are no delays in checking for goals.

5. Click Update.

■ Determine how many impressions or clickthroughs occur before that number is 
written to the database. In the database, the Campaign service compares the 
current count to the impressions or clickthrough goal you set in the Campaign. 
Perform the following steps:

1. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

2. In the Resource Tree, expand the Interaction Management folder and then 
select Ad Service.

3. In the Configure tab, click Configuration Settings for: Ad Service.

4. Set the Display Flush Size to the number you want. The default is 10. A larger 
flush size improves performance, but the Campaign service takes longer to 
determine if goals were met. For testing, set the flush size to a small number to 
ensure Campaigns end immediately after your goals are met.

5. Click Update.

8.2.2.3 Creating URLs to Portal Resources
WebLogic Portal provides an extensible mechanism to create URLs to your portal 
resources in a portal web project that can transfer from domain to domain without 
breaking, especially when server names and port numbers change. This URL-creation 



Building a Campaign

8-8 Oracle Fusion Middleware Interaction Management Guide for Oracle WebLogic Portal

mechanism also lets you switch between secure and non-secure URLs (HTTP and 
HTTPS).

Use the following two items to create portable URLs:

■ The <render:*Url> JSP tags in the Portal Skeleton Rendering JSP tag library 
(see the JSP Design Palette)

■ A portal web project's WEB-INF/beehive-url-template-config.xml file

The beehive-url-template-config.xml file contains multiple URL templates, 
each with a unique name. These template URLs contain variables such as 
url:domain and url:port that are read from the active server. The 
<render:*Url> JSP tags have a template attribute in which you can specify the 
name of a URL template in the beehive-url-template-config.xml file.

The following examples show how the JSP tags use the templates to create URLs:

■ A sample URL template exists in the beehive-url-template-config.xml 
file:

<pz:contentSelector rule="classic" id="nodes"/>
<utility:notNull item="<%=nodes%>">
<ul>
<utility:forEachInArray array="<%=nodes%>" id="node" 
type="com.bea.content.Node">
<img src="<%=request.getContextPath() + "/ShowProperty" + node.getPath()%>">
</utility:forEachInArray>
</ul>
</utility:notNull>

You can use any of the URL templates in the beehive-url-template-config.xml 
file provided by WebLogic Portal, and you can add as many templates as you want to 
the file.

You can use any of the following variables when you build a URL template:

■ The {url:domain} variable – Reads the name of the server from the current 
request.

■ The {url:port} variable – Reads the listen port number of the server from the 
current request. See Section 8.2.2.3.1, "Troubleshooting the URLs."

■ The {url:securePort} variable – Reads the SSL port number of the server from the 
current request. See Section 8.2.2.3.1, "Troubleshooting the URLs."

■ The {url:path} variable – Reads the name of the web application. The URLs to all 
resources in a web application are relative to the web application directory. 

■ The {url:queryString} variable – Reads a queryString variable for the URL.

8.2.2.3.1 Troubleshooting the URLs   If you are using a proxy server or you are switching 
between non-secure and secure ports, you may find that URLs do not resolve if you 
use the {url:port} or {url:securePort} variables. The URLs do not resolve 
because the variables for those values are read from the request. For example, if a user 
in a non-secure port (port number 80) clicks a secure HTTPS link that was created with 
a URL template that uses the {url:securePort} variable, the port number of the 
request (80) is used for the {url:securePort} variable, which creates a secure 
request (HTTPS) on an non-secure port. The same result could occur if a user on a 
proxy server (port 80) clicks a link to a resource outside the proxy server (port 443).

In both cases, you should hard code port numbers in the URL templates to get URLs to 
resolve correctly.
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The beehive-url-template-config.xml file automatically created in a portal 
web project also contains URL templates and variables for Web Service for Remote 
Portlets (WSRP). These templates must remain in the file if you plan to be a WSRP 
producer. See the Oracle Fusion Middleware Federated Portals Guide for Oracle WebLogic 
Portal for more information.

8.2.3 Adding a Scenario to a Campaign
Campaigns contain actions that perform specific Personalization tasks and are 
triggered by specific conditions you set. Actions are grouped into scenarios. A 
Campaign can contain multiple scenarios; each scenario can contain multiple actions. 

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, select the 
Campaign you created in Section 8.2, "Building a Campaign."

2. Drag the New Scenario item from the Design Palette tab into the Campaign 
Editor. You can use four scenario templates that contain predefined actions and 
conditions. If you drag one of these scenarios into the Campaign Designer, see the 
Description window for details on each.

3. In the Properties tab, expand the General Property item and set the following 
properties: 

■ Active – Set the value to true if you want the Campaign to run. Set the value 
to false if you do not want the Campaign to run. 

■ Description – Click the ellipsis icon [...] and enter a detailed description of the 
scenario. Your description is appended to the text in the Description window. 

■ Is Complete – This field displays a read-only value of true or false. If the 
conditions are all complete (the conditions for the Campaign, each scenario, 
and each action), the Is Complete property is set to true. If the field is false, 
you should check each action and scenario to determine which properties are 
missing.

■ Name – Enter a name for the scenario. 

■ Segments – If you want all actions in the scenario to run if the user is a 
member of one or more User Segments, click the ellipsis icon [...] and select the 
User Segments you want to use. For example, BirdLovers.

Figure 8–4 shows these three fields in a Campaign designed to offer a 25% 
discount to users who belong to the BirdLovers User Segment.

Figure 8–4 Campaign Property Editor

6. Add more scenarios as needed. For example, you could include an image of a 
parrot.

7. Save the Campaign by choosing File > Save.
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8.2.4 Adding an Action to a Scenario's Rule
You can add the following actions to the rule in your scenario:

■ Section 8.2.4.1, "Adding a New Object Instance" – Creates a new instance of an 
object and adds it to the object available in the rule set. This new object can then 
trigger other rule conditions that match and their actions that will be invoked.

■ Section 8.2.4.2, "Invoking a Static Method" – Calls any static method on any 
available class. 

■ Section 8.2.4.3, "Invoking an Instance Method" – Calls a method on an available 
ruleset's object.

■ Section 8.2.4.4, "Placing Content in a Placeholder" – Retrieves web content from a 
content repository and displays the selected content in a predefined placeholder.

■ Section 8.2.4.5, "Sending an E-Mail in a Campaign" – Sends a predefined e-mail to 
a user in your Campaign.

You can add multiple actions to each rule in a scenario.

8.2.4.1 Adding a New Object Instance
The Add a new object instance rule action creates a new instance of an object and 
adds it to the object available in the rule set. This new object can then trigger other rule 
conditions that match and the actions that will be invoked.

Perform the following steps to add a new object instance to your Campaign:

1. In the Portal Perspective, select the Campaign you created in Section 8.2, "Building 
a Campaign."

2. From the Design Palette tab, drag the Add a new object instance rule action onto 
the appropriate scenario in the Campaign Editor. See Figure 8–5.
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Figure 8–5 Drag the Action to Your Scenario's Rule

3. Select the Properties tab and enter a name for the action.

4. In the action, click the all link to toggle back and forth between any and all to 
determine which conditions will trigger the action. The any choice means that 
only one of the conditions must be true for the action to occur.

5. Click the [event] link to choose an available event that will trigger the action. 
Events can include logging in, clicking a graphic, clicking a button, adding an item 
to a shopping cart, navigating to another page in a portal, and so on. Some events 
are predefined or you can define your own custom events (see Section 9.8, 
"Creating Custom Events"). After you select the event, click Add and then click 
OK.

6. Click the [java type] link. To see a list of all available Java types, enter **. Use these 
guidelines to view the Java types: 

■ Enter * for any string and ? for any character. See Figure 8–6.
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Figure 8–6 Enter ** to See all Available Java Types

■ You can also enter TZ, for example, for types containing T and Z as uppercase 
letters in camel case notation. An example of this is java.util.TimeZone. You 
could enter NuPoEx for types containing Nu, Po, and Ex as parts in camel case 
notation (for example, java.lang.NullPointerException). The Matching types 
field displays matches for the expression you type in the Select a type field. 

After you select the Java type, click OK.

7. Click the [no arguments] link to choose an argument to the method call. Click Add 
and choose one of the following: String, Boolean, Integer, Long, Double, Float, 
Null Argument, Property Reference, or Variable Reference. Enter the new value 
and click OK. After you enter all the arguments, click Finish.

8. In the Available Conditions section in the Design Palette tab, select the conditions 
you want to trigger the action. When you select a condition, a corresponding link 
appears in the action area. Click the link to define the condition. 

9. Save the Campaign file by choosing File > Save.

8.2.4.2 Invoking a Static Method
The Invoke from static method rule action executes any static method from an 
available object or class. This action also has the ability to use bound variables from 
the Conditions section of the rule set as an argument in the static method, in addition 
to property references, standard Java type (String, Boolean, and so on), and other types 
available in the project. The ability to call a Java method and have several available 
actions makes multiple actions in rules a useful feature.

Tip: After you select a type, the bottom of the dialog box displays the 
type's package and JRE type.

Note: Campaigns that invoke static or instance methods cannot be 
viewed or edited in the WLP Administration Console. Use Oracle 
Enterprise Pack for Eclipse to view or edit these types of Campaigns.
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The Java class must be application-scoped. See "Configuring Standard Project 
Dependencies" in the Oracle Enterprise Pack for Eclipse online help for instructions on 
creating an application-scoped Java or utility project.

Perform the following steps to invoke a static method in your Campaign:

1. In the Portal Perspective, select the Campaign you created in Section 8.2, "Building 
a Campaign."

2. From the Design Palette tab, drag the Invoke a static method rule action onto the 
appropriate scenario in the Campaign Editor. 

3. Select the Properties tab and enter a name for the action.

4. In the action, click the all link to toggle back and forth between any and all to 
determine which conditions will trigger the action. The any choice means that 
only one of the conditions must be true for the action to occur. See Figure 8–7.

Figure 8–7 Click the All Link to Determine What Will Cause the Action to Occur

5. Click the [event] link to choose an available event that will trigger the action. 
Events can include logging in, clicking a graphic, clicking a button, adding an item 
to a shopping cart, navigating to another page in a portal, and so on. Some events 
are predefined or you can define your own custom events; see Section 9.8, 
"Creating Custom Events." After you select the event, click Add and then click 
OK.

6. Click the [java type] link. To see a list of all available Java types, enter **. Use these 
guidelines to view the Java types: 

■ Enter * for any string and ? for any character. See Figure 8–8.
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Figure 8–8 Enter ** to See all Available Java Types

7. You can also enter TZ, for example, for types containing T and Z as uppercase 
letters in camel case notation. An example of this is java.util.TimeZone. You could 
enter NuPoEx for types containing Nu, Po, and Ex as parts in camel case notation 
(for example, java.lang.NullPointerException). The Matching types field displays 
matches for the expression you type in the Select a type field. 

After you select the Java type, click OK.

8. Click the [method name] link and type the name of the method. For example, 
getAlias or getUserName. Do not use special characters; the method name can 
contain only letters, numbers, and underscores. 

9. Click the [no arguments] link to choose an argument to the method call. Click 
Add, and choose one of the following: String, Boolean, Integer, Long, Double, 
Float, Null Argument, Property Reference, or Variable Reference. Enter the new 
value and click OK. After you enter all the arguments, click Finish.

10. In the Available Conditions section in the Design Palette tab, select the conditions 
you want to trigger the action. When you select a condition, a corresponding link 
appears in the action area. Click the link to define the condition. 

11. Save the Campaign file by choosing File > Save.

8.2.4.3 Invoking an Instance Method
The Invoke an instance method action calls a method from any available type that is 
bound to a variable. This variable may come from a condition, or it can be one that you 
define yourself in the action. This action also has the ability to use bound variables 
from the Conditions section of the rule set as an argument in the instance method, in 
addition to property references, standard java types (String, Boolean, and so on), and 
other types available in the project.

Tip: After you select a type, the bottom of the dialog box displays the 
type's package and JRE type.

Note: Campaigns that invoke static or instance methods cannot be 
viewed or edited in the WLP Administration Console. Use Oracle 
Enterprise Pack for Eclipse to view or edit these types of Campaigns.
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The Java class must be application-scoped. See "Configuring Standard Project 
Dependencies" in the Oracle Enterprise Pack for Eclipse online help for instructions on 
creating an application-scoped Java or utility project.

Perform the following steps to invoke an instance method in your Campaign:

1. In the Portal Perspective, select the Campaign you created in Section 8.2, "Building 
a Campaign."

2. From the Design Palette tab, drag the Invoke a static method rule action onto the 
appropriate scenario in the Campaign Editor. 

3. Select the Properties tab and enter a name for the action.

4. In the action, click the all link to toggle back and forth between any and all to 
determine which conditions will trigger the action. The any choice means that 
only one of the conditions must be true for the action to occur.

5. Click the [event] link to choose an available event that will trigger the action. 
Events can include logging in, clicking a graphic, clicking a button, adding an item 
to a shopping cart, navigating to another page in a portal, and so on. Some events 
are predefined or you can define your own custom events; see Section 9.8, 
"Creating Custom Events." After you select the event, click Add and then click 
OK.

6. Click the [variable name] link and enter a variable name. Click the ellipses button 
next to Type, select a matching type, and click OK. Click OK on the Enter Variable 
dialog box.

7. Click the [java type] link. To see a list of all available Java types, enter **. Use these 
guidelines to view the Java types: 

■ Enter * for any string and ? for any character.

■ You can also enter TZ, for example, for types containing T and Z as uppercase 
letters in camel case notation. An example of this is java.util.TimeZone. You 
could enter NuPoEx for types containing Nu, Po, and Ex as parts in camel case 
notation (for example, java.lang.NullPointerException). The Matching types 
field displays matches for the expression you type in the Select a type field. 

After you select the Java type, click OK.

8. Click the [method name] link and type the name of the method. For example, 
getAlias or getUserName. Do not use special characters; the method name can 
contain only letters, numbers, and underscores.

9. Click the [no arguments] link to choose an argument to the method call. Click 
Add, and choose one of the following: String, Boolean, Integer, Long, Double, 
Float, Null Argument, Property Reference, or Variable Reference. Enter the new 
value and click OK. After you enter all the arguments, click Finish.

10. In the Available Conditions section in the Design Palette tab, select the conditions 
you want to trigger the action. When you select a condition, a corresponding link 
appears in the action area. Click the link to define the condition. 

11. Save the Campaign file by choosing File > Save.

Tip: After you select a type, the bottom of the dialog box displays the 
type's package and JRE type.



Building a Campaign

8-16 Oracle Fusion Middleware Interaction Management Guide for Oracle WebLogic Portal

8.2.4.4 Placing Content in a Placeholder
The Place content in a placeholder action retrieves web content from a content 
repository and displays the selected piece of content in a predefined Placeholder on a 
JSP.

Perform the following steps to add content to a placeholder in your Campaign:

1. In the Portal Perspective, select the Campaign you created in Section 8.2, "Building 
a Campaign."

2. From the Design Palette tab, drag the Place content in a placeholder rule action 
onto the appropriate scenario in the Campaign Editor. 

3. Select the Properties tab and enter a name for the action. 

4. In the action, click the all link to toggle back and forth between any and all to 
determine which conditions will trigger the action. See Figure 8–9.

Figure 8–9 Click the All Link to Determine What Will Cause the Action to Occur

5. Click the [eventl] link to choose an available event that will trigger the action. 
Events can include logging in, clicking a graphic, clicking a button, adding an item 
to a shopping cart, navigating to another page in a portal, and so on. Some events 
are predefined or you can define your own custom events; see Section 9.8, 
"Creating Custom Events." After you select the event, click Add and then click 
OK.

6. To define the query, click the empty content search link. You can define the query 
in Advanced mode using WebLogic Portal's expression syntax (on the Advanced 
tab) or in Graphical mode (on the Query tab).

■ Advanced mode – In the Content Search window, select the Advanced tab and 
build a query using the instructions in Section 6.2.1.1, "Building a Content 
Query with Expressions."

■ Graphical mode – Use the following steps to build a content query by 
selecting content properties, comparators, and values to retrieve content items. 

a. In the Content Search window, select the Query tab.

b. Click the drop-down list to select a property set and then select a property and 
click Add. (The properties you select are content properties (types) rather than 
property set properties such as User Profile or session properties.)

c. In the Content Search Values window that appears, select one of the following 
tabs: 

– Values – To define the query based on a comparison to a value you enter. 
For example, the query could be set to retrieve content with an 
investorRiskLevel property that is marked as high. 
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– Properties – To define the content query based on the property value that 
is dynamically fed in from another type of property, such as a User Profile 
property. For example, instead of creating a query based on static content 
properties, you can create a query that reads in the value of the current 
user's investorRiskLevel to populate the query. The query would be 
different for each user. 

d. Click Add. The query descriptor is added in the Content Search window, as 
shown in Figure 8–10.

Figure 8–10 Base the Content Query on a Comparison to a Value You Enter

7. You can add more value phrases to the query, then set the appropriate option in 
the For multiple descriptors section. 

8. Click OK in the Content Search window. 

9. Click the [placeholder name] link in the action, and select the Placeholders that 
will display content when the scenario is triggered. 

10. Click Add to move the Placeholders to the Selected Placeholders section, enter text 
to describe the Placeholder in the Description field, and click OK.

11. You can preview the content that will be retrieved by the query in the Content 
Preview window below the Editor. If you defined the query to use values from a 
User Profile property, the retrieved content will be different for each user, so you 
must enter the user name of an existing user in the Preview User field to see 
which content will be retrieved for that user.
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You must add the adWeight property to a content type as a single-value Integer. 
Content with a higher adWeight number has a higher likelihood of being selected 
to display in a Placeholder. 

12. If you want the content to stop being displayed prior to the end of the Campaign, 
click the campaign ends link to determine when the content will stop being 
displayed. 

13. To increase the chances that content from the query will be displayed, click the Do 
not remove any other content link and determine the existing content that will be 
removed from the designated Placeholders when the action runs. 

14. To set the priority that the query will be run compared to other queries that may 
exist in the Placeholders, click the Normal link and select a priority. Higher 
priorities give the query a greater chance of being run.

15. In the Available Conditions section, select the conditions you want to trigger the 
action. When you select a condition, a corresponding link appears in the action 
area. Click the link to define the condition.

16. Save the Campaign by choosing File > Save.

8.2.4.5 Sending an E-Mail in a Campaign
The Send an email rule action sends a predefined e-mail to a user in your Campaign. 
You might use an e-mail to alert users to specials that are customized to a specific User 
Segment.

Perform the following steps to add an E-Mail Action to your Campaign:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, select the 
Campaign you created in Section 8.2, "Building a Campaign."

2. From the Design Palette tab, drag the Send an email rule action onto the 
appropriate scenario in the Campaign Editor. 

3. In the Properties tab, enter a name for the action.

4. In the action, click the all link to toggle back and forth between any and all to 
determine which conditions will trigger the action. The any choice means that 
only one of the conditions must be true for the action to occur.

5. Click the [server url] link to select the e-mail message to send. Choose URL, enter 
a Subject, and an optional default e-mail address. Click Preview if you want to 
view the e-mail now. 

6. Click OK. 

7. In the Available Conditions section in the Design Palette tab, select the conditions 
you want to trigger the action. When you select a condition, a corresponding link 
appears in the action area. Click the link to define the condition. 

8. Save the Campaign file by choosing File > Save.

Note: The Content Preview window shows content that the query 
will retrieve. However, since a Placeholder can show only one piece of 
content at a time, the single piece of content that is displayed varies 
depending on which query is run (determined by the priority you set 
for a query and the settings for Campaign queries) and the adWeight 
property setting on content.
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8.2.5 Setting Up Automatic E-Mail Messages
Perform the following steps to send automatic e-mails as part of a Campaign:

1. Define an e-mail address property by create a property in a User Profile property 
set to store the user e-mail address. For example, the default 
CustomerProperties.usr property set contains an Email property that can contain 
a single, unrestricted string value for an e-mail address.

2. Set up the Campaign Service. You must tell the Campaign service where to get the 
e-mail address when sending automatic e-mails to users. 

a. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

b. In the Resource Tree, expand the Interaction Management folder and select 
Campaign Service.

c. Click Configuration Settings for: Campaign Service. Figure 8–11 shows you 
where to enter the property set name and the name of the e-mail property you 
set up in the previous step.

Figure 8–11 You Can Set Up Where to Get E-Mail Addresses for Automatic E-Mails

■ Goal Check Time – The default is 300,000 milliseconds (five minutes). If you 
set the Goal Check Time to 0, there is no time delay in the amount of time the 
Campaign service checks to see if goals have been met. See Section 8.2.2.1, 
"Setting Goal Definitions" for more information.

■ Base Directory for Email Browsing – The default directory for storing e-mail 
files is campaigns/emails. You must also change the <url-pattern> path 
in the web.xml file to secure the files in the new directory and redeploy the 

Note: If you are using e-mails in your Campaign, you can choose to 
send the e-mails in batch mode or real-time (batch mode is the 
default). In batch mode, when you run or test your Campaign, e-mails 
are not sent. See Section 8.2.5.1, "Setting Up Bulk E-Mail Messages" to 
learn how to change the mailing behavior to real-time.
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application after you make these changes. See Section 8.2.5.5.1, "Storing E-Mail 
Files in a Different Directory."

■ Maximum URI Length – The maximum length of a deployable Campaign 
Uniform Resource Identifier (URI).

■ Default From Email Address – The default address that receives any replies 
from email that the Campaign sends. In a standard mail header, this is the 
From address. Each Campaign scenario can specify its own From address that 
overrides this default property.

■ Email Address Property Name – The name of the property that contains 
customer email addresses.

■ Property Set Name Containing Email Address Property – The name of the 
property set that contains customer email properties.

■ Email Opt In Property Name – The name of the property that specifies 
whether customers want to receive Campaign-related email. You should 
define a User Profile property with the single, restricted values of true and 
false. 

■ Property Set Name Containing Opt In Property – The name of the property 
set that contains the customer's opt-in property. Emails will not be sent to 
users who have their property value set to false.

3. Click Update.

4. Set SMTP for outgoing mail by configuring the Simple Mail Transfer Protocol 
(SMTP) hostname for the Mail Service. Perform the following steps:

a. In the Resource Tree, select Interaction Management and then Mail Service.

b. Click Configuration Settings for Mail Service and use the SMTP Host Name 
field to enter the hostname for your e-mail server's outgoing mail.

c. If you use a Sybase database, select the Enable ORDER BY Workaround for 
Clobs check box. This setting enables the Mail Service to work with Sybase 
since Sybase does not support using a TEXT data type in an ORDER BY 
clause.

5. Create e-mail messages using a predefined e-mail message. E-mail messages can 
be in any of the following formats: TXT, HTML, JSP, or XML (with style sheets). 
Store the e-mails in the <PortalWebProject>/campaigns/emails directory. 
If you want to use a different directory for storing e-mail files, see Section 8.2.5.5.1, 
"Storing E-Mail Files in a Different Directory." If you want to send bulk e-mails, see 
Section 8.2.5.1, "Setting Up Bulk E-Mail Messages."

6. Set e-mail security. Prevent unauthorized access to e-mail messages by following 
the steps in Section 8.2.5.5, "Setting Up E-Mail Security."

8.2.5.1 Setting Up Bulk E-Mail Messages
You must use a command to periodically send the batch e-mails that the JSPs store in 
the WebLogic Portal data repository. You can also use the cron command or any other 
scheduler that your operating system supports to issue the send-mail command. 

For Windows, the send-mail command is located in a .bat file wrapper script. For 
UNIX, the send-mail command is located in a .sh file. The following sections refer 
to the .bat file. UNIX users should substitute .sh for .bat.

The send-mail wrapper script specifies the name and listen port of the WebLogic 
Portal host that processes the send-mail request. By default, the wrapper script 
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specifies localhost:7501 for the hostname and listen port. However, 
localhost:7501 is valid only when you run the script while logged in to a 
WebLogic Portal host in a single-node environment (and only if you did not modify 
the default listen port). If you use the send-mail script from any other configuration, 
you must modify the script.

8.2.5.1.1 Modifying the Send-Mail Script to Work from a Remote Host  Perform the following 
steps to run the send-mail script from a remote host (a computer that is not a 
WebLogic Portal host):

1. Open the following file in a text editor:

<WLPORTAL_HOME>\info-mgmt\bin\mailmanager.bat (Windows)

or

<WLPORTAL_HOME>/info-mgmt/bin/mailmanager.sh (UNIX)

2. In the mailmanager script, locate the SET HOST= line. Replace localhost with the 
name of a WebLogic Portal host.

3. If the host uses a listen port other than 7501, replace 7501 in the SET PORT= line 
with the correct listen port.

4. Save the mailmanager script.

8.2.5.1.2 Modifying the Send-Mail Script to Work in a Clustered Environment  If you work in a 
clustered environment, you must modify the send-mail wrapper script to specify the 
name of a host in the cluster. The default localhost value is not valid for the Mail 
Service in a clustered environment.

Perform the following steps on each host to use the send-mail script in a clustered 
environment:

1. Open the following file in a text editor:

<WLPORTAL_HOME>\info-mgmt\bin\mailmanager.bat (Windows)

<WLPORTAL_HOME>/info-mgmt/bin/mailmanager.sh (UNIX)

2. In the mailmanager script, replace localhost in the SET HOST= line with the 
name of a WebLogic Portal host. Because each host in a cluster can access the data 
repository that stores the e-mail messages, you can specify the name of any host in 
the cluster.

3. If the host uses a listen port other than 7501, replace 7501 in the SET PORT= line 
with the correct listen port.

4. Save the mailmanager script.

8.2.5.1.3 Using the Mailmanager Commands  The mailmanager command is a wrapper 
script that uses the jav.com.bea.p13n.mail. MailManager class. The 
mailmanager commands help you send and manage bulk e-mails.

Use the following command syntax:

mailmanager.bat [ appName ] [ list | send | send-delete | delete ] 
batch-name ] (mailmanager.sh on UNIX)

Note: The following steps must be performed on each host that will 
run the script.
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If you specify only the appName arguments, the mailmanager command prints to 
standard output the names all e-mail batches in the application and the number of 
e-mails in each batch.

Table 8–3 contains a list of the command arguments.

Table 8–4 contains examples of mailmanager commands.

8.2.5.2 Sending Bulk E-Mail Messages
Perform the following steps to send bulk e-mail from a shell that is logged into a 
WebLogic Portal host:

1. Start the WebLogic Server by choosing Run As > Run on Server.

2. To determine the names and contents of the e-mail batches in the data repository, 
enter the following command:

mailmanager.bat appName list (Windows)

The appName is the name of the enterprise application that generated the e-mail 
batch. The command prints to standard output. You can use shell commands to 
direct the output to files.

3. To send a batch and remove it from the data repository, enter the following 
command:

Table 8–3 Mailmanager Command Arguments

Command Argument Description

appName The name of the enterprise application that generated the e-mail 
batch.

list Prints to standard output the names of all e-mail batches in the data 
repository and the number of e-mails in each batch.

list batch-name Prints to standard output the subject and recipients of all e-mails in 
the batch that you specify.

send batch-name Sends all e-mails in the batch that you specify.

send-delete batch-name Sends all e-mails in the batch that you specify and then deletes the 
batch from the data repository.

delete batch-name Deletes e-mails in the batch that you specify.

batch-name The name of a batch that mailmanager list returns. This 
argument does not support wildcards.

Table 8–4 Examples of Mailmanager Commands

Command Example Description

mailmanager.bat list Lists all available batches

mailmanager.bat wlcsApp list 
/campaigns/campaign1.cam

Lists the contents of a batch named 
/campaigns/campaign1.cam that the 
wlcsApp application generated

mailmanager.bat wlcsApp 
send-delete 
/campaigns/campaign1.cam

Sends the campaign1.cam batch and deletes it 
afterwards

mailmanager.bat wlcsApp delete 
/campaigns/campaign1.cam

Deletes the campaign1.cam batch
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mailmanager.bat appName send-delete batch-name

8.2.5.3 Scheduling Bulk E-mail Delivery
You can use a scheduling utility to send the e-mail batches in the data repository. 
Because you must specify the name of a batch when you use the mailmanager 
command to send mail, you must schedule sending mail for each Campaign scenario 
separately. The name of a batch corresponds to the scenario's containerId. The 
containerId specifies the ID of the Campaign to which the scenario belongs.

For information in using a scheduling utility, refer to your operating system's 
documentation.

8.2.5.4 Deleting E-Mail Batches
You can delete e-mail batches as you send them (See Section 8.2.5.2, "Sending Bulk 
E-Mail Messages").

You can also perform the following steps to delete e-mail batches:

1. To determine the names and contents of the e-mail batches in the data repository, 
enter the following command:

mailmanager.bat appName list

The appName is the name of the enterprise application that generated the e-mail 
batch. The command prints to standard output. You can use shell commands to 
direct the output to files.

2. To delete a batch, enter the following command:

mailmanager.bat appName delete batch-name

8.2.5.5 Setting Up E-Mail Security
When a Campaign sends an automatic e-mail, it uses a predefined e-mail message 
stored on the file system within your portal web project. By default, WebLogic Portal 
prevents unauthorized access to those e-mail files when the files are stored in the 
<PortalWebProject>/campaigns/ emails directory. 

The following deployment descriptors secure your e-mail files:

■ The <PortalApplication>/wps.jar/META-INF/weblogic-ejb-jar.xml descriptor 
file – The following line in this file provides the name of a user who is in the 
global PortalSystemAdministrator role:

<run-as-principal-name> username </run-as-principal-name>

Membership in the global PortalSystemAdministrator security role is defined in the 
WebLogic Portal Administration Console at the server level. In a portal domain 
created with the Configuration Wizard, the Administrators and 
PortalSystemAdministrators groups that are provided by default are configured to 
be members of the global PortalSystemAdministrator role. 

Note: If you are using e-mails in your Campaign, you can choose to 
send the e-mails in batch mode or real-time (batch mode is the 
default). In batch mode, when you run or test your Campaign, no 
e-mails will be sent. See Section 8.2.5.1, "Setting Up Bulk E-Mail 
Messages" to learn how to send batch mode emails and how to change 
the mailing behavior to real-time.
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■ The <PortalWebProject>/WEB-INF/web.xml file – The following line in this file 
secures the e-mail files in <PortalWebProject>/campaigns/emails, 
allowing only the Campaign service (through the PortalSystemAdministrator user 
defined in the previous section) to access and send the e-mails:

<url-pattern>/campaigns/emails/*</url-pattern>

Perform the following steps to use a different user for e-mail security:

1. Back up the wps.jar file.

2. Un-jar the wps.jar file and change the name of the user in the 
weblogic-ejb-jar.xml file.

3. Verify that the user exists.

4. Verify that the user is a member of the global PortalSystemAdministrator security 
role; and 

5. Re-jar and replace the old wps.jar and redeploy the application. If you enter the 
name of a user in <run-as-principal-name> that does not exist, or if you 
delete the user specified by <run-as-principal-name> without changing the 
<run-as-principal-name> entry, you will receive deployment errors on the 
wps.jar file.

8.2.5.5.1 Storing E-Mail Files in a Different Directory  Perform the following steps if you 
need to use a different directory to store e-mail files:

1. Change the <url-pattern> path in the web.xml file to secure the files in the 
new directory.

2. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

3. In the Resource Tree, expand the Interaction Management folder and select 
Campaign Service.

4. Click Configuration Settings for Campaign Service and change the directory in 
the Base Directory for Email Browsing field. For example, 
campaigns/emails/q1, as shown in Figure 8–12.
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Figure 8–12 Change the E-mail Directory

5. Redeploy the application or restart the server during development in Oracle 
Enterprise Pack for Eclipse.

8.2.6 Targeting a Campaign to Tracked Anonymous Users
You can set Campaigns up to work with tracked anonymous users. A Campaign will 
not work with completely anonymous users.

Perform the following steps to target a Campaign to tracked anonymous users:

1. Create a Campaign file and add goals, scenarios, and actions to it. Follow the 
instructions in Section 8.2.2, "Creating a Campaign File."

2. Locate the web.xml file in the /WEB-INF directory of your portal web project.

3. Double-click the web.xml file so you can edit it in Oracle Enterprise Pack for 
Eclipse.

4. To override the settings from the shared library, add the following lines from 
Example 8–1 to the web.xml file. Adding this PortalServletFilter 
component turns on anonymous user tracking in your Campaign. 

Example 8–1 Add this Section to the Web.xml File

<filter>
     <filter-name>PortalServletFilter</filter-name>
     <filter-class>com.bea.p13n.servlets.PortalServletFilter

Note: Using a wildcard character (*) in the URL pattern does not 
provide recursive directory protection. The wildcard protects only the 
files in the last directory listed. For example, if you want to store 
e-mail files in the /campaigns/emails/q1 directory, the url-pattern 
information in the /campaigns/emails/* directory does not protect 
the e-mail files in the /q1 directory. To protect those e-mail files, the 
url-pattern information must be in the /campaigns/emails/q1/* 
directory.
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          </filter-class>
     <init-param>
          <description>Option to track anonymous users, defaults to false
               if not set. 'createAnonymousProfile' is ignored if this is
               true</description>
          <param-name>enableTrackedAnonymous</param-name>
          <param-value>true</param-value>
     </init-param>
     <init-param>
          <description>Length in seconds visitor must be on site before we
          start tracking them. Defaults to 60 seconds if not set
               </description>
          <param-name>trackedAnonymousVisitDuration</param-name>
          <param-value>60</param-value>
     </init-param>
</filter>

5. Change the trackedAnonymousVisitDuration parameter value to the 
number of seconds before tracking begins. During testing, set the 
trackedAnonymousVisitDuration in Example 8–1 to a small number (for 
example, 5) so that your sessions quickly switch to tracked sessions.

6. Create an event trigger for the Campaign. For the registered user, a login event 
triggers the Campaign. For a tracked anonymous user, you must add code to 
generate the event on behalf of the tracked anonymous user. The example below 
shows a ClickContentEvent that triggers a Campaign.

try
{
     profile = SessionHelper.getProfile(session);
     if (profile != null && !profile.getType().equals
          (ProfileType.REGISTERED))
     {
          TrackingEventHelper.getEventService().dispatchEvent(new
               ClickContentEvent(session, httpReq, null, null));
     }
}
catch (Exception ex)
{
     //handle any exceptions dipatching the event
}

7. Save the changes to the web.xml file.

8. You can see more detail on the PortalServletFilter setting in Oracle 
Enterprise Pack for Eclipse by right-clicking the web.xml file, choosing Compare 
With > J2EE Library Version, and double-clicking p13n-web-lib in the Compare 
editor. The editor shows the p13n-web-lib version in one of the panes.

8.3 Testing a Campaign
Use the following guidelines to test Campaigns on your development server in your 
development environment: 

1. Verify that the Campaign is complete. The entire Campaign, each scenario, and 
each action have specific conditions for being complete. When you select each, the 
Is Complete property in the Property Editor window displays a read-only value of 
true or false. If the Is Complete property is false for any part of a Campaign, 
select the property in the Property Editor window and read the Description to find 
out which properties are required.
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2. Verify that the Campaign is active. With the Campaign selected (not a scenario or 
action), set the Active property in the Property Editor window to true.

3. If you see the text Campaign is currently stopped just below the Campaign Editor 
window, you must change the Start Date or Stop Date properties so that the 
current date falls between the two. When the current date is within the Campaign 
date range, the Campaign is currently stopped text disappears.

4. If your Campaign uses Goal Setting to end a Campaign based on content 
impressions or clickthroughs, perform the following steps to modify the settings:

a. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

b. In the Resource Tree, expand the Interaction Management folder and select 
Campaign Service.

c. Click the Configuration Settings for Campaign Service link and set the Goal 
Check Time to 0. This creates no time delay in the amount of time the 
Campaign service checks to see if goals have been met. Click Update.

d. In the Resource Tree, select Ad Service and click the Configuration Settings 
for: Ad Service link

e. Set the Display Flush Size field to 1, as shown in Figure 8–13.

Figure 8–13 Change the Display Flush Size to 1

This setting writes each impression or clickthrough to the database each time 
it occurs and ends the Campaign on the exact number of impression or 
clickthrough counts you have established. For example, if you want to end a 
Campaign on five impressions, but your Display Flush Size was set to 10, 
you would need to see 10 impressions before the that number is written to the 
database. At that point, the Campaign service would detect that the five 
impressions had already been met, effectively ending the Campaign after 10 
impressions rather than five.

You must restart the server for this change to take effect.

5. You can reset many aspects of Campaigns during testing, such as impression and 
clickthrough counts that can end a Campaign and scenarios that run only once for 

Note: Do not deploy your application into a production environment 
with these settings. Performance will be adversely affected.
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each user. With a Campaign file open in Oracle Enterprise Pack for Eclipse, choose 
Portal > Reset Campaign and reset any aspect of the Campaign.

6. Test run once Content Actions by performing the following steps to test Content 
Actions that you want to run only once per user:

a. With the Campaign open in Oracle Enterprise Pack for Eclipse, right-click in 
the Campaign Editor.

b. Choose Reset Campaign.

c. In the Reset Campaign dialog box, select the Reset all options check box, and 
click OK.

d. View the portal and run the Content Action by starting an event for which the 
Campaign service is listening (such as logging in). Verify that the Campaign 
content is displayed.

e. Log out or click Back in the browser to return to where you can launch the 
event again.

f. Return to the Campaign in Oracle Enterprise Pack for Eclipse and select the 
Campaign.

g. Right-click the Campaign Editor space and choose Reset Campaign, as shown 
in Figure 8–14.

Figure 8–14 Right-Click in the Campaign Editor to Reset the Campaign

7. Select the Remove previously placed content from rotation check box and click 
OK. See Figure 8–15.
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Figure 8–15 Reset a Campaign

8. To troubleshoot Campaign content in Placeholders, you should understand how 
Placeholders handle default and Campaign queries. For example, default and 
Campaign queries have priorities that help determine which query runs. Also, you 
can set default queries so that they do not run when Campaign queries are 
present. For more information, see Chapter 7.

9. Improve performance by disabling, enabling, and flushing content caches that are 
used for web content. With a Campaign open in Oracle Enterprise Pack for 
Eclipse, the Edit > Portal Content Caches menu provides those options: 

■ Flush Content Caches

■ Disable Content Caches

■ Enable Content Caches

For more information on managing your caches, use the Run > Portal Cache 
Manager menu and consult the Oracle Fusion Middleware Portal Development Guide 
for Oracle WebLogic Portal for instructions.

The following caches are affected (you can view the caches in the Administration 
Console by choosing Configuration & Monitoring > Service Administration and 
selecting Personalization and then Cache Manager in the Resource Tree).

■ The adBucketServiceCache – Reserved for future use.

■ The searchCache – Caches the results of content searches for the virtual 
content repository.

■ The documentMetadataCache – Caches the results of document searches for 
the DocumentManager. This setting is not used by the content repositories.

■ The binaryCache.WLP Repository – Caches binary property values for the 
WLP Repository.

■ The documentContentCache – Caches the document bytes for the 
DocumentManager. This setting is not used by the content repositories.

■ The nodeCache.WLP Repository – Caches content for the WLP Repository.

■ The documentIdCache – Caches the results of document searches (ids only) 
for the DocumentManager. This setting is not used by the content 
repositories.

■ The adServiceCache – Used by the ad service to cache the results of searches 
for content rendering.
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8.4 Triggering a Campaign
You must use a Regular or Behavior Tracking event to begin your campaign or trigger 
a campaign action based on events and their values. A commonly used event is 
SessionLoginEvent; see Section 9.3.1, "Using the SessionLoginEvent" for 
instructions.

Campaign scenario rules are evaluated only when a single event occurs for which the 
Campaign service is listening.

If your Campaign conditions use request, session, or event properties, those properties 
are captured when a listened-for event is triggered. The event takes a snapshot of the 
current session properties, the single request property (contained in the session), and 
the event properties (contained in the request). The snapshot taken by the event is in 
the form of a request object, which the event passes to the Campaign service for 
evaluation. If the values in that snapshot evaluate to true against any Campaign action 
rules, those Campaign actions are triggered.

This section contains the following topic:

■ Section 8.4.1, "Troubleshooting Campaign Actions"

8.4.1 Troubleshooting Campaign Actions
When Campaign Actions are not triggered as expected using Session, Request, and 
Event properties, one of the following items might be the problem:

■ The Campaign service was listening for events, but no event occurred

■ The session, request, or event properties contained in the Campaign rule were not 
part of the request object snapshot taken when the event occurred

■ In Campaign rules that are defined so that all conditions must apply for the 
Campaign action to be triggered, one or more of the conditions evaluated to 
false

8.5 Turning Off a Campaign
You can remove the CampaignEventListener in order to turn off all Campaigns so 
that they do not fire Campaign events. 

Tip: For optimal performance, enable these caches in your 
production environment. See Section 8.6.2.1, "Setting Campaign 
Content Caches" for instructions.

Note: By default, the only events that cannot be used to trigger 
Campaigns are DisplayContentEvent, DisplayProductEvent, 
BuyEvent, SessionBeginEvent, and SessionEndEvent, as listed in the 
<PortalApplication>/wps.jar/com/bea/campaign/internal/ 
listeners.properties file.)

Tip: If you trigger a Campaign to test e-mails, the e-mails are not 
sent real-time if the batch flag default is still set to true. See 
Section 8.2.5.1, "Setting Up Bulk E-Mail Messages" for instructions on 
changing the mailing behavior to real-time.
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Perform the following steps to turn off Campaign events:

1. Start the Administration Console and choose Configuration & Monitoring > 
Service Administration.

2. In the Resource Tree, expand the Personalization folder and select Event Service.

3. In the Browse tab, select the 
com.bea.campaign.internal.CampaignEventListener check box and 
click Delete. Campaign events will not longer be fired, but if you set up other 
Behavior Tracking or other event listeners, those events will continue to fire.

8.6 Resetting a Campaign
You can reset different parts of your Campaigns. For example, you may want to do one 
or all of the following:

■ Clear content from a Placeholder that had been previously put in the Placeholder. 
Doing this ensures that the users who were supposed to see personalized content 
only once see it only one time.

■ Clear from the database the number of times an image has been viewed or clicked 
so that your Campaign does not reach its goals.

■ Give users a second chance on run once Campaign Actions that they have already 
triggered.

■ Clear any e-mail messages waiting to be sent.

You can reset Campaigns in the development environment (for testing) or in the 
production environment.

This section contains the following topics:

■ Section 8.6.1, "Resetting a Campaign in the Development Environment"

■ Section 8.6.2, "Resetting a Campaign in the Production Environment"

8.6.1 Resetting a Campaign in the Development Environment
Perform the following steps to automatically reset a Campaign in your development 
environment after you make changes to it:

1. Open a Campaign file in the Portal Perspective in Oracle Enterprise Pack for 
Eclipse.

2. Choose Window > Preferences.

3. In the Preferences window, select WebLogic Portal.

4. Click Campaigns and select the Reset campaign after saving changes check box, 
as shown in Figure 8–16.

Tip: The following steps in the Administration Console work for a 
portal that is deployed as an exploded EAR file. If your portal is a 
compressed EAR file, you will need to do these steps manually and 
then re-build and deploy the EAR file.

Note: If you want to turn on the Campaign later, add the 
CampaignEventListener as a Synchronous Listener in the Browse tab.
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Figure 8–16 You Can Automatically Reset a Campaign After You Edit It

5. Click OK.

For more information on using this feature for testing, see Section 8.3, "Testing a 
Campaign."

8.6.2 Resetting a Campaign in the Production Environment
Perform the following steps to reset a Campaign in your production environment:

1. In Oracle Enterprise Pack for Eclipse, start the Administration Console by 
choosing Run > Open Administration Console.

2. In the Administration Console, select Interaction > Campaigns.

3. In the Resource Tree, select the Campaign that you want to reset.

4. In the Campaign Details tab, click Reset Campaign. 

5. Click OK.

8.6.2.1 Setting Campaign Content Caches
For optimal performance, enable content caches in your production environment. 
From Oracle Enterprise Pack for Eclipse, you can disable, enable, and flush caches that 
are used for web content. 

Perform the following steps to enable content caches:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, open a Campaign.

2. Choose Edit > Portal Content Caches > Flush Content Caches to clear each of the 
caches. Select Edit > Portal Content Caches > Disable Content Caches to stop 
caching for all caches. Select Edit > Portal Content Caches > Enable Content 
Caches to get the best performance for your Campaign. See Section 8.3, "Testing a 
Campaign" for a list of content caches.

3. You can view the affected caches in the WebLogic Portal Administration Console 
by choosing Configuration & Monitoring > Service Administration.

4. In the Resource Tree, expand the Cache Manager folder. 
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5. Click a specific cache name to view its settings. You can click Flush to clear this 
cache item.

6. Click Configuration Settings for <cache name> and select the Enabled or 
Disabled check box, as shown in Figure 8–17.

Figure 8–17 You Can Enable or Disable a Cache Setting

7. Click Update.

See Section 15.3, "Managing a Campaign for Optimal Performance" for information on 
changing Campaigns to improve performance.

Tip: You can adjust your Campaign and caches to run faster in a 
production environment.
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9Setting Up Events and Behavior Tracking

An Event is generated when a user interacts with a web interface. Events can include 
logging in, clicking or viewing a graphic, clicking a button, navigating to another page 
in a portal, and so on. 

WebLogic Portal provides an events framework that lets you leverage events in many 
ways: to trigger Campaigns, persist event data in the database, and provide other 
types of functionality when events occur.

The following examples show functionality you can provide with the event 
framework:

■ Capture the number of times users access a portal page.

■ Determine how many users have registered in a portal. You could also create a 
Campaign Action that automatically sends each user a welcome e-mail when the 
registration event occurs.

■ Identify which pieces of content are viewed or clicked.

■ Determine which category of user logs in to your HR Intranet most often. 
Categories of users could include managers and regular employees. You could 
also create a Campaign Action that displays a specific graphic when managers log 
in and displays another graphic when regular employees log in.

This chapter describes the components of the event framework, helps you plan an 
event strategy by explaining the purpose and use of each piece of the framework, 
describes WebLogic Portal's predefined events, and provides guidance and 
instructions on using events in your applications.

This chapter includes the following sections:

■ Section 9.1, "Choosing How to Handle Events"

■ Section 9.2, "Completing Your Behavior Tracking Strategy"

■ Section 9.3, "Using Predefined Events"

■ Section 9.4, "Generating Events for Content Clicks"

■ Section 9.5, "Generating Content Events"

■ Section 9.6, "Providing Event Attribute Values"

Note: Interaction Management events are different than portlet 
events, which provide a framework for interportlet communication. 
See the Oracle Fusion Middleware Portlet Development Guide for Oracle 
WebLogic Portal.
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■ Section 9.7, "Enabling Behavior Tracking"

■ Section 9.8, "Creating Custom Events"

■ Section 9.9, "Creating Custom Event Listeners"

■ Section 9.10, "Dispatching Events"

■ Section 9.11, "Using Events in Campaigns"

■ Section 9.12, "Debugging the Event Service"

■ Section 9.13, "Tracking Content Changes"

■ Section 9.14, "Disabling Behavior Tracking"

9.1 Choosing How to Handle Events
Each Event is an instance of an Event object that is identified with a unique name, or 
type. Each Event type can get and set specific attributes, depending on its function. In 
each of the previous examples, the event must capture specific information. For 
example, to capture the number of times users access a portal page, a ClickPage event 
might get and set the name of the page that was clicked. To identify which pieces of 
content are viewed, a DisplayContent event might get and set the ID and type of each 
displayed content item.

After events set their attribute values, you can persist those values in any desired way. 
WebLogic Portal provides a default mechanism for persisting event attributes in a 
database as XML. When event data is stored in the database, you can mine that data to 
perform analytics, run reports, or even feed event data back into your applications. For 
example, you can create a portlet that runs SQL queries against the database and 
returns the number of times each portal page was visited. You can also develop your 
own persistence functionality. For example, you can store event data in a file, or you 
can write the data to database tables without structuring the data in XML.

Sometimes, events do not require attributes or persistence. Their only purpose could 
be to trigger some other type of functionality. For example, if you want to determine 
how many times a download link is clicked regardless of who clicked it, a 
ClickDownloadLink event (and an accompanying event listener) can increment a 
database field value by 1.

You can also make Campaigns more powerful by using events in your Campaign 
definitions. For example, you can send a user a predefined e-mail automatically when 
the user generates the UserRegistration event by registering in a portal; or display a 
personalized piece of content when an event with specific attribute values is 
generated.

Figure 9–1 shows the event framework, which gives you the flexibility to handle 
events in many ways. Table 9–1 describes the pieces of the framework.
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Figure 9–1 The Event Framework
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Table 9–1 The Event Framework

Number from 
Figure 9–1 Description

1 An event is an object that extends either the Event or TrackingEvent class. The event 
identifies itself to the Event service with a unique name, or type, declares the attributes it will 
use, and passes the event type and the attributes to the base class constructor.

Events can contain whatever type of attributes you want to capture. For example, you can 
capture the name of a page or a portlet that is selected for viewing; you can capture the name 
of a JSP in a Page Flow to gauge which JSPs are being visited most often. You can trigger a 
Campaign when a specific JSP is viewed; you can capture information about content retrieved 
from the virtual content repository, or you can capture product information when a user adds 
an item to a shopping cart.

Note: Page flows are a feature of Apache Beehive, which is an optional framework that you 
can integrate with WLP. See "Apache Beehive and Apache Struts Supported Configurations" in 
the Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

Behavior Tracking events also declare the XML namespace and schema filename that the Event 
Service uses to store event attribute values in the database as XML. For each custom Behavior 
Tracking event you create, you should also create an XML schema.

2 Wherever you want to generate the event in your application (whether from a JSP, a Java class, 
or a Page Flow), create an instance of the event. In your code, set the attribute values the event 
needs, and pass them to the event as arguments in the order the event expects them. The 
argument order is defined in the event class. Tell the Event Service to dispatch the event. 
Dispatching an event tells all the interested event listeners that the event has occurred, causing 
them to perform their actions.

Note: Page flows are a feature of Apache Beehive, which is an optional framework that you 
can integrate with WLP. See "Apache Beehive and Apache Struts Supported Configurations" in 
the Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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9.2 Completing Your Behavior Tracking Strategy
WebLogic Portal's event framework provides many options for generating and 
handling events, as described in the previous section. See the guidelines in Section 2.4, 
"Planning Your Behavior Tracking Strategy" to determine the pieces of the event 
framework you need to implement.

This section contains the following topic:

3 The Behavior Tracking listener listens for all events that extend the TrackingEvent class and 
are registered with the Behavior Tracking service.

The Behavior Tracking listener's function is to move the XML document of event attributes, 
created by the event and the XML schema, to a buffer. The Behavior Tracking Service then 
moves the XML document to the BT_EVENT table in the database in an interval you determine.

You can retrieve Behavior Tracking data from the database for reporting or analytical purposes, 
such as determining the amount of traffic a page or portlet receives.

By default, the Behavior Tracking listener is not registered with the Event service. You must 
register the Behavior Tracking listener to enable Behavior Tracking, as described in Section 9.7, 
"Enabling Behavior Tracking."

4 The Campaign event listener listens for and handles all events, except excluded events listed in 
the wps.jar file's listeners.properties file. When an event occurs, the Campaign event 
listener calls the Campaign service. The Campaign service takes a snapshot of the current 
HTTP request, and evaluates the data in the request against any Campaigns you have created 
to see if any Campaign actions need to be executed.

Campaigns are completely dependent on events. If no events occur, the Campaign service is 
never called, and no Campaign actions are executed.

In addition to the basic function of calling the Campaign service with an event, you can also 
use events within Campaign definitions by executing Campaign actions if a specific event 
occurs or if an event has specific properties. For example, you can define a Campaign in the 
following ways:

■ If MyEvent occurs, show a specific piece of content.

■ If MyEvent has a published property with a value greater than 2004, show a specific 
piece of content.

In order to use events and event properties in Campaign definitions, you must create an event 
property set for each event you want to use in Campaigns (stored in your application's 
/data/src/events directory in Oracle Enterprise Pack for Eclipse). An event property set 
contains the exact names of the attributes you are setting in your event. The Campaign Editor 
interface uses the event property set in drop-down fields that you use to create the Campaign 
definition.

For information on Campaigns, see Chapter 8.

5 Create a custom event listener only if you want to perform custom functionality when an event 
occurs. A custom listener tells the Event service which events to monitor (which events trigger 
it to perform its custom functionality). For example, with a custom event listener, you can 
implement your own persistence mechanism to store event attributes, or you can respond to an 
event in real time by modifying a User Profile or displaying related products when a user 
clicks a product image.

The base class you implement, EventListener, provides two methods: getTypes(), which 
lets the listener advertise which event types it is interested in, and handleEvent(), which 
lets you perform your custom functionality. 

A listener can listen for more than one event, whether the event is a custom event or any of 
WebLogic Portal's predefined events.

In performing custom event handling, you have access to the event properties with the event's 
getAttribute() method.

Table 9–1 (Cont.) The Event Framework

Number from 
Figure 9–1 Description
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■ Section 9.2.1, "Planning the Deployment of Custom Events, Listeners, and 
Property Sets"

9.2.1 Planning the Deployment of Custom Events, Listeners, and Property Sets
Creating custom events, listeners, and event property sets involves adding files to 
your application and updating your application CLASSPATH. If you are adding events 
and property sets to an application that is already deployed, these changes require 
application redeployment for the events and CLASSPATH updates, and running the 
Propagation Utility to update the event properties in the database. For deployment 
instructions, see the Oracle Fusion Middleware Production Operations Guide for Oracle 
WebLogic Portal.

9.3 Using Predefined Events
WebLogic Portal provides predefined Behavior Tracking events. The events capture 
different attributes and use the Behavior Tracking listener and the Behavior Tracking 
Service to persist the attributes as XML in the BT_EVENT table when they are 
generated, or dispatched. You must enable Behavior Tracking to persist the event 
attributes (as described in Section 9.7, "Enabling Behavior Tracking"). You can also use 
these events to trigger Campaigns.

If you want to perform custom event handling when any of the predefined events is 
dispatched, create a custom event listener, as described in Section 9.9, "Creating 
Custom Event Listeners."

This section contains the following topics:

■ Section 9.3.1, "Using the SessionLoginEvent"

■ Section 9.3.2, "Using the SessionBeginEvent and SessionEndEvent"

■ Section 9.3.3, "Using the UserRegistrationEvent"

■ Section 9.3.4, "Using the AddToCartEvent"

■ Section 9.3.5, "Using the RemoveFromCartEvent"

■ Section 9.3.6, "Using the PurchaseCartEvent"

■ Section 9.3.7, "Using the Rule Events"

■ Section 9.3.8, "Using the DisplayCampaignEvent"

■ Section 9.3.9, "Using the CampaignUserActivityEvent"

■ Section 9.3.10, "Using the ClickCampaignEvent"

■ Section 9.3.11, "Using the ClickProductEvent"

■ Section 9.3.12, "Using the ClickContentEvent"

■ Section 9.4.1, "Using the ClickThroughEventFilter"

■ Section 9.5.1, "Using the ContentConfigEvent"

■ Section 9.5.2, "Using the ContentCreateEvent"

■ Section 9.5.3, "Using the ContentDeleteEvent"

■ Section 9.5.4, "Using the ContentUpdateEvent"



Using Predefined Events

Setting Up Events and Behavior Tracking 9-7

9.3.1 Using the SessionLoginEvent
Use the SessionLoginEvent to dispatch an event when a user logs into a portal and 
is authenticated.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.3.2 Using the SessionBeginEvent and SessionEndEvent
The SessionBeginEvent and the SessionEndEvent are generated automatically. 
A SessionBeginEvent is generated when a user accesses a web site running on 
WebLogic Portal. A SessionEndEvent is generated when the session ends, such as 
when the user closes the browser or the session times out.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the events are generated and the event is registered with 
the Behavior Tracking service as a persisted event, as shown in Figure 9–3.

The SessionBeginEvent and the SessionEndEvent do not have corresponding 
property sets in a portal application. By default, the Campaign listener does not listen 
for these events, so they cannot be used to trigger Campaigns. For more information 
on starting a Campaign, see Section 8.4, "Triggering a Campaign."

9.3.3 Using the UserRegistrationEvent
Use the UserRegistrationEvent to dispatch an event when a user registers in a 
portal (when the user is added to the user store programmatically with a registration 
portlet, for example).

If Behavior Tracking is enabled, the event property values (in particular the user ID) 
are written to the BT_EVENT table in the database when the event is generated and the 
event is registered with the Behavior Tracking service as a persisted event, as shown in 
Figure 9–3.

9.3.4 Using the AddToCartEvent
Use AddToCartEvent to dispatch an event when a user adds an item to a shopping 
cart. This event lets you capture information such as currency type, quantity of the 
item being added, unit list price, and SKU. These properties must be represented 
somehow in your shopping cart and content type to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

9.3.5 Using the RemoveFromCartEvent
The RemoveFromCartEvent generates an event when a user removes an item from a 
shopping cart. This event lets you capture information such as currency type, quantity 
of the item being added, unit list price, and SKU. These properties must be represented 
somehow in your shopping cart and content type to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.
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9.3.6 Using the PurchaseCartEvent
The PurchaseCartEvent dispatches an event when a user makes a purchase. This 
event lets you capture information such as currency type, order number, and total 
purchase price. These properties must be represented somehow in your shopping cart 
to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.3.7 Using the Rule Events
WebLogic Portal provides a Rule Event control that lets you generate a Behavior 
Tracking event whenever you fire a rule in a page flow using the Rules Executor 
control. The Rule Event control gets all necessary properties, including the names of 
the rule set and the rule that was fired.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

The Rule Event does not have a corresponding property set in a portal application. 
Rules are often used instead of Campaigns, because they provide more flexibility and 
power; so creating a rule event property set to trigger a Campaign when a rule is fired 
is not a likely scenario. However, if you want to create a rule property set to trigger a 
Campaign when a rule is fired, create an event property set called RuleEvent.evt and 
add the following single, unrestricted string properties: ruleset-name and rule-name. 
For instructions on creating property sets, see Chapter 4.

For more information on using rules, see Chapter 10.

9.3.8 Using the DisplayCampaignEvent
If Behavior Tracking is enabled, a DisplayCampaignEvent is automatically 
generated when a Campaign places a content item in a Placeholder. The event 
property values are written to the BT_EVENT table in the database when the event is 
generated and the event is registered with the Behavior Tracking service as a persisted 
event, as shown in Figure 9–3.

9.3.8.1 Using the Display Content Event Control
Using the Display Content Event control with a 
<BehaviorTracking:displayContentEvent/> JSP tag let you generate a 
Behavior Tracking event when you display a piece of content in a JSP.

See Table 9–1 for details on how get the document-id and document-type properties.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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A Display Content Event does not have a corresponding property set in a portal 
application. By default, the Campaign service does not listen for these events, so they 
cannot be used to trigger Campaigns. For more information, see Section 8.4, 
"Triggering a Campaign."

9.3.8.2 Using the Display Product Events JSP Tag
The <productTracking:displayProductEvent> JSP tag lets you generate a 
Behavior Tracking event when you display a product from your catalog.

See Table 9–1 for details on how get the application-name, category-id, document-id, 
document-type, and SKU properties.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

A Display Product Event does not have a corresponding property set in a portal 
application. By default, the Campaign service does not listen for these events, so they 
cannot be used to trigger Campaigns. For more information, see Section 8.4, 
"Triggering a Campaign."

9.3.9 Using the CampaignUserActivityEvent
The CampaignUserActivityEvent dispatches an event when a generic Campaign 
event occurs. This event creates a new DisplayCampaignEvent and associates users 
with specific Campaign and Scenario instances. These properties must be represented 
to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.3.10 Using the ClickCampaignEvent
Using the ClickCampaignEvent with the ClickThroughEventFilter generates 
an event when a user clicks a content item displayed by a Campaign.

Perform the following steps to enable content clicking:

1. Include the appropriate entries in your portal web project's web.xml and 
weblogic.xml files, as described in Section 9.4, "Generating Events for Content 
Clicks."

2. Configure your content items with specific properties, as described in Chapter 3.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

9.3.11 Using the ClickProductEvent
Use the ClickProductEvent with the ClickThroughEventFilter to generate an 
event when a user clicks a product content item. 

The ClickProductEvent lets you capture information such as product category and 
SKU. Both of those properties must be represented somehow in your content type to 
use this event.
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To enable content clicking, include the appropriate entries in your portal web project's 
web.xml and weblogic.xml files, as described in Section 9.4, "Generating Events for 
Content Clicks."

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

9.3.12 Using the ClickContentEvent
Use the ClickContentEvent with the ClickThroughEventFilter to generate an 
event when a user clicks any content item that was retrieved from the virtual content 
repository, but not as the result of a Campaign.

To enable event generation on content clicking, include the appropriate entries in your 
portal web project's web.xml and weblogic.xml files, as described in Section 9.4, 
"Generating Events for Content Clicks."

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking service as a persisted event, as shown in Figure 9–3.

9.4 Generating Events for Content Clicks
WebLogic Portal provides predefined events that can be generated when a user clicks a 
content item in a portal. In particular, the 
<BehaviorTracking:clickContentEvent> and the 
<productTracking:clickProductEvent> JSP tags enable content click events. 
The ClickCampaignEvent also generates content click events. To enable content to 
be clicked so that an event is dispatched to the Event service, use the 
ClickThroughEventFilter, add the EventService to the web.xml file and the 
weblogic.xml file, and enable Campaign clickthroughs.

This section contains the following topics:

■ Section 9.4.1, "Using the ClickThroughEventFilter"

9.4.1 Using the ClickThroughEventFilter
Use the ClickThroughEventFilter whenever you use /ShowBinary pattern in a 
URL. ShowBinary (which is mapped to the ShowPropertyServlet) displays 
binary web content, such as graphics. Use /ShowBinary in the content URL in your 
JSPs. After you map the ClickThroughEventFilter to the /ShowBinary URL 
pattern, use /ShowBinary in your JSP as part of the URL with a click event JSP tag. 
Then, when a user clicks the content, a click content event is generated by the 
ClickThroughEventFilter.

To enable this capability, add the following filter and filter mapping to your portal web 
project's web.xml file:

<filter>
    <filter-name>ClickThroughEventFilter</filter-name>
    <filter-class>
    com.bea.p13n.tracking.clickthrough.ClickThroughEventFilter
    </filter-class>
</filter>
<filter-mapping>
    <filter-name>ClickThroughEventFilter</filter-name>
    <url-pattern>/ShowBinary/*</url-pattern>



Generating Content Events

Setting Up Events and Behavior Tracking 9-11

</filter-mapping>

9.4.1.1 JSP Example
Assuming you have added the filter mapping to your web.xml file, the following JSP 
code displays a content item from the virtual content repository (that has already been 
retrieved from an iterator, not shown) and provides the mechanism for click content 
event generation:

<!-- The JSP tag gets the documentId of a content item, which provides
     the ClickThroughEventFilter with the parameters it needs to
     generate an event. The id attribute stores the data retrieved
     by the tag. This JSP tag alone does not generate the event. -->
<BehaviorTracking:clickContentEvent documentId="<%= node.getName() %>" 
id="eventInfo" />
<!-- A URL variable uses /ShowBinary to provide the clickable link,
     which is mapped to the ClickThroughEventFilter. The eventInfo variable
     provides the ClickThroughEventFilter with the required event parameters
    when a user clicks the link. -->
<% String url = request.getContextPath() + "/ShowBinary"+node.getPath() + "?" + 
eventInfo;%>
<!-- Now if the user clicks the link, a ClickContentEvent is generated by
     the ClickThroughEventFilter. The ShowBinary servlet displays the
     content from the virtual content repository in its binary form
     (such as a graphic). -->
<a href="<%= url %>"><img src="<%=request.getContextPath() + "/ShowBinary" + 
node.getPath()%>" ></a>

9.4.1.2 Enabling Campaign Clickthroughs
To enable Campaign clickthroughs that trigger the predefined ClickCampaign 
Event, you must configure your content items with specific properties, as described in 
Chapter 3.

9.5 Generating Content Events
Other predefined events track changes made to the virtual content repository or to the 
repository configuration. The events capture different attributes and use the Behavior 
Tracking listener and the Behavior Tracking Service to persist the attributes as XML in 
the BT_EVENT table when they are generated, or dispatched. You must enable 
Behavior Tracking to persist the event attributes (as described in Section 9.7, "Enabling 
Behavior Tracking").

The following events track repository changes: CampaignUserActivityEvent, 
ContentConfigEvent, ContentCreateEvent, ContentDeleteEvent, and 
ContentUpdateEvent. 

If you want to perform custom event handling when any of the predefined events is 
dispatched, create a custom event listener, as described in Section 9.9, "Creating 
Custom Event Listeners."

9.5.1 Using the ContentConfigEvent
The ContentConfigEvent dispatches a new event when a user makes a 
configuration change to the virtual content repository. This event lets you capture 
information, such as the action that was performed on the repository. The properties 
must be represented to use this event.
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If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.5.2 Using the ContentCreateEvent
The ContentCreateEvent dispatches an event when a user adds content to the 
virtual content repository. This event lets you capture information, such as the content 
type, the path where the new content was created, the content's status, and so on. The 
properties must be represented to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.5.3 Using the ContentDeleteEvent
The ContentDeleteEvent dispatches an event when a user removes content from 
the virtual content repository. This event lets you capture information, such as the 
content type, the path where the content existed before it was removed, the content's 
status, and so on. The properties must be represented to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.5.4 Using the ContentUpdateEvent
The ContentDeleteEvent dispatches an event when a user changes content from 
the virtual content repository. This event lets you capture information, such as the 
content type, the path where the content existed before it was updated, the content's 
status, and so on. The properties must be represented to use this event.

If Behavior Tracking is enabled, the event property values are written to the BT_EVENT 
table in the database when the event is generated and the event is registered with the 
Behavior Tracking Service as a persisted event, as shown in Figure 9–3.

9.6 Providing Event Attribute Values
WebLogic Portal's predefined events set many of their attribute values automatically. 
However, there are attributes that you must set manually in your code. Table 9–2 
describes the attributes needed by the predefined events and shows you the methods 
you can use to set the attributes in your code. You can also use these methods to set 
attributes in your custom events.

You can get some attributes from other generated events. For example, whenever a 
Campaign displays a piece of content, a DisplayCampaignEvent is generated. The 
DisplayCampaignEvent sets an attribute called placeholder-id. (It also sets other 
attributes.) If you want to set the placeholder-id for a custom event, you can get the 
attribute from the DisplayCampaignEvent using the getAttribute() method on 
that event. For example: DisplayCampaignEvent.getAttribute( 
"aPlaceholderId" );
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9.7 Enabling Behavior Tracking
The default Derby database in a WebLogic Portal domain (and the SQL scripts used to 
build a portal database for other database types) include Behavior Tracking tables that 
are ready to use for storing Behavior Tracking data. However, you must manually 

Table 9–2 Getting Attributes for Predefined Events

Event Attribute How to Get the Attribute

application-name The name of the enterprise application. All predefined events that use this attribute set it 
automatically. To set this attribute manually in a custom event, use the following 
method: com.bea.p13n.events.Event.getApplication().

campaign-id The unique ID of a Campaign. All predefined events that use this attribute set it 
automatically. To set this attribute manually in a custom event, use the following 
method: com.bea.campaign.CampaignInfo.getUniqueId().

category-id The category that an item in the catalog belongs to. You must set this attribute manually. 

currency Gets the type of currency on an item. 

document-id The unique virtual content repository ID of the retrieved content item. You could also 
get the unique document name. The Campaign events set this attribute automatically. 
You must set it manually for all other events. Content events that have corresponding 
JSP tags provide a tag attribute. After you have retrieved a content item from the virtual 
content repository with a Content Selector, a Campaign, a Placeholder, or by any other 
means, use one of the following to get the document-id:

com.bea.content.Node.getId() or getName()

or

Use the <cm:getProperty> JSP tag to get the cm_uid or cm_nodeName property.

document-type Type is the name of the virtual content repository type, not the MIME type. The 
Campaign events set this attribute automatically. You must set it manually for all other 
events. Content events that have corresponding JSP tags provide a tag attribute. After 
you have retrieved a content item from the virtual content repository with a Content 
Selector, a Campaign, a Placeholder, or by any other means, use 
com.bea.content.Node.getType() to retrieve the content's type.

order-id The unique ID of a customer's order.

placeholder-id The unique ID of the content Placeholder displaying the content. The predefined events 
that use this attribute set it automatically.

quantity The number of a specific items in a shopping cart. 

scenario-id The unique ID of a Campaign scenario that contains the action that was executed. The 
predefined events that use this attribute set it automatically. To set it manually in a 
custom event, use the following method: com.bea.campaign.action. 
Action.getScenarioId().

session-id The unique ID of the current session. This is retrieved automatically by the predefined 
events, which extend the TrackingEvent class, which uses 
javax.servlet.http.HttpSession.getId() and assigns the return value to the 
session-id property.

sku The sku number of the catalog item. 

total-price The total price of an order in a shopping cart. 

unit-price

unit-list-price

The unit price of an item in a shopping cart. 

user-id The ID of the authenticated user. This is retrieved automatically by the predefined 
events, which extend the TrackingEvent class, and the return value is assigned to the 
user-id property. You can also use the following method to get the user-id from the 
request: com.bea.p13n.usermgmt.SessionHelper. getUserId(request).
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activate Behavior Tracking to use Behavior Tracking events. You can use the 
Administration Console or Oracle Enterprise Pack for Eclipse to enable Behavior 
Tracking. The tool you choose to enable Behavior Tracking depends on how you want 
to deploy your application. 

Choose one of the following two ways to enable Behavior Tracking:

■ Administration Console – To make changes to your application at run-time, 
register the Behavior Tracking Listener in the Administration Console. This 
configuration information is written to the plan.xml deployment file. See 
Section 9.7.1, "Enabling Behavior Tracking in the Administration Console" for 
instructions.

■ Oracle Enterprise Pack for Eclipse – To deploy your application to a new domain, 
enable Behavior Tracking by updating the p13n-config.xml file for your 
application in Oracle Enterprise Pack for Eclipse and placing it in your 
<EAR>/META-INF directory. (Oracle Enterprise Pack for Eclipse does not create a 
plan.xml deployment file.) This configuration information is merged and saved 
with other configuration files from other library modules when you deploy your 
EAR file. See Section 9.7.6, "Enabling Behavior Tracking in Oracle Enterprise Pack 
for Eclipse" for instructions.

This section contains the following topics:

■ Section 9.7.1, "Enabling Behavior Tracking in the Administration Console"

■ Section 9.7.2, "Configuring Behavior Tracking"

■ Section 9.7.3, "Adjusting Behavior Tracking for Optimal Performance"

■ Section 9.7.4, "Storing Behavior Tracking Data in Other Ways"

■ Section 9.7.5, "Creating a Separate Database for Behavior Tracking Events"

■ Section 9.7.6, "Enabling Behavior Tracking in Oracle Enterprise Pack for Eclipse"

9.7.1 Enabling Behavior Tracking in the Administration Console
Use the Administration Console to update the plan.xml deployment file for your 
application at run-time. See the Oracle Fusion Middleware Production Operations Guide for 
Oracle WebLogic Portal for more information on deployment plans.

If you are using a database other than Derby, see the Oracle Fusion Middleware Database 
Administration Guide for Oracle WebLogic Portal for instructions on creating a separate 
database for Behavior Tracking events.

Perform the following steps to activate Behavior Tracking by registering the 
BehaviorTrackingListener class with the Event service:

1. Start the Administration Console and log in as a system administrator.

2. Choose Configuration & Monitoring > Service Administration.

3. In the Resource Tree, expand the Personalization folder and select Event Service.

4. In the Synchronous Listeners section, click Add Synchronous Listener.

5. Enter the following class in the Class Name field:

com.bea.p13n.tracking.listeners.BehaviorTrackingListener

Note: Synchronous listeners receive events immediately. 
Asynchronous listeners use a thread scheduler to receive events.
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6. Click Update. The class appears in the Class Name list, and the plan.xml file is 
updated. Behavior Tracking is activated, as shown in Figure 9–2. You do not need 
to restart the server or redeploy your application.

Figure 9–2 The New Class Appears in the Class Name Field

9.7.2 Configuring Behavior Tracking
By default, Behavior Tracking data is not written to the database immediately when a 
Behavior Tracking event occurs. The events are stored in a buffer. You can determine 
how often Behavior Tracking data is moved to the database from the buffer. 

Perform the following steps to determine how often Behavior Tracking data is moved 
to the database:

1. Start the Administration Console and log in as a system administrator.

2. Choose Configuration & Monitoring > Service Administration.

3. In the Resource Tree, expand the Personalization folder and select Behavior 
Tracking Service.

4. Click Configuration Settings for: Behavior Tracking Service. Figure 9–3 shows 
the Configuration Setting dialog box.

5. Modify the settings, as described in Table 9–1. Leave the default values for Data 
Source JNDI Name (the p13n.trackingDataSource) and Custom Persistence 
Classname (null). These fields provide the default behavior for moving event data 
from the buffer to the BT_EVENT table in the database. For alternative persistence, 
see Section 9.7.4, "Storing Behavior Tracking Data in Other Ways." For information 
on the Persisted Event Types field, see Section 9.8.1.2, "Creating a Behavior 
Tracking Event Class."
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Figure 9–3 Configuring Behavior Tracking

6. Click Update.

7. Restart the server for your changes to take effect.

Use Table 9–3 when you set your Behavior Tracking settings.

This section contains the following topics:

■ Section 9.7.3, "Adjusting Behavior Tracking for Optimal Performance"

■ Section 9.7.4, "Storing Behavior Tracking Data in Other Ways"

■ Section 9.7.5, "Creating a Separate Database for Behavior Tracking Events"

■ Section 9.7.6, "Enabling Behavior Tracking in Oracle Enterprise Pack for Eclipse"

9.7.3 Adjusting Behavior Tracking for Optimal Performance
In your development or testing environment, start with a set of baseline values for 
Maximum Buffer Size, Buffer Sweep Interval, and Buffer Sweep Maximum. Try 
different values while testing peak site usage with your web application until you find 

Table 9–3 Behavior Tracking Settings

Setting Description

Maximum Buffer Size Determines the maximum number of events stored in the buffer 
before the event data is written to the database. The default value is 
100 events.

All events are stored in the buffer, but only the events listed in the 
Persisted Event Types field are written to the database. All others 
are flushed from the buffer.

Buffer Sweep Interval Determines how often the events buffer is checked to determine 
whether the events in the buffer should be persisted to the 
database. Two conditions trigger events to be moved from the 
buffer to the database: 1) The maximum buffer size has been 
reached, or 2) The maximum time allowed in the buffer (Buffer 
Sweep Maximum) has been exceeded. The default value is 10 
seconds.

Buffer Sweep Maximum 
Time

Sets the maximum time in seconds before the events in the buffer 
are written to the database (and the non-persisted event types are 
flushed from the buffer). The default value is 120 seconds.
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the ideal balance between the number of database operations and the amount of data 
being stored.

9.7.4 Storing Behavior Tracking Data in Other Ways
Behavior Tracking event data, by default, is stored in the database in the BT_EVENT 
table. If you want to persist your event data in a different place or in a different way, 
such as to a different database table or to a file, create a custom event listener that 
provides the alternative persistence logic. For information on creating custom 
listeners, see Section 9.9, "Creating Custom Event Listeners."

9.7.5 Creating a Separate Database for Behavior Tracking Events
If you are using Behavior Tracking, you can improve performance by storing Behavior 
Tracking data in a separate database. The Oracle Fusion Middleware Database 
Administration Guide for Oracle WebLogic Portal contains instructions for creating a 
separate Behavior Tracking database for each type of database.

9.7.6 Enabling Behavior Tracking in Oracle Enterprise Pack for Eclipse
If you plan to deploy your application to a new domain, you should enable Behavior 
Tracking in Oracle Enterprise Pack for Eclipse. This Behavior Tracking configuration 
information is merged with other configuration files from other library modules. You 
can place the updated p13n-config.xml file in source control to use when you 
deploy other applications. See the Oracle Fusion Middleware Production Operations Guide 
for Oracle WebLogic Portal for more information on deployment.

For example, you can add event types for the listener to the configuration file, as 
shown in Example 9–1. This technique accomplishes the same result as adding the 
event types through the Administration Console, as explained in Section 9.13, 
"Tracking Content Changes." See also Section 9.5, "Generating Content Events" for 
information on the content event types. 

Example 9–1 Adding Event Types to a P13N Configuration File

...
<behavior-tracking>
    <persisted-event-type>ClickContentEvent</persisted-event-type>
    <persisted-event-type>DisplayContentEvent</persisted-event-type>
    <data-source-jndi-name>p13n.trackingDataSource</data-source-jndi-name>
</behavior-tracking>
...

Perform the following steps to enable Behavior Tracking when deploying your 
application to a new domain:

1. Start Oracle Enterprise Pack for Eclipse and create a p13n-config.xml file in 
your <EAR>/META-INF directory or copy an existing file to your project.

2. Enter your configuration details and save the file. Saving the p13n-config.xml 
file combines this information with your other library module configuration files. 
This appended configuration file can be used when you deploy other applications.

If you want to redeploy to the same application, right-click the server in the 
Servers tab and choose Publish.

Tip: If you do not use Behavior Tracking, you should disable Event 
services. See Section 9.14, "Disabling Behavior Tracking."
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3. Copy the p13n-config.xm.xml file into your source control system. 

9.8 Creating Custom Events
If WebLogic Portal's predefined events do not capture the specific combinations of 
attributes you need, you can create your own custom events. You can create two types 
of custom events: Behavior Tracking events and regular events.

For guidance on custom events and what type to create, see Section 2.4.2, 
"Understanding When to Create a Custom Event" and Section 2.4.1, "Understanding 
When to Use a Predefined Event." Creating a custom event involves creating the Event 
class and creating the XML Schema.

This section contains the following topics:

■ Section 9.8.1, "Creating the Event Class"

■ Section 9.8.2, "Creating an XML Schema for Behavior Tracking"

9.8.1 Creating the Event Class
WebLogic Portal provides the two base event objects that work with the Event Service: 
com.bea.p13n.events.Event and 
com.bea.p13n.tracking.events.TrackingEvent. These base classes provide 
the necessary methods required by the Event Service. You can use either of these 
classes as the superclass when creating your event class as described in Step 2.

When you create an event class you extend one of the base classes, declare the event 
attributes you want, and pass the event data (such as the event type) to the base class 
constructor.

This section provides instructions on creating custom regular events and custom 
Behavior Tracking events.

9.8.1.1 Creating a Regular Event Class
Create a custom regular event when none of WebLogic Portal's predefined events 
capture the event attributes you want, and you do not want to use the Behavior 
Tracking service for persisting event data as XML in the BT_EVENT table. You can 
trigger Campaigns with custom regular events and perform your own event handling 
if you create a custom event listener.

The steps involve creating am EJB or utility project, which is generally used to develop 
general-purpose Java code that is not directly part of special entities.

The steps in this chapter refer to the \src folder in the Package Explorer View. Your 
src directory might be named differently.

Perform the following steps to create a custom event class:

1. Create an EJB or utility project in Oracle Enterprise Pack for Eclipse by performing 
the following steps:

a. In the Portal Perspective, choose File > New > Project.

b. In the New Project - Select a Wizard window, expand the EJB folder and select 
WebLogic EJB Project or expand the J2EE folder and select Utility Project. 
Click Next.

Tip: If you use Oracle Enterprise Pack for Eclipse to remove an 
application from a domain, the deployment plan is also removed.
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c. Enter a name for the EJB or utility project and ensure that the Use default 
check box is selected. Select the Add project to an EAR check box and click 
Next, as shown in Figure 9–4.

Figure 9–4 Enter a Project Name

d. Select the facets (including Portal Application Services) that you want to 
enable and click Finish.

Your new EJB or utility project is automatically associated with your EAR 
project. For more information on EJB projects, see the Oracle Fusion Middleware 
Portal Development Guide for Oracle WebLogic Portal.

2. Make a new Java class by performing the following steps:

a. Select your web project in Package Explorer View and choose File >New > 
Other. 

b. In the New - Select a Wizard dialog, expand the Java folder, select Class, and 
click Next.

c. In the New Java Class - Java Class dialog, enter a Name for the new class and 
for the Superclass. Select the Constructors from superclass check box and the 
Inherited abstract methods check box and click Finish. See Figure 9–5.
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Figure 9–5 Enter the Class Name and Superclass

The new class appears in the \src directory of your portal web project.

3. Perform the following steps to declare event attribute names and create the event 
object for the new Java class:

a. Declare the event attribute names as keys that are passed back to the Event 
constructor. For example:

public static final String FOO_ATTRIBUTE = "fooAttribute";
public static final String SESSION_ID = "session-id";
public static final String USER_ID = "user-id";

b. Create the event object. For example:

public MyEvent(
    String fooAttributeValue, 
    String user_id,
    HttpServletRequest request,
    HttpSession session

c. Add a constructor, such as the one below, and pass the event type back to it:

super( TYPE );

d. Declare the event attributes with the following code:

setAttribute( FOO_ATTRIBUTE, fooAttributeValue );
setAttribute( SESSION_ID, session_id );
if( user_id != null )

Note: If you use events to trigger Campaigns, you must have a string 
called user-id that contains the User's Profile name. You must also 
have a request attribute of type com.bea.p13n.http.Request. The 
request attribute, however can be added at runtime with the following 
code: event.setAttribute("request", new Request(request, true));
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    setAttribute( USER_ID, user_id );
else
    setAttribute( USER_ID, "unknown" );

where fooAttributeValue is the variable that stores the value you retrieved in 
your code (not shown here).

4. The Java files in the \src folder will be compiled the normal way and deployed as 
part of the application. You can dispatch the event from a JSP, Java code, or a Page 
Flow, as described in Section 9.10, "Dispatching Events." If you want to use the 
event in Campaign definitions, create an event property set for the event, as 
described in Section 9.11.1, "Registering Events for Campaigns." If you want to 
perform custom functionality when the event is generated, create a custom event 
listener that listens for the event, as described in Section 9.9, "Creating Custom 
Event Listeners."

9.8.1.2 Creating a Behavior Tracking Event Class
Create a custom Behavior Tracking event if none of WebLogic Portal's predefined 
events captures the event attributes you want, and you need to use WebLogic Portal's 
Behavior Tracking framework to persist event data as XML in the BT_EVENT table. 

You can use these events in Campaigns and create a custom listener that performs 
special handling on the event, but unless you want to use the Behavior Tracking 
framework to store event data as XML, you do not need to create a custom Behavior 
Tracking event. If you do not want to use the Behavior Tracking service, create a 
custom regular event as described on Section 9.8.1.1, "Creating a Regular Event Class."

Your Behavior Tracking event works with its own XML schema to store the event data 
as XML in the BT_EVENT database table. Information about that schema must be 
included in your event class, as described in the following steps. 

The steps involve creating a utility project, which is generally used to develop 
general-purpose Java code that is not directly part of special entities, such as web 
services, controls, or EJBs.

The steps in this chapter refer to the src folder in the Package Explorer View. Your 
src directory might be named differently.

Perform the following steps to create a Behavior Tracking event class:

1. Create an EJB project in Oracle Enterprise Pack for Eclipse by performing the 
following steps:

a. In the Portal Perspective, choose File > New > Project.

b. In the New Project - Select a Wizard window, expand the EJB folder and select 
WebLogic EJB Project. Click Next.

c. In the New WebLogic EJB Project dialog, enter a name for the EJB project and 
ensure that the Use default check box is selected. Select the Add project to an 
EAR check box and click Next.

d. In the New Java Utility Module - Select Project Facets dialog, select the facets 
that you want to enable and click Finish.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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Your new EJB project is automatically associated with your EAR project. For more 
information on EJB projects, see the Oracle Fusion Middleware Portal Development 
Guide for Oracle WebLogic Portal. 

2. Make a new Java class by performing the following steps:

a. Select your web project in Package Explorer View and choose File >New > 
Other. 

b. In the New - Select a Wizard dialog, expand the Java folder, select Class, and 
click Next.

c. In the New Java Class - Java Class dialog, enter a Name for the new class and 
for the Superclass. Select the Constructors from superclass check box and the 
Inherited abstract methods check box and click Finish. See Figure 9–6.

Figure 9–6 Enter the Class Name and Superclass

The new class appears in the \src directory of your portal web project.

3. Perform the following steps to declare event attribute names and create the event 
object for the new Java class:

a. Declare the XML_NAMESPACE key. This is the namespace URL used by your 
Behavior Tracking event's XML schema to uniquely identify it. For example:

private static final String XML_NAMESPACE = 
"http://www.yourdomain.com/myschemas/tracking/mytrackingschema";

b. Declare the name of the XML schema file. For example:

private static final String XSD_FILE = "mytrackingschema.xsd";

c. Declare the event attribute names as keys that are passed to the 
TrackingEvent constructor. For example:

public static final String SESSION_ID = "session-id";
public static final String USER_ID = "user-id";
public static final String PAGE_LABEL = "pageLabel";
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d. Declare the XML schema keys as an array. The schema keys are strings that are 
passed to the base TrackingEvent constructor. These keys are used to get 
the Behavior Tracking data that is put into the database. List the keys as an 
array of string objects.

private static final String localSchemaKeys[] =
{
    SESSION_ID, USER_ID, PAGE_LABEL
};

The localSchemaKeys order is important, because it corresponds to the 
order in which the XML schema needs the event properties for the XML 
output. An XML file will be invalid if elements are out of order.

The SESSION_ID and the USER_ID are data elements in the 
localSchemaKeys array that are useful in implementing a tracking event. 
The SESSION_ID, which must not be null, is the WebLogic Server session ID 
that is created for every session object. The USER_ID is the user name of the 
user who triggered the event.

e. Create the event object. For example:

public MyEvent(
    String fooAttributeValue, 
    String user_id,
    HttpServletRequest request,
    HttpSession session

f. Call the TrackingEvent constructor and pass the required arguments back 
to it in the required order. For example:

{
super( 
    TYPE,
    session,
    XML_NAMESPACE,
    XSD_FILE,
    localSchemaKeys,
    request );

g. Declare the event attributes. For example:

setAttribute( PAGE_LABEL,  pageLabelValue );
setAttribute( SESSION_ID,  session_id );
if( user_id != null )
    setAttribute( USER_ID, user_id );
else
    setAttribute( USER_ID, "unknown" );
}

The pageLabelValue is the variable storing the value you retrieved in your 
code (not shown here).

Note: If you use events to trigger Campaigns, you must have a string 
called user_id that contains the User's Profile name. You must also 
have a request attribute of type com.bea.p13n.http.Request. The 
request attribute, however can be added at runtime with the following 
code: event.setAttribute("request", new Request(request, true));
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4. Register the Behavior Tracking event with the Behavior Tracking service in the 
WebLogic Portal Administration Console. This event tells the Behavior Tracking 
listener to handle this type of event.

a. Start the Administration Console.

b. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

c. In the Resource Tree, expand the Personalization folder and select Behavior 
Tracking Service.

d. In the Configure tab click Configure Settings for: Behavior Tracking Service.

e. Enter the name of your Behavior Tracking class in the Custom Persistence 
Classname field (such as behtrackingclass).

f. Click Update.

5. Create an XML schema that determines the structure of the XML document 
generated by the Behavior Tracking event. See Section 9.8.2, "Creating an XML 
Schema for Behavior Tracking." If you want to use the event in Campaign 
definitions, create an event property set for the event, as described in 
Section 9.11.1, "Registering Events for Campaigns." If you want to perform custom 
functionality when the event is generated, create a custom event listener that 
listens for the event, as described in Section 9.9, "Creating Custom Event 
Listeners."

6. The Java files in the \src folder will be compiled the normal way and deployed as 
part of the application. You can dispatch the event from a JSP, Java code, or a Page 
Flow, as described in Section 9.10, "Dispatching Events." If you want to use the 
Behavior Tracking event in Campaign definitions, create an event property set for 
the event, as described in Section 9.11.1, "Registering Events for Campaigns." If 
you want to perform custom functionality when the event is generated, create a 
custom event listener that listens for the event, as described in Section 9.9, 
"Creating Custom Event Listeners."

9.8.1.3 Creating an Event With a Scriptlet
You can create an event without writing an event class by using a scriptlet in a JSP. 
This technique is best suited for simple, Non-Behavior Tracking events that are used to 
trigger Campaigns. Using this technique for complex events clutters your JSP. You 
should use this technique in a JSP that has a form that can supply values to event 
properties.

Perform the following steps to create an event with a scriptlet:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, create an event 
property set. For instructions, see Section 9.11.1, "Registering Events for 
Campaigns."

2. After you have created the event property set, open the JSP in which you want to 
create the event.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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3. Drag the event property set file into the JSP where you want the event to occur (for 
example, after the Submit button on a form). The scriptlet is generated 
automatically.

For example, if you create an event property set called MyEvent.evt that contains 
a single, unrestricted attribute called fooAttribute, the following scriptlet is 
generated when you drag the property set file into a JSP:

<%
// Generate the Event object here.
// If you have a custom Event subclass for your event type,
// change this code to use it instead
com.bea.p13n.events.Event event = new com.bea.p13n.events.Event("MyEvent");
// fooProperty should be a String
event.setAttribute("fooProperty", "");

// These attributes are standard to all Events.
event.setAttribute("request", new com.bea.p13n.http.Request(request, true));
event.setAttribute("user-id", 
com.bea.p13n.usermgmt.SessionHelper.getUserId(request));

// Dispatch the Event to the EventService.
com.bea.p13n.tracking.TrackingEventHelper.dispatchEvent(request, event);
%>

The scriptlet automatically gets the request and the user-id, which are required for 
triggering Campaigns, and the code for dispatching the event. The dispatch code 
uses the Behavior Tracking API, but it also dispatches regular events.

You must supply the value for fooProperty, which could come from the value of a 
form field.

4. Save your work by choosing File > Save.

If you want to perform custom functionality when the event is generated, create a 
custom event listener that listens for the event, as described in Section 9.9, "Creating 
Custom Event Listeners."

9.8.2 Creating an XML Schema for Behavior Tracking
Behavior Tracking events, by default, store their property values in the database as 
XML. For each type of Behavior Tracking event, the Event service uses a specific XML 
schema to create the XML. When you create a custom Behavior Tracking event, you 
must also create an XML schema for the Behavior Tracking service to use.

When creating an XML schema for a custom Behavior Tracking event, consider the 
following connection points between the schema and your event class:

■ Filename – The value of the XSD_FILE key in your event class must match the 
name of the actual XSD file.

■ Namespace – The value of the XSD_NAMESPACE key in your event class must 
match the targetNamespace attribute value in your XSD file.

■ Property Order – The XSD file contains a list of event attributes you want to 
capture. The order in which these properties are listed in the XSD must match the 
order they are listed in your event class's localSchemaKeys[] array.

For example, if your event class contains this list of schema keys, your XSD file 
must list those properties in the same order:

private static final String localSchemaKeys[] =



Creating Custom Event Listeners

9-26 Oracle Fusion Middleware Interaction Management Guide for Oracle WebLogic Portal

{
SESSION_ID, USER_ID, PAGE_LABEL_KEY
};

When you use XSD, you need to change only the targetNamespace and xmlns= 
attribute values to your namespace, and add your custom event attributes, in order.

You can view the XSDs for WebLogic Portal's predefined events at the following 
location: 
<MW_HOME>\user_projects\workspaces\workshop\.metadata\.plugins\ 
com.bea.workshop.wls.core\libraries\p13n-app-lib_10.3.2_10.3.2\1
\APP-INF\lib\p13n_app.jar.

A user might not be associated with an event. In such a case, use the minOccurs="0" 
attribute for the user-id attribute in the XSD file. For example:

<xsd:element ref="user-id" minOccurs="0"/>

9.8.2.1 Packaging the Schema
After you create the schema, add it to your portal application's p13n_app.jar file 
using the following steps.

1. Back up your p13n_app.jar file by creating a copy of it and naming it 
p13n_ejb.orig, for example.

2. In your application directory, temporarily add the <yourschema>.xsd file to the 
lib/schema/ directory.

3. Add the schema to the p13n_app.jar file. In a command window (that has the 
JAR utility in the environment), switch to the application directory and run the 
following command:

jar uvf p13n_app.jar lib\schema\<yourschema>.xsd

The schema is added to the JAR file. 

4. Redeploy the p13n_app.jar file.

9.9 Creating Custom Event Listeners
An event listener serves one purpose: when an event occurs for which the listener is 
listening, the listener performs some type of programmatic functionality. WebLogic 
Portal provides the following two listeners that handle events in specific ways:

■ CampaignEventListener – Listens for all events (except those it is told to ignore in 
the listeners.properties file in the wps.jar file) and calls the Campaign 
service to evaluate and trigger Campaign actions.

■ BehaviorTrackingListener – Listens for all events registered with the Behavior 
Tracking service and puts data from Behavior Tracking events in a buffer, where it 
is later moved into the BT_EVENT database table. (You must manually register this 
listener to activate Behavior Tracking, as described in Section 9.7, "Enabling 
Behavior Tracking." For example, you could create a custom event listener that 
listens for the SessionLoginEvent, SessionBeginEvent, and 
SessionEndEvent. You can add the user-id field of these events to a list to keep 
track of who has logged in.

If you create and register a custom Behavior Tracking event, that event is handled by 
the BehaviorTrackingListener and the CampaignEventListener. If you 
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create a custom regular event, that event is handled by the 
CampaignEventListener.

However, there may be times when you want to provide more programmatic 
functionality when events occur, whether the events are custom events or WebLogic 
Portal's predefined events. For example, you may want to persist event data to a file or 
another database table, show related products when a user clicks a product image, or 
modify a User's Profile when the user submits a form. For these additional types of 
functionality, you must create custom event listeners.

WebLogic Portal provides a base event listener object called EventListener. This 
base class, which you must implement in your custom listener, provides two methods 
for listening for and responding to events:

■ The getTypes() method – Tells the Event service which types of events that 
interest the listener.

■ The handleEvent() method – Lets you insert the custom functionality you want 
to perform when the listener receives an event that interests it.

The steps to create a custom event listener involve creating a utility project, which is 
generally used to develop general-purpose Java code that is not directly part of special 
entities, such as web services, controls, or EJBs. Note that you can also use an EJB 
project (a new one or an existing one). 

The steps in this chapter refer to the \src folder in the Package Explorer View. Your 
src directory might be named differently.

Perform the following steps to create a custom event listener for regular events or 
Behavior Tracking events:

1. Create a utility project in Oracle Enterprise Pack for Eclipse by performing the 
following steps. 

a. In the Portal Perspective, choose File > New > Project.

b. In the New Project - Select a Wizard window, expand the J2EE folder and 
select Utility Project. Click Next.

c. In the New Java Utility Module - Utility Module dialog, enter a name for the 
utility project and ensure that the Use default check box is selected. Select the 
Add project to an EAR check box and click Next.

d. In the New Java Utility Module - Select Project Facets dialog, select the facets 
that you want to enable and click Finish. (If you select the Portal Application 
Services and/or Portal Customizations Framework facet, you can skip Step 2 
and proceed to Step 3.) 

Your new utility project is automatically associated with your EAR project. For 
more information on utility projects, see the Oracle Fusion Middleware Portal 
Development Guide for Oracle WebLogic Portal.

Note: If you try to access a local EJB with an EventListener, the 
attempt will fail in the JNDI lookup. For this scenario, use a Remote 
EJB interface instead. 

Note: You can also use an EJB project. You can either create a new 
EJB project or use an existing one. 
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2. To ensure that the project sees the p13n classes as the server will see them, add the 
WebLogic Portal Server and the p13n-app-lib library module CLASSPATH 
containers to the project. Perform the following steps:

a. In Package Explorer, right-click the portal utility project you created and 
choose Properties.

b. In the Properties dialog, select Java Build Path and select the Libraries tab.

c. Click Add Library.

d. In the Add Library dialog, select Oracle WebLogic Portal Server as the library 
type and click Next.

e. In the Add Library - Oracle WebLogic Portal Server dialog, configure the 
server CLASSPATH entries by selecting All Configured entries and clicking 
Finish. 

f. In the Properties dialog, click Add Library in the Libraries tab.

g. In the Add Library dialog, select WebLogic Library Module and click Next.

h. In the Add Library - Library Module dialog, click Browse and select 
p13n-app-lib and click OK. The Specification Version, and Implementation 
Version fields are populated. Select the Allow newer versions check box and 
click Finish.

i. In the Properties dialog, click OK.

3. Make a new Java class by performing the following steps:

a. Select your web project in Package Explorer View and choose File >New > 
Other. 

b. In the New - Select a Wizard dialog, expand the Java folder, select Class, and 
click Next.

c. In the New Java Class - Java Class dialog, enter a Name for the new class and 
for the Superclass. For example, a class name could be MyEventListener. 
Select the Constructors from superclass check box and the Inherited abstract 
methods check box and click Finish.

The new class appears in the \src directory of your portal web project.

4. Perform the following steps to define the events for which the listener will listen, 
declare event attribute names, and create the event object for the new Java class:

a. Your custom event listener must implement EventListener. For example:

public class MyEventListener
    implements EventListener
{

b. Define the events for which the listener will listen. For example:

private String[] eventTypes = {"MyEvent, ClickContentEvent"};

c. Pass the type of events listened for back to the base constructor. This tells the 
Event service which events to send to this listener when the events occur:

Note: It is unnecessary to perform Step 2 if you chose the Portal 
Application Services and/or Portal Customizations Framework facet 
in Step 1-d. 
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public String[] getTypes()
{
   return eventTypes;
}

d. Override the handleEvent() method to provide the programmatic 
functionality you want the listener to perform when the listened-for events 
occur:

public void handleEvent( Event ev )
  {
      //Put your custom code here.
      //This code is executed when the events occur.
  }
}

5. The Java files in the \src folder will be compiled the normal way and deployed as 
part of the application. You can dispatch the event listener from a JSP, Java code, or 
a Page Flow, as described in Section 9.10, "Dispatching Events." If you want to use 
the event listener in Campaign definitions, create an event property set for the 
event, as described in Section 9.11.1, "Registering Events for Campaigns."

6. Register the listener with the Event service by performing the following steps.

a. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

b. In the Resource Tree, expand the Personalization folder and select Event 
Service.

c. In the Browse tab, click Add Synchronous Listener or Add Asynchronous 
Listener.

d. Enter the fully qualified class name. For example:

com.bea.p13n.events.custom.listeners.MyEventListener

e. Click Update. The listener is registered with the Event service. You do not 
need to restart the server.

9.10 Dispatching Events
With events and listeners in place, you can dispatch those events in your JSPs, Java 
code, and Page Flows. Dispatching an event means that the Event service sends an 
event object to any listeners interested in the event. Those listeners, in turn, handle the 
events in their own ways.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

Note: Synchronous listeners receive events immediately. 
Asynchronous listeners use a thread scheduler to receive events.
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For example, a sample event called ResourceDisplayedEventBT, is dispatched 
from two portal framework skeleton JSP files: book.jsp and page.jsp. The 
book.jsp skeleton is responsible for rendering portal book and page navigation 
(such as tabs), and the page.jsp skeleton provides the area for portlets to be 
displayed.

The code shown in Example 9–2 is inserted in each of the book.jsp and page.jsp. 
files. This example uses code from the page.jsp file. The code dispatches a 
ResourceDisplayEventBT event when portlets are viewed on a page.

Example 9–2 Dispatching an Event from a JSP Page

<%@ page import="com.bea.p13n.tracking.TrackingEventHelper,
     examples.events.ResourceDisplayedEventBT" %>
...
ResourceDisplayedEventBT rde;
...
ResourceDisplayedEvent rde = new ResourceDisplayedEvent(
 ppc.getLabel(),
      portletTitle,
     "portlet",
      sessionID,
     userId,
     "true", // portlet is being displayed
 request,
    session );
// New mechanism for dispatching an event in 9.2:
EventService es = TrackingEventHelper.getEventService();
TrackingEventHelper.dispatchEvent(es, rde);
...

The code performs the following actions:

■ The file imports the custom event class and the TrackingEventHelper, which is 
used to dispatch the event.

■ The event class is assigned to the rde variable.

■ An instance of the event is created, and the attributes retrieved from the JSP are 
passed in as event arguments in the same order that the event expects them. It 
does not matter what names are used in the arguments as long as they supply the 
type of information the event needs.

■ The event is dispatched to the Event Service with the 
TrackingEventHelper.dispatchEvent( rde ) method.

The event is then sent to the listeners registered to receive it, and the listeners handle 
the event in their own ways. Figure 9–1 illustrates the event life cycle, and in this 
example, the skeleton JSP is Item 2 in the diagram.

Section 9.8.1.3, "Creating an Event With a Scriptlet" also describes how to dispatch an 
event for which you have created no event class. Dispatching events when content is 
clicked requires special instructions, as described in Section 9.4, "Generating Events for 

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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Content Clicks." Some predefined events have their own dispatch methods. See 
Section 9.3, "Using Predefined Events."

9.11 Using Events in Campaigns
You can use events to activate the Campaign Service and to make your Campaigns 
more powerful by triggering Campaign actions based on events and their attribute 
values.

When you use an event in a Campaign, you do not have to explicitly tell the Campaign 
service about your events. The Campaign listener listens for all events that are not 
explicitly excluded in the listeners.properties file in the wps.jar file.

When an event occurs for which the Campaign listener is listening, the listener calls 
the Campaign service. The Campaign service takes a snapshot of the current request 
and evaluates the request data against all the Campaign rules you have defined to see 
if any actions need to be performed.

In addition, you can use events in Campaigns in another way: as part of a Campaign 
action. For example, you can define a Campaign action that displays personalized 
content only if the user clicks the Home page in a portal (triggered by some sort of 
click page event). To use events as part of a Campaign definition, you must create an 
event property set, as described in Section 9.11.1, "Registering Events for Campaigns."

An example of using an event in a Campaign definition is illustrated in Figure 9–7, 
where a Campaign scenario is triggered if an event has specific property values 
(characteristics). When you add An event has specific characteristics to your Campaign 
scenario and click the characteristics link in the Campaign Editor, you can select the 
event properties and determine which property values will trigger the Campaign 
Action to occur. The event property set you created enabled the property selection.
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Figure 9–7 Using an Event to Trigger a Campaign Scenario

To control your Campaign, especially when you want personalized content to display, 
create events that trigger Campaign actions at the key places in your application. For 
more information on controlling personalized content, see Section 14.4, "Managing 
Placeholders for Optimal Performance." For instructions on creating a Campaign, see 
Section 8.2, "Building a Campaign."

This section contains the following topic:

■ Section 9.11.1, "Registering Events for Campaigns"

9.11.1 Registering Events for Campaigns
If you want to use a custom event to trigger a Campaign, you must create an event 
property set. The properties you create for the event match the attribute names defined 
in your event class.

For example, the sample ResourceDisplayedEvent class uses the following 
properties: resourceId, resourceLabel, resourceType, session-id, user-id, and 
resourceSelected. In your event property set, you can define properties for any or all 
of those attributes, but the property names must exactly match the event attribute 
names.

For instructions on creating event property sets, see Section 9.8, "Creating Custom 
Events." For instructions on registering event property sets, see Section 9.7, "Enabling 
Behavior Tracking."
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9.11.1.1 Changing Event Properties
If you create, modify, or delete event property sets after an application is deployed, 
you must update those property set definitions in the database using the Propagation 
Utility. For more information, see the Oracle Fusion Middleware Production Operations 
Guide for Oracle WebLogic Portal.

9.12 Debugging the Event Service
You can debug the Event service and review the console output.

Perform the following steps to debug the event service:

1. To debug the Event service, create debug.properties in a directory similar to 
the following: <MW_HOME>\user_projects\domains\<myDomain>.

2. Add the following to the file and modify the settings accordingly. These settings 
provide server console output for you to review:

usePackageNames: on
com.bea.p13n.cache: on
# Turns on debug for all classes under events
com.bea.p13n.events: on
# com.bea.p13n.events.internal.EventServiceBean: on
# Turns on debug for all classes under
# com.bea.p13n.tracking: on
com.bea.p13n.tracking.internal persistence: on
# Selectively turn on classes
com.bea.p13n.mbeans.BehaviorTrackingListener: on
com.bea.p13n.tracking.listeners.BehaviorTrackingListener: on
com.bea.p13n.tracking.SessionEventListener: on

3. In Oracle Enterprise Pack for Eclipse, double-click the server in the Servers tab and 
uncheck the Launch WebLogic server in Eclipse console check box. Close the 
Server Overview tab and click Yes to save your changes. Right-click the server 
name and choose Restart to start the server and run debugging from a command 
prompt.

9.13 Tracking Content Changes
You can use content events to track content changes to your virtual content repository 
and modifications to the repository's configuration. Content changes include who 
added, updated, or deleted content or content properties and the date and time the 
change was made in the repository. You can also track who performed the changes 
(including the date and time the changes were made) to the repository's configuration, 
its content types, or content workflow. For more information on these events, see 
Section 9.5, "Generating Content Events."

You could also configure a content event to watch for content changes and then 
perform an action. For example, when a user adds a resume document to the content 
repository, an e-mail is sent to the HR Director.

Tip: Events will fire for a content repository that was upgraded to 
10.x (unless you turned event tracking turned off at the repository 
level). Events can include repository configuration changes, as well as 
content updates, additions, and deletions to the repository. See the 
Oracle Fusion Middleware Upgrade Guide for Oracle WebLogic Portal for 
more information on performing an upgrade.
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These content events are saved in the Behavior Tracking database for historical 
tracking. For more information on content management, see the Oracle Fusion 
Middleware Content Management Guide for Oracle WebLogic Portal.

Perform the following steps to track content changes:

1. Start the Administration Console.

2. Choose Configuration & Monitoring > Service Administration.

3. In the Resource Tree, expand the Personalization folder and select Event Service.

4. Click Add Synchronous Listener.

5. Enter the listener name in the Class Name field. To capture content repository 
changes, enter 
com.bea.p13n.tracking.listeners.BehaviorTrackingListener. See 
Figure 9–8.

Figure 9–8 Identify the Behavior Tracking Listener

6. Click Update. 

7. In the Resource Tree, select Behavior Tracking Service.

8. In the Configure tab, click Add Event Type, as shown in Figure 9–9.
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Figure 9–9 Click Add Event Type

9. In the Persisted Event Type field, enter the events for the content change you want 
to track. For example, you could add the ContentCreateEvent to determine 
new content that was added to the content repository, who added it, and when.

10. Click Update.

11. Refresh the display by clicking Refresh Tree in the Resource Tree.

9.14 Disabling Behavior Tracking
You can disable the persistence of Behavior Tracking events by unregistering the 
Behavior Tracking listener or removing individual events.

This section contains the following topics:

■ Section 9.14.1, "Unregistering the Behavior Tracking Listener"

■ Section 9.14.2, "Removing an Individual Event"

Tip: To view the tracked changes to the content repository, you can 
create a log file of the repository content changes that are contained in 
the Behavior Tracking database tables, or you could enable listeners to 
provide specific logged output.
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9.14.1 Unregistering the Behavior Tracking Listener
Perform the following steps to unregister the Behavior Tracking listener:

1. Start the Administration Console.

2. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

3. In the Resource Tree, expand the Personalization folder and select Event Service.

4. In the Configure tab, locate the Behavior Tracking listener and select the Delete 
check box next to it.

5. Click Delete.

6. Refresh the display by clicking Refresh Tree in the Resource Tree.

9.14.2 Removing an Individual Event
Perform the following steps to remove default events:

1. Start the Administration Console.

2. In the Administration Console, choose Configuration & Monitoring > Service 
Administration.

3. In the Resource Tree, expand the Personalization folder and select Behavior 
Tracking Service.

4. In the Configure tab, select the Delete check box for each event in the Persisted 
Event Types section that you want to remove, as shown in Figure 9–10.

Figure 9–10 Select the Delete Check Box

5. Click Delete.

6. You must redeploy your application for the changes to take effect.

Note: Events could still be triggered to fire by the application, but 
they are not persisted to the database table.
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10Creating Advanced Personalization with
Rules

Developing Personalization using User Segments, Campaigns, Placeholders, and 
Content Selectors can be done with JSP tags with very little Java coding. There might 
be times, however, when you want more flexibility in your Personalization.You can 
achieve this by creating and deploying a rule set, which uses the Rules Controls and 
the RulesManager EJB.

This chapter contains the following sections:

■ Section 10.1, "Using Rules in Portal Applications"

■ Section 10.2, "Creating a Rule"

■ Section 10.3, "Rules Control Reference"

The Rules service can help you create advanced Personalization features, which can 
help control each user's path through a Page Flow or using runtime information as 
dynamic input to conditional logic in your code. You must possess a working 
knowledge of XML and schemas (an advanced version of DTDs), as well as an 
intermediate understanding of Java development.

10.1 Using Rules in Portal Applications
WebLogic Portal provides a set of tools to personalize the user experience in your 
portal applications. You have control over the content each user sees, the automatic 
e-mail messages each receives.

To achieve these Personalization results, you create User Segments, Content Selectors, 
and Campaigns in Oracle Enterprise Pack for Eclipse. Developing Personalization with 
these tools involves very little Java coding because you can use JSP tags. After this 
type of Personalization is developed, portal administrators can use the WebLogic 
Portal Administration Console to modify the behavior of the Personalization with no 
coding at all.

There may be times, however, when you want even more power and flexibility in the 
Personalization you develop. For example, you may want to use Personalization to 
control each user's path through a Page Flow or use run-time information as dynamic 
input to conditional logic in your code.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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You can access the Rules Service by using the following two types of components: 

■ The Rules Controls – The two rules controls (the Rules Executor Control and the 
Rules Manager Control) are used in Page Flows or Web services, and provide a 
convenient way to add rules functionality to your application without writing 
code. For example, using a drag-and-drop interface, you can add a Rules Control 
to a Page Flow, select the methods in the control you want to use, and configure 
the control in the Oracle Enterprise Pack for Eclipse Property Editor. For more 
information, see the Oracle Fusion Middleware Java API Reference for Oracle WebLogic 
Portal.

■ The RulesManager EJB – The Rules Controls, which delegate calls to the 
underlying RulesManager EJB, are the preferred way to interact with the Rules 
Service. However, if you want to use the Rules Service somewhere besides a Page 
Flow or Web service, you can use the RulesManager EJB directly in your code to 
access the Rules Service.

This overview section includes the following topics:

■ Section 10.1.1, "Choosing Personalization Components"

■ Section 10.1.2, "Understanding the Rules Service"

10.1.1 Choosing Personalization Components
Table 10–1 describes the personalization tools provided by WebLogic Portal. User 
Segments, Campaigns, Content Selectors, and Personalization JSP tags are described 
only to highlight the increased programmatic power you have by directly accessing 
the Rules Service.

The Input Objects and Action columns in Table 10–1 show the flexibility and power 
you have with the rules controls and the RulesManager EJB.
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Table 10–1 WebLogic Portal Personalization Components

Component Description Input Objects
Action (if the input objects 
match the rules criteria)

User Segments Dynamically assign users to a 
grouping, or segment, when the 
users meet specific conditions.

Segment rules are created in 
Oracle Enterprise Pack for Eclipse 
with the User Segment Editor. 
You can modify rules in the 
WebLogic Portal Administration 
Console.

Segment rules can be 
defined with User Profile 
properties, HTTP session 
or request properties, and 
date or time values and 
ranges.

One action: If all conditions 
evaluate to true, the user is 
considered a member of the 
segment. Segments can be 
used in Campaigns, Content 
Selectors, and in the 
<pz:div> JSP tag.

Campaigns Trigger personalized actions to 
occur for users who meet specific 
conditions or perform specific 
actions.

Campaign rules are created in 
Oracle Enterprise Pack for 
Eclipsewith the Campaign Editor. 
Rules are modifiable in the 
WebLogic Portal Administration 
Console.

Campaign rules can be 
defined with User 
Segments, User Profile 
properties, HTTP session 
or request properties, 
event characteristics, date 
or time values and ranges, 
and random sampling.

Up to three types of actions: 
Show a single personalized 
content item, automatically 
send a predefined e-mail, 
provide a discount. 

Content Selectors Show specific content items to 
users who meet specific 
conditions.

Content Selector rules are created 
in Oracle Enterprise Pack for 
Eclipse with the Content Selector 
Editor. You can modify rules in 
the Administration Console.

Content Selector rules can 
be defined with User 
Segments, User Profile 
properties, HTTP session 
or request properties, and 
date or time values and 
ranges.

One action: Show one or 
more personalized content 
items.
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10.1.2 Understanding the Rules Service
The Rules Service reads objects you have put into working memory and evaluating 
those objects against a set of rules you have predefined in an XML file. (Working 
memory is the place where objects are temporarily stored as the Rules Service is 
processing the rules.) If the objects in memory match the conditions defined in the rule 
set (which can be made up of multiple rules), the corresponding rule set actions are 
triggered. For example, if you put a user's credit score into working memory (from the 
User Profile, from the return of a Web service calculation, or any other way), a rule in 
the rule set can be defined in XML to perform the following action: If the user has a 
credit score equal to or greater than 10, classify that user as a 'gold customer'.

You can use the results of this rule processing in your applications any way you 
choose. For example, if you are developing a Page Flow, you can send a "gold 
customer" to the gold.jsp and send all other customers to another JSP.

■ Rules Controls – WebLogic Portal provides two rules controls that you can use to 
invoke the Rules Service from a Page Flow or Web service. The Rules Executor 
control lets you evaluate objects in working memory against a rule or set of rules, 
filter the results, and perform actions if the rules evaluate to true. The Rules 
Manager control provides methods for getting rule set information.

Personalization 
(Interaction 
Management) JSP 
tags

Some of these tags are used to 
render the results of segment, 
Campaign, and Content Selector 
rules. 

Displayed content is 
based on User Segment, 
Campaign, or Content 
Selector rules.

One action: Show 
personalized content items.

Rules Controls The Rules Executor control lets 
you evaluate any input objects 
(such as a user's profile 
properties) against a predefined 
set of rules (rule set). If the rules 
evaluate to "true" based on the 
input objects, any predefined 
action(s) can be triggered (such as 
assigning the user to a certain 
classification). The Rules 
Manager control lets you look up 
information about rule sets. The 
rules controls serve as an 
interface to the RulesManager 
EJB.

You add and configure rules 
controls in your Page Flows or 
Web services with a graphical 
user interface in Oracle Enterprise 
Pack for Eclipse. You create rules 
manually in XML.

Unlimited types of input 
objects: You can use the 
rules you create in XML to 
evaluate any object put 
into working memory 
(See Section 10.2.4, 
"Invoking the Rules 
Service to Evaluate 
Objects").

Unlimited types of actions: 
Can filter objects in working 
memory (see Section 10.2.5, 
"Filtering the Results") and 
perform any action defined 
in the rule set XML.

RulesManager EJB Provides the same capabilities as 
the rules controls in areas of your 
application other than Page Flows 
and Web services. Using the 
RulesManager EJB to access the 
Rules Service involves Java 
coding.

Unlimited types of input 
objects: You can use the 
rules you create in XML to 
evaluate any object put 
into working memory 
(See Section 10.2.4, 
"Invoking the Rules 
Service to Evaluate 
Objects").

Unlimited types of actions: 
Can filter objects in working 
memory (see Section 10.2.5, 
"Filtering the Results") and 
perform any action defined 
in the rule set XML.

Table 10–1 (Cont.) WebLogic Portal Personalization Components

Component Description Input Objects
Action (if the input objects 
match the rules criteria)
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■ RulesManager EJB – The RulesManager EJB is the interface into the Rules 
Service. The rules controls delegate calls to the RulesManager EJB. Use the 
RulesManager EJB if you want to use the Rules Service in code outside of a Page 
Flow or Web service.

10.1.2.1 Using the Rules Service
The Rules Service is based on the Rete algorithm, which is optimized for forward 
chaining reasoning. In the rule evaluation process outlined in the following steps, the 
Rules Executor control is used as an example:

1. The Portal Rules Service is initialized, creating its working memory.

2. The Rules Executor control will identify which rule set to use, which rules to 
evaluate (the default is all), and optionally, whether to filter the results. These are 
all parameters that can be configured on the control.

3. The developer creates and adds objects to working memory. Example objects 
could include the User's Profile, the Request, and so on. These parameters are 
passed in as an argument to the rule control's evaluate*() method.

4. The Rules Service is invoked by the Rules Executor control and uses the following 
algorithm:

a. Match – Evaluates the left hand side (LHS) of the rules to determine which are 
satisfied given the current contents of working memory.

b. Conflict resolution – Selects one rule with a satisfied LHS. If no rules satisfied 
the LHS, the interpreter is stopped.

c. Act – Performs the actions in the right hand side (RHS) of the selected rule.

d. Repeat the process – Go to Step a.

5. The Rules Service fires repeatedly, executing rules according to the state of the 
input objects and rule conditions. Only one rule can be fired at a time. As 
conditions are met and rules are fired, more objects may be added to working 
memory for evaluation.

6. After the Rules Service has reached a state where no more rules will fire, it stops. 
In addition to the original input objects, new objects created as a result of the rule 
evaluation may also be in working memory.

7. Because the input objects are part of the results, you may choose to filter the 
results based on a class. For example, you can specify that only results of Java class 
com.bea.p13n.usermgmt.profile.ProfileWrapper are returned.

8. The objects are returned to the caller, who then decides what to do with the 
returned data. For example, the user may be directed to a new page, or the User's 
Profile might have its properties updated.

Figure 10–1 provides a basic illustration of the rule evaluation process with the Rules 
Executor control used in a Page Flow. The returned results from the Rules Service 
process are used to determine the user's path through the Page Flow. In the figure, 
natural language is used instead of code for illustration purposes. (To see the actual 
parameterization and invocation of the control in a Page Flow, see Section 10.2.4.3, 
"Using the Control to Determine the User's Path in the Page Flow.")

Note: The Rules Manager control is most useful as a rules 
development debugging tool.
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Figure 10–1 Using Rules to Control a Page Flow

10.1.2.2 Understanding the Advantages of Using the Rules Service 
The Rules Service is more dynamic than a simple conditional in your code. After a 
Web application or some other application component has been hard-coded with 
condition statements (if/then), there is no way to change that without recompiling the 
code and re-deploying the application. In comparison, rules can be changed and 
loaded as the Portal server is running. This means the administrator may get the 
business logic from domain experts, formulate a rule to reflect that logic, and load the 
rule into the application without ever having to stop the server.

10.2 Creating a Rule
This section shows you how to develop personalization using the rules controls and 
RulesManager EJB. The following steps are involved and are described in this section:

■ Section 10.2.1, "Creating a Rule Set"

■ Section 10.2.2, "Deploying a Rule Set"

■ Section 10.2.3, "Adding Objects to Working Memory"

■ Section 10.2.4, "Invoking the Rules Service to Evaluate Objects"

■ Section 10.2.5, "Filtering the Results"

■ Section 10.2.6, "Using the Results in Your Application"

10.2.1 Creating a Rule Set
Rule sets are sets of instructions written in XML that the Rules Service uses to evaluate 
objects in working memory. A rule set determines if something in working memory 
meets certain conditions and performs an action.

There are two methods you can use to create a rule set:

■ Create a rule set in Oracle Enterprise Pack for Eclipse

■ Create a rule set manually

Creating a Rule Set in Oracle Enterprise Pack for Eclipse

You can use Oracle Enterprise Pack for Eclipse to create and manage a .rls file that 
contains rules, conditions, and actions. 
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Perform the following steps to create a rule set in Oracle Enterprise Pack for Eclipse:

1. Start the WebLogic Server in Oracle Enterprise Pack for Eclipse by choosing Run 
As > Run on Server. For instructions on configuring the WebLogic Server, see the 
Oracle Fusion Middleware Portal Development Guide for Oracle WebLogic Portal. 

2. In the Portal Perspective, right-click the <data>\src folder in the Package Explorer 
View and choose New > Rule Set.

3. Select the folder for the rule set and enter a name for the rule set in the File name 
field, using the .rls file extension. A rule set can exist anywhere in your data 
directory.

4. Click Finish. The rule set appears in the folder you selected. 

5. Select the rule set in the Rule Set Editor.

6. Select the Properties tab and enter a description for the rule set.

7. From the Design Palette tab, drag a rule action onto the Rule Set Editor. See 
Section 8.2.4, "Adding an Action to a Scenario's Rule" for more detail on each 
action.

8. In the action, click the all link to toggle back and forth between any and all to 
determine which conditions will trigger this action. The any choice means that 
only one of the conditions must be true for the action to occur. Rules can have 
more than one action.

9. Click other applicable links and define them.

10. In the Available Conditions section in the Design Palette tab, select the condition 
under which the rule set will run and drag the condition to the action. Click the 
condition's link to define the condition and determine what will trigger the action. 
See Table 4–1 for more information on conditions. See Figure 10–2 for an example 
rule set.

Figure 10–2 A Rule Set that Uses The Visitor is a Member of a Predefined User Segment 
Condition

11. Save the file by choosing File > Save.

10.2.1.1 Creating a Rule Set Manually
You can create a rule set manually. Rule sets must conform to particular schema. (The 
rule set schemas are located in the p13n_app.jar file. You can find this file in 
<WLPORTAL_HOME>\p13n\lib\j2ee-modules\p13n-app-lib.ear.) The 
language of the rules is actually a usage of the WebLogic Portal expressions package, 
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extended to meet additional requirements for the Rules Service. See the 
com.bea.p13n.expression.operator.* packages in Oracle Fusion Middleware 
Java API Reference for Oracle WebLogic Portal for descriptions of the expressions you can 
use.

Rule set XML files, which must end in .rls, all contain the following required 
elements: 

■ The <rule-set> – Includes all references to schema used in the rule set.

■ The <rule> – Contains the definition of the rule, which consists of at least one 
condition and at least action. A rule set can have more than one <rule>.

■ The <conditions> and <actions> – Each <rule> contains its own if/then clauses 
that consist of at least one <condition> (if) and one or more <action> (then). 
The Rules Service evaluates the objects in working memory against the conditions. 
If an object meets a condition, the related actions are executed. 

Example 10–1 contains a simple rule set example that says, If the string 'Make an Integer 
10' is in working memory, add an Integer object '10' to working memory.

Example 10–1 Rule Set that Adds an Object to Working Memory

<?xml version="1.0" encoding="UTF-8"?>
<!-- edited with XMLSPY v5 rel. 4 U (http://www.xmlspy.com) by Your Name (Your 
Company) -->
<rule-set xmlns="http://www.bea.com/servers/p13n/xsd/rules/core/2.1.1" 
xmlns:exp="http://www.bea.com/servers/p13n/xsd/expression/expressions/2.1.1" 
xmlns:literal="http://www.bea.com/servers/p13n/xsd/expression/literal/1.0.1" 
xmlns:string="http://www.bea.com/servers/p13n/xsd/expression/string/1.0.1" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.bea.com/servers/p13n/xsd/rules/core/2.1.1
rules-core-2_1_1.xsd" is-complete="true">
   <rule is-complete="true">
      <name>Add Integer</name>
      <description>Test Rule</description>
      <conditions>
         <exp:equal-to>
            <exp:variable>
                <exp:type-alias>java.lang.String</exp:type-alias>
             </exp:variable>
                <literal:string>Make an Integer 10</literal:string>
             </exp:equal-to>
       </conditions>
       <actions>
           <add-object>
               <exp:type-alias>java.lang.Integer</exp:type-alias>
               <exp:arguments>
                   <literal:string>10</literal:string>
                </exp:arguments>
            </add-object>
       </actions>
   </rule>
</rule-set>

Unless you are adept at reading schemas and manually constructing valid XML 
according to the schema's rules, use an XML editor such as XMLSpy (which can be 
installed from the WebLogic Platform product CD). An XML editor reads a schema, as 
well as all the schemas the schema imports, and shows you elements and attributes 
that can be added to an XML document at any location, showing you available 
elements and attributes and helping you create a valid XML rule set.
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Before you begin to create the rule set in XML, write out the rule in natural language to 
understand all its pieces (conditions and actions) and types of data. What is being put 
into working memory? What conditions do you want the objects to meet, and what 
should happen (actions) when objects in working memory meet the conditions?

Use the following guidelines to create a rule set (or modify an existing rule set) with an 
XML editor:

1. Extract the following schemas from the p13n_app.jar file in the 
<WLPORTAL_HOME>\p13n\lib\j2ee-modules\p13n-app-lib.ear file 
into the same directory where you will create your rule set:

lib/schema/expression*.xsd

lib/schema/rules*.xsd

2. Start a new document (or open an existing document) in your XML editor and 
associate the document with the rules-core-2_1_1.xsd schema. This schema 
also includes imports of other schemas, especially expression schemas, that are 
helpful in building rule sets.

In a new XML document, your XML editor should automatically insert the XML 
header, automatically import any schemas listed for import, and insert required 
base elements, such as <rule-set>, <rule>, <name>, <conditions>, and 
<actions>.

3. Select the <conditions> and <rules> elements and begin building (or 
modifying) the conditions and rules.

Figure 10–3 shows a rule set being built in XMLSpy. With the 
<exp:greater-than-or-equal-to> element selected, the Elements section 
shows which elements can be added as children. The Attributes section shows the 
attributes that can be set on the element.

Figure 10–3 Building a Rule with an XML Editor

4. After you finish building the rule set, use the XML editor's features to check them 
for being well-formed. Then validate the rule set against the schema. (In XMLSpy, 
press F7 and F8 to perform these steps.) See Section 10.2.1.3, "Working with Invalid 
Rule Sets" for instructions on fixing invalid rule sets.
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5. Save the rule set. (XMLSpy prompts you if you are trying to save an invalid rule 
set, but you can still save it.)

6. Copy the rule set to your portal application's datasync project directory, or to one 
of its subdirectories. For example, create a 
myDatasyncProject/src/rulesets directory and save the rule set there.

10.2.1.2 Using a Method in a Rule
Example 10–2 and Example 10–3 show how an XML rule set uses a method to retrieve 
a User Profile property value so it can be evaluated by the Rules Service.

Example 10–2 Condition

<exp:greater-than-or-equal-to>
   <literal:integer>10</literal:integer>
   <exp:instance-method>
      <exp:variable>
         <exp:type-alias>User</exp:type-alias>
      </exp:variable>
      <exp:name>getProperty</exp:name>
      <exp:arguments>
         <literal:string>CreditPropertySet</literal:string>
          <literal:string>CreditScore</literal:string>
        </exp:arguments>
    </exp:instance-method>
</exp:greater-than-or-equal-to>

Example 10–3 Method To Which the Condition Maps

ProfileWrapper pw = SessionHelper.getProfile(request);
Object value = pw.getProperty("CreditPropertySet", "CreditScore");

Use the following information when working on the mapping between the XML and 
the method:

■ The <exp:type-alias> identifies the type of object the method will work on. 
For a list of object type mappings defined in the 
parser-mapping-type.properties file in p13n_app.jar, see 
Section 10.2.3.3, "Using Type Mappings."

■ The <exp:instance-method> indicates a method, and the <exp:name> 
provides the name of the method.

■ The <exp:argument> includes two <literal:string> elements that provide 
the String arguments to the method.

■ The <literal:integer> identifies a value that the Rules Service uses. The 
evaluation of the object in working memory (in this case the User Profile 
CreditScore value) determines if the rule's action is fired.

■ The result is that the rule's condition (in XML) retrieves the value of the user's 
CreditScore. If the value is greater than or equal to 10, in this example, the 
associated actions are fired.

Note: To invoke methods from a rule, the appropriate classes must 
be imported in the calling code.



Creating a Rule

Creating Advanced Personalization with Rules 10-11

10.2.1.3 Working with Invalid Rule Sets
If a rule set does not validate, you can see the invalid area. Perform the following steps 
to fix the invalid rule set:

■ Verify that you imported all schemas referenced in the .rls file. Those schemas 
are listed at the top of the *.rls file. The schemas must be in the same directory 
as the .rls file.

■ Ensure that the XML sections defined in your .rls file are valid according to the 
schema. You can open the schema in XMLSpy to check your .rls against the 
schema definitions. In XMLSpy, you can view the schema in Design view for a 
graphical representation of the schema. You can view the .rls in Text view and 
Enhanced Grid view.

10.2.2 Deploying a Rule Set
This section explains how to deploy a rule set in development (Oracle Enterprise Pack 
for Eclipse) and in Staging or Production environments.

This section contains the following topics:

■ Section 10.2.2.1, "Deploying a Rule Set in Oracle Enterprise Pack for Eclipse"

■ Section 10.2.2.2, "Deploying a Rule Set in a Staging or Production Environment"

10.2.2.1 Deploying a Rule Set in Oracle Enterprise Pack for Eclipse
After you create a rule set and store it in your application's datasync project directory 
(or in a subdirectory you create, such as the myDatasyncProject/src/rulesets 
directory), the rule set is automatically deployed if the server is running. If the server 
is not running, the rule set is automatically deployed at server startup. (The datasync 
project directory also contains the User Segments, Content Selectors, Campaigns, and 
other application metadata you have created.) Rule sets must be deployed to the 
datasync project directory, and rule set file names must have an .rls extension to be 
used by the Rules Service.

When you modify a rule set in the datasync project directory, the rule set is 
automatically refreshed on the running server.

10.2.2.2 Deploying a Rule Set in a Staging or Production Environment
Perform the following steps to add, modify, or remove a rule set that exists in a 
deployed application:

1. Modify the rule set in the Development environment and replace it in the 
deployed application. If the application is in a compressed EAR file, you must 
recreate the EAR file to include the updated rule set and then replace the EAR file 
on the server. When you replace the EAR file on the server, you do not need to 
redeploy the application.

2. Update the rule set with the Propagation Utility. See the Oracle Fusion Middleware 
Production Operations Guide for Oracle WebLogic Portal for instructions.

Note: There is no guarantee that a rule set validated in an XML 
editor will be validated in the Rules Service.
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10.2.3 Adding Objects to Working Memory
Rule sets must have objects in working memory to evaluate. For example, a rule set 
might contain a rule that has the following condition: "If the user's credit score is 
greater than 10." This implies there is either the credit score input, or there is a way to 
get at the credit score. We could add a credit score to working memory in one of two 
ways:

■ Adding the credit score to memory from an integer

■ Adding the credit score to memory from a User Profile

10.2.3.1 Adding a Credit Score to Working Memory from an Integer
You could provide a credit score value in your code in the following ways:

■ Directly – For example, Integer value = new Integer(10);

■ Indirectly – For example, through a form input value:

Object [] inputObjects = { value }; (This is a required argument to the 
evaluate*() methods.)

You could then create a rule condition that evaluates the value Integer.

10.2.3.2 Adding a Credit Score to Working Memory from a User Profile
Retrieving a credit score from a User Profile is more flexible and dynamic. First, you 
would use code to retrieve the User Profile and put it into working memory: 

ProfileWrapper pw = SessionHelper.getProfile(request);
Object [] inputObjects = { pw }; (This is a required argument to the evaluate*() 
methods.)

In your rule set, you would then create a condition that uses a method 
(getProperty) that retrieves a specific property (CreditScore) from a specific 
property set (CreditPropertySet). See the example in Example 10–2 and 
Example 10–3. The condition in the code example checks to see if the retrieved 
CreditScore is greater than or equal to the <literal:integer> value of 10.

10.2.3.3 Using Type Mappings
The following object type mappings are from the 
parser-mapping-type.properties file in the p13n_app.jar file:

10.2.3.3.1 Using Mappings for <type-alias> Tags  Example 10–4 shows mappings for 
<type-alias> tags.

Example 10–4 Mappings for <type-alias> Tags

User=com.bea.p13n.usermgmt.profile.ProfileWrapper
Classifier=com.bea.p13n.user.Classification
Capability=com.bea.p13n.entitlements.common.Capability
Role=com.bea.p13n.entitlements.common.Role
Context=com.bea.p13n.rules.internal.engine.Context

Note: The User type is actually an alias for an object of class 
ProfileWrapper. This mapping of User to ProfileWrapper, along with 
the mappings of other well-known types, are defined in the 
parser-mapping-type.properties file in the p13n_app.jar file, shown in 
Section 10.2.3.3, "Using Type Mappings."
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Email=com.bea.campaign.rules.MailActionDef
Placeholders=com.bea.campaign.rules.AddAdToPlaceholderActionDef
EndScenario=com.bea.campaign.rules.EndScenarioActionDef
ContentQueryAdvice=com.bea.p13n.content.advislets.ContentQueryAdvice

The code examples in Example 10–1 and Table 10–1 show the <type-alias> element 
with a User type.

10.2.3.3.2 Mappings for <variable> Tags  Example 10–5 shows mappings for <variable> 
tags.

Example 10–5 Mappings for <variable> Tags

user=com.bea.p13n.usermgmt.profile.ProfileWrapper
request=com.bea.p13n.http.Request
session=com.bea.p13n.http.Session
event=com.bea.p13n.events.Event
randomNumber=java.lang.Number
classification=com.bea.p13n.user.Classification
date=com.bea.p13n.xml.schema.Date
time=com.bea.p13n.xml.schema.Time
timeInstant=com.bea.p13n.xml.schema.TimeInstant
role=com.bea.p13n.entitlements.common.Role
resource=java.lang.String

10.2.4 Invoking the Rules Service to Evaluate Objects
After you have created a rule set and you have objects in working memory, you can 
invoke the Rules Service to evaluate the objects in working memory with the rules you 
created. This section provides an example to show you how to invoke the Rules 
Service with the Rules Executor control in a Page Flow.

10.2.4.1 Using an Existing Rule Set
The example used throughout the Section 10.2.4, "Invoking the Rules Service to 
Evaluate Objects" section assumes that a rule set already exists in the 
/data/rulesets directory that classifies users as "GoldCardMembers" or 
"SilverCardMembers" by reading a User's Profile (similar to the example used in 
Section 10.2.3.2, "Adding a Credit Score to Working Memory from a User Profile"). The 
Page Flow example in this section shows the User Profile being added to working 
memory. Since the User's Profile is needed in this example, you should assume the 
Profile Control was added to an existing Page Flow to enable the getting and setting of 
User Profile properties.

This sample also uses the User Login Control for authentication so that the Page Flow 
knows which User Profile to retrieve.

For instructions on creating a Page Flow and adding a Portal Control to the Page Flow, 
see the Oracle Fusion Middleware Java API Reference for Oracle WebLogic Portal.

10.2.4.2 Inserting the Control in the Page Flow
When you insert a control in a Page Flow (a .jpf file in Oracle Enterprise Pack for 
Eclipse), all the Actions that are part of that control are available to use.
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The Rules Executor Control contains two actions:

■ The evaluateRule Action – Lets you evaluate the objects in working memory 
against a single rule in a rule set.

■ The evaluateRuleSet Action – Lets you evaluate the objects in working memory 
against all rules in a rule set.

When you are looking at a Page Flow in Action View, you can select a control you have 
inserted (by selecting the control's border) and set properties on that control. The 
Property Editor is a convenient way to send arguments to the RulesManager EJB 
(which interfaces directly with the Rules Service) without writing Java code.

For example, Table 10–2 shows how the Rules Executor Control properties shown in 
Figure 10–1 map to method and constructor arguments in the RulesManager EJB.

The RulesManager EJB has the same Actions contained in the Rules Executor 
Control: evaluateRule() and evaluateRuleSet(). The difference is that the 
Rules Executor Control Actions take only one argument—for example, 
evaluateRuleSet(Object[] inputObjects)—and provide the rule and filter 
arguments through the control properties.

If you set the filterResults property to true on the Rules Executor Control, the 
EJB method with the filter argument is used and the filtering properties you enter 
are automatically sent to that argument. 

The filterClassName and filterClassNames properties are different options for 
populating the filter argument (with one or more types of filters). Set either 
filterClassName or filterClassNames on the control, but do not set both.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.

Table 10–2 How Control Properties Map to Method and Constructor Arguments

Rules Executor Control 
properties Methods and Constructors

rulesetUri

ruleName

filterResults

filterClassName

filterClassNames

■ evaluateRule(String ruleSetUri, String ruleName, Object[] 
inputObjects)

■ evaluateRule(String ruleSetUri, String ruleName, Object[] 
inputObjects, ObjectFilter filter)

■ evaluateRuleSet(String ruleSetUri, Object[] inputObjects)

■ evaluateRuleSet(String ruleSetUri, Object[] inputObjects, 
ObjectFilter filter)

For details on these RulesManager EJB methods, see com.bea.p13n.rules.manager in 
the Oracle Fusion Middleware Java API Reference for Oracle WebLogic Portal.

filterRuleName ■ RuleResultClassFilter(String ruleName, Class targetClass)

■ RuleResultClassFilter(String ruleName, Class[] 
targetClassArray)

For details on these filter constructors, see 
com.bea.p13n.rules.manager.RuleResultClassFilter in the Oracle Fusion Middleware 
Java API Reference for Oracle WebLogic Portal.
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Use the filterRuleName property to filter on the results of a specific rule in a rule set 
that has fired. If you use this property, the RuleResultClassFilter constructor is 
called. Notice that the constructor is overloaded to use either a single class filter (that 
you entered in the filterClassName) property or multiple class filters (that you 
entered in the filterClassNames) property. The result of using the 
filterRuleName property is that you not only filter the results of a specific rule that 
has fired, you can also filter on specific data types.

Following are more detailed definitions of the control properties:

■ The rulesetUri (required) URI of the rule set to use – This URI is relative to the 
application's datasync project directory. For example, if you created a rule set 
called myruleset.rls and stored it in a myDatasyncProject/rulesets 
directory, the URI would be /rulesets/myruleset.rls. Use the Rules Manger 
Control to list rule sets and rules.

■ The ruleName (optional) Name of the rule to use –The rule must be contained in 
the rule set specified in the rulesetUri property. If not specified, all the rules in the 
rule set are evaluated. The default is null.

■ The filterResults (optional) – This property determines whether to filter the 
results after the rules have been evaluated. If the value is false, all objects 
remaining in working memory are returned. The default is false. For 
information on filtering, see Section 10.2.5, "Filtering the Results."

■ The filterClassName (optional) – Enter the class name (for example, 
java.lang.String) of the type of results to return. If this is left empty, results 
are not filtered. Specify this or the filterClassNames, but not both.

■ The filterClassNames (optional) – Enter a comma-separated list of class names of 
the types of results to return (for example, 
java.lang.String,java.lang.Integer). If this is left empty, results are not 
filtered. Specify this or the filterClassName, but not both.

■ The filterRuleName (optional) – Filter the results of a specific rule that was fired. 
If this is left empty, results from all rules will be returned. Otherwise, results from 
only this rule are returned. This filter is applied with the Class filters, if those are 
specified.

10.2.4.2.1 Understanding the Benefits of Using the Control  Understanding how properties 
map to methods and constructors can help you understand the benefits of using the 
Rules Executor control. Filling in property values provides the following benefits:

■ You do not have to write Java code

■ If you are filtering the results, the filter is constructed automatically for you

For more information on the Rules Executor Control, see the Oracle Fusion Middleware 
Java API Reference for Oracle WebLogic Portal.

10.2.4.3 Using the Control to Determine the User's Path in the Page Flow
After you add the Rules Executor Control to the Page Flow, set the properties on the 
control, and select one of the control's execute* actions to use, you should verify that 
all other prerequisite details are in place (see Section 10.2.4.1, "Using an Existing Rule 
Set"). Then you can add code to the Page Flow that sends users to a different page 
depending on the classification they receive from the rule evaluation process.

The sample Page Flow code in Example 10–6 shows how a user is directed to a 
particular page based on the results from the Rules Service. 
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Example 10–6 Sample Code to Direct a User to a Page, Based on the Results of the 
Rules Service

public class Controller extends PageFlowController
{
    /**
    * @common:control
    */
    private com.bea.p13n.controls.login.UserLoginControl userLoginControl;
    /**
    * @common:control
    */
    private com.bea.p13n.controls.profile.ProfileControl myProfileControl;
// The Rules Executor control is added. Properties are configured
// in the Property Editor.
// This is all done in the Page Flow's Action View.
    /**
    * @common:control
    * @jc:rules-executor filterClassName="com.bea.p13n.user.Classification"
filterResults="true" rulesetUri="/rulesets/myruleset.rls"
    */
    private com.bea.p13n.controls.rules.RulesExecutorControl
    myRulesExecutorControl;
    /**
    * @jpf:action
    * @jpf:forward name="default" path="default.jsp"
    * @jpf:forward name="goldCard" path="goldCard.jsp"
    * @jpf:forward name="silverCard" path="silverCard.jsp"
    * @jpf:catch type="com.bea.p13n.controls.exceptions.P13nControlException" 
path="error.jsp"
    * @jpf:forward name="error" path="error.jsp"
    */
    protected Forward evaulateRuleSetAction(EvaluateRuleSetActionForm form)
    throws P13nControlException
    {
// Start with an empty list into which we add objects to populate
// the working memory of the Rules Service
        List wmObjects = new ArrayList();
        ProfileWrapper pw = 
myProfileControl.getProfileFromRequest(this.getRequest());
        if ( pw == null)
        {
            throw new P13nControlException("Undable to retrieve profile from
            request. " + "Make sure PortalServletFilter is configured 
            in web.xml for an anonymous user, " + "or that a user 
            has logged in.");
        }
// This one will be the condition that fires the rule
        Integer value = new Integer(6);
        myProfileControl.setProperty(pw, "FooPropertySet", "CreditScore", value);
        wmObjects.add(pw);
// Evaulate all rules in the rule set. Parameters have been declared on the
// control in the Page Flow Property Editor (in Action View).
        Iterator iter = 
myRulesExecutorControl.evaluateRuleSet(wmObjects.toArray());
        List results = new ArrayList();
// Let's say we're looking for GoldCardMembers
        Classification goldCardMembers = new Classification("GoldCardMembers");
        Classification silverCardMembers = new 
Classification("SilverCardMembers");
// And we'll direct them to a certain page depending 
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// on how the rule evaluates
        Classification classification = (Classification)iter.next();
// Now you would do something with that,
// like show them a different page
        if (classification.equals(goldCardMembers))
        {
// Direct them to high-price stuff
            return new Forward("goldCard");
        }
        else if (classification.equals(silverCardMembers))
        {
// Direct them to lower-price stuff
            return new Forward("silverCard");
        }
// Otherwise, it defaults. Something went wrong.
// Check the rule conditions or turn off filtering on the control 
// to see what's in working memory
        }
    }
    return new Forward("default");
}

If you want to use only a specific type of object in working memory after the Rules 
Service has stopped, you can filter the objects in working memory. Filtering is set 
using Java types. On the Rules Executor Control, you can set the filter type in the 
Property Editor.

Get more information on the following subjects:

■ Filter Type – See Section 10.2.5, "Filtering the Results"

■ The Rules Executor Control – See the Oracle Fusion Middleware Java API Reference 
for Oracle WebLogic Portal.

■ The RulesManager EJB – See the Oracle Fusion Middleware Java API Reference for 
Oracle WebLogic Portal. 

10.2.5 Filtering the Results
When you execute the Rules Service to evaluate objects in working memory, as 
described in Section 10.2.4, "Invoking the Rules Service to Evaluate Objects," you can 
filter the objects in working memory when the Rules Service has stopped running to 
return only the objects of a specific type.

Objects exist in working memory as a result of one of the following actions:

■ The caller puts them there (in the inputObjects array)

■ A new object is instantiated in one of the rules' actions

When the Rules Service has stopped, several objects might remain in working memory, 
including those the user initially added. For example, your rule may instantiate a new 
Classification object into working memory if the rule evaluates to true. Another 
example is that a rule action might have updated the User's Profile, so you need to 
retrieve the profile from working memory.

When the Rules Service's API executes a rule, it returns an Iterator over the entire 
contents of working memory unless you filter the results. If you are looking only for 
Classification objects, then you can specify a filter that returns only Classification 
objects. You can design this filter based on a single class name, multiple class names, 
or a given rule, as described in Section 10.2.4.2, "Inserting the Control in the Page 
Flow."
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When you implement the Rules Executor Control, the control takes care of 
constructing the filter automatically. You need to specify whether to filter and the filter 
class names as control properties. The filter is applied for you automatically by the 
control, if you specify this.

10.2.5.1 Filtering with the RulesManager EJB
Filtering with the RulesManager EJB is a more cumbersome than filtering with the 
Rules Service, because you must design the filter yourself with the RulesManager 
EJB. Example 10–7 shows how to design a filter.

Example 10–7  Design a Filter with the RulesManager EJB

String filterRuleName = null;
Class filterClass = com.bea.p13n.user.Classification.class;
ObjectFilter filter = new RuleResultClassFilter(filterRuleName, filterClass);
Class [] filterClasses = { java.lang.String.class, 
com.bea.p13n.usermgmt.profile.ProfileWrapper.class};
ObjectFilter filter = new RuleResultClassFilter(filterRuleName, filterClasses);

The filter can then be used as part of the RulesManager EJB, as shown in the 
following example:

public Iterator evaluateRule(String ruleSetUri, String ruleName, Object[] 
inputObjects, ObjectFilter filter)

If you filtered the results, the Iterator should only contain results of the class types you 
specified. The code sample in Example 10–8 shows a Classification object of 
SilverCardMembers.

Example 10–8 Sample Code that Retrieves Silver Card Members

while (iter.hasNext())
{
Classification c = (Classification)iter.next(); 
     if (c.equals(silverCardMembers)) 
     {  
          // do something 
     } 
} 

10.2.6 Using the Results in Your Application
The Rules Service makes decisions for you at run-time. The rules framework is more 
flexible than hard-coding logic (if/then) into your components, because you can 
modify rules without modifying your code.

Following are some examples of using rules and rule results:

■ If the time is between 8-5, direct users to pages that relate to brokerage services. If 
the time is outside the range, direct users to pages related to investment research.

■ If the user lives in Boulder and is female, show her an advertisement for the 
Boulder Rock Club.

■ If the user's credit score is > 10, the User Profile (sets a property) to classify the 
user as a Gold Member.

■ If the date is between December 1 and December 31, send the user to the New 
Year's promotional JSP.
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10.3 Rules Control Reference
You can use the Rules Control elements to provide Personalization in your portal 
application. Table 10–3 lists the control names and all possible values you can use to 
create rules.

Table 10–3 Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values

rule-set The root element that contains 
all of the rules.

rule

rule The definition of a rule using 
conditions and actions, along 
with an optional description.

name, description, conditions, actions

name The name of the rule. Any text

description Optional text describing the 
rule.

Any text

conditions Expressions that the Rules 
Service evaluates using the 
objects in working memory.

variable, literal, branch, operator, method

variable Indicates the type of the object 
being compared in an 
expression.

N/A
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type-alias A string specifying the kind of 
a an object or variable

For variables, the value can be any type, such as 
java.lang.String, or an alias to a variable type from the list 
below:

user=com.bea.p13n.usermgmt.profile.ProfileWrapper

request=com.bea.p13n.http.Request

session=com.bea.p13n.http.Session

event=com.bea.p13n.events.Event

randomNumber=java.lang.Number

classification=com.bea.p13n.user.Classification

date=com.bea.p13n.xml.schema.Date

time=com.bea.p13n.xml.schema.Time

timeInstant=com.bea.p13n.xml.schema.TimeInstant

role=com.bea.p13n.entitlements.common.

Roleresource=java.lang.String

For objects, the value can be any type, such as java.lang.String, 
or an alias to an object type from the list below:

User=com.bea.p13n.usermgmt.profile.ProfileWrapper

Classifier=com.bea.p13n.user.Classification

Capability=com.bea.p13n.entitlements.common.

Capability

Role=com.bea.p13n.entitlements.common.Role

Context=com.bea.p13n.rules.internal.engine.Context

Email=com.bea.campaign.rules.MailActionDef

Placeholders=com.bea.campaign.rules.

AddAdToPlaceholderActionDef

EndScenario=com.bea.campaign.rules.

EndScenarioActionDef

ContentQueryAdvice=com.bea.p13n.content.advislets.

ContentQueryAdvice

literal Used to specify a particular, 
unchanging value

boolean, character, decimal, double, float, integer, long, string

branch Controls the execution path 
within a rule.

if

if Evaluates expressions to 
control execution path within a 
rule.

Any two or three other expressions that evaluate to true or false.

operator Indicates what sort of 
comparison will be made in the 
expression.

and, equal-to, greater-than, greater-than-or-equal-to, less-than, 

less-than-or-equal-to, multi-and, multi-or, not, not-equal-to, or

and To evaluate to true, both 
expressions must evaluate to 
true.

N/A

equal-to Evaluates to true when both 
expressions are equivalent.

N/A

Table 10–3 (Cont.) Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values
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greater-than Evaluates to true when the first 
expression is more than the 
second expression.

N/A

greater-than-

or-equal-to

Evaluates to true when the first 
expression is more than or the 
same as the second expression.

N/A

less-than Evaluates to true when the first 
expression is less than the 
second expression.

N/A

less-than-or-

equal-to

Evaluates to true when the first 
expression is less than or the 
same as the second expression.

N/A

multi-and Evaluates to true when all of 
the supplied expressions 
evaluate to true.

N/A

multi-or Evaluates to true when any of 
the supplied expressions 
evaluate to true.

N/A

not Negates the logical value of 
one expression.

N/A

not-equal-to Evaluates to true when both 
expressions are not equivalent.

N/A

or Evaluates to true when either 
expression evaluates to true.

N/A

method An abstract, complex type. static-method, instance-method, new-instance, contains, 
contains-all, abs, acos, add, asin, atan, atan2, ceil, cos, divide, 
exp. floor, ieee-remainder, log, maximum, minimum, multiply, 
pow, rint, round, sin, sqrt, subtract, tan, to-degrees, to-radians, 
char-at, compare-to-ignore-case, concat, ends-with, 
equals-ignore-case, length, like, replace, starts-with, substring, 
to-lower-case, to-upper-case, trim

static-method Invokes the named method on 
an object in working memory 
of the type specified by the 
type-alias, passing any 
provided arguments to the 
method.

type-alias, name, arguments

instance-

method

Invokes the named method on 
an object in working memory 
of the type specified by the 
variable type-alias, passing any 
provided arguments to the 
method.

variable, name, arguments

new-instance Instantiates an object of the 
type specified in the type-alias. 
Arguments are supplied as 
expressions, and the type of 
each argument is specified in 
the type-alias list in the 
arguments- signature.

type-alias, arguments-signature, arguments

Table 10–3 (Cont.) Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values
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contains Returns a boolean indicating if 
the first Collection object 
contains the second object.

N/A

contains-all Returns a boolean indicating if 
the first Collection object 
contains the entire second 
Collection object.

N/A

abs Absolute value operator, 
accepting a number and 
returning a number.

N/A

acos Arc cosine operator, accepting 
a number and returning a 
number.

N/A

add Addition operator, accepting 
two numbers and returning 
their sum.

N/A

asin Arc sine operator, accepting a 
number and returning a 
number.

N/A

atan Arc tangent operator, accepting 
a number and returning a 
number.

N/A

atan2 Cartesian to polar coordinates 
operator, accepting two 
numbers and returning a 
number.

N/A

ceil Ceiling operator, accepting a 
number and returning a 
number.

N/A

cos Cosine operator, accepting a 
number and returning a 
number.

N/A

divide Division operator, accepting 
two numbers and returning a 
number.

N/A

exp Exponential operator, 
accepting a number and 
returning a number.

N/A

floor Floor operator, accepting a 
number and returning a 
number.

N/A

ieee-

remainder

IEEE 754 remainder operator, 
accepting two numbers and 
returning a number.

N/A

log Natural logarithm operator, 
accepting a number and 
returning a number.

N/A

maximum Maximum operator, accepting 
two numbers and returning a 
number.

N/A

Table 10–3 (Cont.) Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values



Rules Control Reference

Creating Advanced Personalization with Rules 10-23

minimum Minimum operator, accepting 
two numbers and returning a 
number.

N/A

multiply Multiplication operator, 
accepting two numbers and 
returning a number.

N/A

pow Power of operator, accepting 
two numbers and returning a 
number.

N/A

random-

number

Random number operator, 
optionally accepts a lower and 
upper bound and returns a 
random number.

N/A

rint Round to next integer operator, 
accepting a number and 
returning a number.

N/A

round Round operator, accepting a 
number and returning a 
number.

N/A

sin Sine operator, accepting a 
number and returning a 
number.

N/A

sqrt Square root operator, accepting 
a number and returning a 
number.

N/A

subtract Subtraction operator, accepting 
two numbers and returning a 
number.

N/A

tan Arc tangent operator, accepting 
a number and returning a 
number.

N/A

to-degrees Radians to degrees operator, 
accepting a number and 
returning a number.

N/A

to-radians Degrees to radians operator, 
accepting a number and 
returning a number.

N/A

char-at Returns the character at the 
given position within the 
string, accepting a string and a 
number then returning a 
character.

N/A

compare-to-

ignore-case

String comparison operator 
that ignores case, accepting 
two strings and returning an 
integer.

N/A

concat String concatenation operator, 
accepting two strings and 
returning a string.

N/A

Table 10–3 (Cont.) Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values
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ends-with Returns a boolean indicating if 
the first string ends with the 
second string.

N/A

equals-ignore-c
ase

Returns a boolean indicating if 
the first string is the same as 
the second string, ignoring 
case.

N/A

length Accepts a string and returns an 
integer representing the 
number of characters in the 
string.

N/A

like Returns a boolean indicating if 
the second string is contained 
in the first string, ignoring 
case.

N/A

replace Accepts a string and two 
characters, returning a string 
that has the first character 
replaced by the second.

N/A

starts-with Returns a boolean indicating if 
the first string starts with the 
second string.

N/A

substring Accepts a string and two 
numbers, returning a string of 
the characters that fall within 
that number range from inside 
the given string.

N/A

to-lower-case Accepts a string, returning that 
same string converted to lower 
case.

N/A

to-upper-case Accepts a string, returning that 
same string converted to upper 
case.

N/A

trim Accepts a string, returning that 
same string but with any 
leading or trailing whitespace 
removed.

N/A

Table 10–3 (Cont.) Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values
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actions Instructions that are executed if 
the conditions are met. A 
group of zero or more action 
tags.

action

action One instruction that is 
executed if the conditions are 
met.

action (nested), method (defined above), add-object

add-object Adds an object of the type 
specified in the type-alias to 
working memory. Arguments 
are supplied as expressions, 
and the type of each argument 
is specified in the type-alias list 
in the arguments- signature. 
This is same functional 
definition as add instance 
above.

type-alias, arguments-signature, arguments

Table 10–3 (Cont.) Rules Control Elements for the Rules Engine

Rules Control 
Name Description All Possible Values
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Part III
Part III Staging

During the Staging phase, you test and modify the Property Sets, Content Selectors, 
User Segments, Placeholders, and Campaigns that you created in the Development 
phase. This staging environment simulates a production environment. 

Consider setting up a common development environment for the Development phase 
and the Staging phase. You might move iteratively between these two phases, 
developing and then testing what you created.

For a detailed description of the staging phase of the portal life cycle, see the Oracle 
Fusion Middleware Overview for Oracle WebLogic Portal. 

Part III contains these chapters:

■ Chapter 11, "Modifying Property Set Values"

■ Chapter 12, "Modifying a User Segment"

■ Chapter 13, "Modifying a Content Selector"

■ Chapter 14, "Modifying a Placeholder"

■ Chapter 15, "Managing a Campaign"





11

Modifying Property Set Values 11-1

11Modifying Property Set Values

Developing user interaction that uses Personalization and Campaigns can involve 
setting up properties (such as User Profile or Session properties) that are used to 
define the conditions under which users will be targeted with personalized content.

User Profile property sets contain conditions that identify users. For example, you 
could classify all users who ordered more than five on-demand movies in the last 30 
days. If visitors match the defined characteristics, they automatically become members 
of that User Segment and are shown specific web content with Content Selectors or 
they are targeted with Campaign actions.

This chapter describes how to change the values in your User Profile property sets. 
The properties are used in the conditions you define for your Personalization logic. 
Each user is dynamically served personalized web content or automatic e-mails based 
on the logic conditions.

Developers used Oracle Enterprise Pack for Eclipse when they created property sets 
and properties (see Chapter 4 for instructions on creating property sets and 
properties). Portal administrators can use the WebLogic Portal Administration Console 
to update property values.

This chapter includes the following sections:

■ Section 11.1, "Editing a Property Value"

■ Section 11.2, "Deleting a Property Value"

For information on setting up and managing users that will experience Interaction 
Management features, see the Oracle Fusion Middleware User Management Guide for 
Oracle WebLogic Portal.

11.1 Editing a Property Value
Developers can edit property sets, properties, and conditions in Oracle Enterprise Pack 
for Eclipse. You can edit the property values in the WebLogic Portal Administration 
Console.

11.1.1 Editing Properties in Oracle Enterprise Pack for Eclipse
Developers can use Oracle Enterprise Pack for Eclipse to modify properties or 
conditions and their values for User Profiles, User Segments, HTTP session or request 
data, date and time conditions, or events. For instructions, see Section 4.3, "Modifying 
Properties and Conditions."

When an attribute's value is requested for a particular user or group, and an attribute 
has not explicitly been assigned, then any default value assigned when the property 
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set attribute was created is returned. Editing a value using the Administration Console 
or tags overrides that default value, allowing personalization for that user or group.

Developers can use the <profile:setProperty> JSP tag in JSPs or the Property 
control in a Page Flow to modify existing property values for users.

11.1.2 Editing Property Values in WebLogic Portal Administration Console
Perform the following steps to modify a property's value:

1. Start the Administration Console.

2. Choose Users, Groups, & Roles > User Management.

3. Select a user store from the drop-down list above the Resource Tree.

4. Select the user in the Resource Tree.

5. Select the User Profile tab and use the drop-down list in the Profile Values for 
Property Set field to select the property set containing the value you want to edit.

6. In the Property Name field, locate the property value you want to change and 
click the Edit icon as shown in Figure 11–1.

Figure 11–1 Click Edit to Change the Property Value

7. Enter a new value in the Update Saved Value field and click Update. You can 
delete the value that is currently saved by clicking the Delete Saved Value check 
box. If you delete the saved value, a successor value is returned if one is defined. If 
a successor was not defined, the default value is returned. If there is no defined 
successor value or a default value, the property value is null.

Note: Page flows are a feature of Apache Beehive, which is an 
optional framework that you can integrate with WLP. See "Apache 
Beehive and Apache Struts Supported Configurations" in the Oracle 
Fusion Middleware Portal Development Guide for Oracle WebLogic Portal.
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11.2 Deleting a Property Value
You can use Oracle Enterprise Pack for Eclipse to delete individual properties from a 
property set, and you can delete an entire property set. See Section 4.4, "Deleting a 
Property or a Property Set" for instructions.

Perform the following steps to remove a property's value in the WebLogic Portal 
Administration Console:

1. Start the Administration Console.

2. Choose Users, Groups, & Roles > User Management.

3. Select a user store from the drop-down list above the Resource Tree.

4. Select the user in the Resource Tree.

5. Select the User Profile tab and use the drop-down list to select the property set 
that contains the value you want to remove. 

6. In the Property Name field, locate the property value you want to remove and 
click Edit. 

7. In the Edit Profile dialog box, select the Delete Saved Value check box to remove 
the value that is currently saved. (If you do not delete the saved value, a successor 
value is returned if one is defined. If a successor was not defined, the default value 
is returned. If there is no defined successor value or a default value, the property 
value is null.)

8. Click Update to save the property set file.
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12Modifying a User Segment

User Segments let you dynamically group users based on conditions you define. You 
can modify User Segments that you created in Chapter 5 by editing the segment's 
characteristics, such as gender, browser type, date or time, and so on. If a user matches 
the characteristics of a bookfan, for example, the user automatically and dynamically 
becomes a member of the bookfan User Segment. You can then target this User Segment 
group with web content and automatic e-mails based on the User Segment.

Developers use Oracle Enterprise Pack for Eclipse to create User Segments. Portal 
administrators can use the Administration Console to change the User Segment 
properties (conditions) to dynamically group users. Developer time is not required to 
update User Segment properties.

This chapter includes the following sections:

■ Section 12.1, "Modifying a User Segment"

■ Section 12.2, "Modifying a User Segment's Properties"

■ Section 12.3, "Copying a User Segment"

■ Section 12.4, "Removing a User Segment"

12.1 Modifying a User Segment
Developers can use Oracle Enterprise Pack for Eclipse to change the conditions and 
characteristics that determine how users are categorized with User Segments. Portal 
administrators use the WebLogic Portal Administration Console to edit the properties 
for the User Segment.

Perform the following steps to edit a User Segment file in Oracle Enterprise Pack for 
Eclipse:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, double-click the 
User Segment .seg file in the \<data>\src folder in the Package Explorer View.

2. Enter the changes in the User Segment Editor.

3. Save the file by choosing File > Save.

The changes will appear in the Administration Console.

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently. 
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12.2 Modifying a User Segment's Properties
Portal administrators can edit individual properties in a User Segment with the 
Administration Console.

Perform the following steps to edit a User Segment's properties in the Administration 
Console:

1. Start the Administration Console.

2. Choose Interaction > Segments.

3. In the Resource Tree, select the User Segment you want to edit. 

4. In the Segment Details tab, locate the segment property you want to change and 
click Edit the edit icon, as shown in Figure 12–1.

Figure 12–1 Click Edit to Change the User Segment Property

5. Enter your changes and click Save.

12.3 Copying a User Segment
Portal Administrators can save time and avoid errors by making a copy of a User 
Segment and then editing the properties in the new User Segment.

Perform the following steps in the Administration Console to duplicate a User 
Segment:

1. Start the WebLogic Portal Administration Console.

2. Choose Interaction > Segments.

3. Right-click a User Segment in the Resource Tree and choose Copy. 

4. Enter a name and description for the new User Segment, and click OK. 

The new User Segment now appears in the User Segments Resource tree. You can now 
modify the User Segment's properties; see Section 12.1, "Modifying a User Segment."

Tip: You can also duplicate a User Segment in Oracle Enterprise Pack 
for Eclipse.
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12.4 Removing a User Segment
Deleting a User Segment removes it from Oracle Enterprise Pack for Eclipse and from 
the Administration Console.

Perform the following steps to remove a User Segment:

1. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, select the User 
Segment .seg file in the \<data>\src folder in the Package Explorer View.

2. Right-click the segment and choose Delete.

3. Click Yes in the Confirmation dialog box.

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently.
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13Modifying a Content Selector

Developers can use Oracle Enterprise Pack for Eclipse to create Content Selectors and 
place them in a JSP. Portal administrators use the WebLogic Portal Administration 
Console to make changes to the Content Selectors that display content in the portal. 
Developer time is not required to update Content Selectors.

This chapter includes the following sections:

■ Section 13.1, "Modifying a Content Selector"

■ Section 13.2, "Deleting a Content Selector and Query"

13.1 Modifying a Content Selector
Content Selectors allow you to define the content you want a particular type of visitor 
to see. Modifying a Content Selector property allows you to change the content that is 
displayed.

Perform the following steps to modify a Content Selector property:

1. Start the Administration Console.

2. Choose Interaction > Content Selectors.

3. In the Resource Tree, select the Content Selector you want to edit. 

4. Select the Content Selector property and click the Edit icon, as shown in 
Figure 13–1.

Figure 13–1 Edit a Content Selector Property
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Depending on how the Content Selector was defined in Oracle Enterprise Pack for 
Eclipse, you can edit the following properties: 

■ Whether any or all conditions apply 

■ If the visitor belongs to specific User Segments 

■ If the visitor has certain characteristics 

■ The visitor's HTTP session 

■ The visitor's HTTP request 

■ The current date 

■ The current date is after a particular date 

■ The current date and time is after a particular date and time 

■ The current time is between two particular times 

■ The current date is between two particular dates 

■ The current date and time is between two particular dates and times 

■ The result of the content search 

5. Enter your change and click Save, as shown in Figure 13–2.

Figure 13–2 Change a Content Selector Property

6. To view your selections, click Show Previews. 

13.2 Deleting a Content Selector and Query
Deleting a Content Selector or a Content Selector query removes the Content Selector 
or the query from Oracle Enterprise Pack for Eclipse and the Administration Console. 
See Section 6.4, "Deleting a Content Selector Query" and Section 6.5, "Deleting a 
Content Selector" for instructions.

Tip: The Content Selector gets results from the Search cache, which 
might contain outdated Search results. Refreshing your browser does 
not clear the Search cache. You can flush the Search cache in the 
Administration Console by choosing Configuration & Monitoring > 
Service Administration. In the Resource Tree, expand Cache 
Manager. Select searchCache (you might need to click Next to see all 
the caches) and click Flush.

Tip: You should also delete any <pz:contentSelector> tags in your 
JSPs that reference the Content Selector you deleted.
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14Modifying a Placeholder

Placeholders display a single content item on a JSP. The content item is dynamically 
retrieved from the WLP Virtual Content Repository. A Placeholder retrieves content 
using predefined queries that are put in the Placeholder. Placeholders do not use 
conditions. Each query has a priority, or weight. 

A Placeholder stores queries, runs one query at a time, and displays one of the content 
items retrieved by the query. A Placeholder is made up of two parts: a Placeholder file 
you create in Oracle Enterprise Pack for Eclipse and a companion JSP tag that 
performs the processing.

Developers can use Oracle Enterprise Pack for Eclipse to create Placeholders and place 
them in a JSP. Portal administrators use the WebLogic Portal Administration Console 
to manage the content that populates Placeholders by modifying the default 
Placeholder query or modifying a Campaign. Developer time is not required to update 
Placeholders.

This chapter includes the following sections:

■ Section 14.1, "Changing Content for a Placeholder"

■ Section 14.2, "Modifying a Placeholder"

■ Section 14.3, "Deleting a Query or a Placeholder"

■ Section 14.4, "Managing Placeholders for Optimal Performance"

14.1 Changing Content for a Placeholder
When a content query in a Placeholder (a default Placeholder query or a query put in 
the Placeholder by a Campaign) returns multiple possible content items to a 
Placeholder, the Placeholder determines which content item to display.

For more information on changing the content a Placeholder displays, see Chapter 3 
and the Oracle Fusion Middleware Content Management Guide for Oracle WebLogic Portal.

Tip: During the development phase of your project when you are 
updating content frequently, consider disabling or flushing the portal 
caches. To do this, use the Portal Cache Manager tool. To start this 
tool, select Run > Portal Cache Manager in Oracle Enterprise Pack for 
Eclipse. 
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14.2 Modifying a Placeholder
Placeholders allow you to target content to a desired user (also called a visitor). You 
use the tools provided in the Administration Console to modify a Placeholder by 
editing the queries that determine the content displayed in a Placeholder on a JSP.

Perform the following steps to modify a Placeholder:

1. Start the Administration Console.

2. Choose Interaction > Placeholders and select the Placeholder and content search 
item in the Resource Tree, as shown in Figure 14–1.

Figure 14–1 Select the Placeholder and Content Item

3. In the Query Details tab, change the descriptor in the Content Query Properties 
section by clicking the bracketed text, as shown in Figure 14–2.

Figure 14–2 Change a Content Query
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4. In the pop-up window, select a new value for the descriptor and click Save. This 
descriptor governs what content is selected for display in the Placeholder. The 
value is based on a property set definition; typically it is a User Profile property 
set. 

5. To preview the modified content search for the Placeholder, click Show Previews. 

The content search for the Placeholder has been modified.

14.3 Deleting a Query or a Placeholder
Removing a Query or a Placeholder removes it from Oracle Enterprise Pack for Eclipse 
and from the WebLogic Portal Administration Console.

Perform the following steps to delete a query in a Placeholder:

1. In the Portal Perspective, double-click the Placeholder file in the 
<data>\src\placeholders folder in the Package Explorer View.

2. Select the query in the Editor window.

3. In the Content Search window, select the query and click Remove.

4. Click OK.

Perform the following steps to delete a Placeholder:

1. In the Portal Perspective, select the Placeholder file in the 
<data>\src\placeholders folder in the Package Explorer View.

2. Right-click the Placeholder file and choose Delete.

3. Click Yes to confirm the Placeholder deletion.

14.4 Managing Placeholders for Optimal Performance
Placeholders can become crowded with many queries, especially if more than one 
Campaign uses a Placeholder to display content. Campaign queries can remain in 
Placeholders indefinitely unless something specific occurs to remove them. 

Perform the following steps to remove unwanted queries and control the content that 
is displayed in a Placeholder:

1. When you create default queries in a Placeholder, you can designate that default 
queries do not run when a Placeholder contains Campaign queries:

Note: Developers might choose to modify a Placeholder in Oracle 
Enterprise Pack for Eclipse. Open the Placeholder file by 
double-clicking it in the Design Palette, and select and modify the 
appropriate query.

Note: The steps in this chapter refer to the data\src folder in the 
Package Explorer View. Your data and src directories might be named 
differently.

Tip: You should also delete any <ph:placeholder> tags in your JSPs 
for the deleted Placeholder.
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a. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, open a 
Placeholder file and select the default query.

b. In the Properties tab, set the Mix Globals property to false. This setting 
suppresses default queries when Campaign queries are present.

2. When you create a Content Action in a Campaign in Oracle Enterprise Pack for 
Eclipse, use the Remove (all) existing content option to minimize the number of 
queries held in a Placeholder at a given time.

3. For Campaign content actions, set the Time to Live (duration) field to an 
appropriate time so that the content action stops putting queries in the Placeholder 
when you want it to stop. Locate the Time to Live field in the Administration 
Console by choosing Configuration & Monitoring > Service Administration. 
Then select Personalization in the Resource Tree and click Cache Manager in the 
Service List tab. Click a specific cache name to edit the Time to Live field.

4. To control the Campaign content that is displayed in a Placeholder, create a 
content action for each event that occurs. Use the previous recommendations to 
display a fresh rotation of content in the Placeholder.

5. To stop events from firing and placing content in a Placeholder, reset the existing 
content as described in Section 8.5, "Turning Off a Campaign."
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Developers can use Oracle Enterprise Pack for Eclipse to create a Campaign and 
display it in a JSP. Portal administrators use the WebLogic Portal Administration 
Console to make changes to the Campaign, including the rules, start or stop date, the 
sponsor, and so on.

Developer time is not required to modify a Campaign. A Portal administrator can also 
duplicate an existing Campaign and then modify the new Campaign.

This chapter contains the following sections:

■ Section 15.1, "Modifying a Campaign"

■ Section 15.2, "Modifying a Rule"

■ Section 15.3, "Managing a Campaign for Optimal Performance"

15.1 Modifying a Campaign
Portal administrators can avoid creating new Campaigns by modifying existing 
Campaigns in the following ways:

■ Section 15.1.1, "Changing a Campaign's Description or Sponsor"

■ Section 15.1.2, "Changing a Campaign Start or Stop Date"

■ Section 15.1.3, "Activating and Deactivating a Campaign"

■ Section 15.1.4, "Turning Off a Campaign"

■ Section 15.1.5, "Resetting Campaign Settings"

■ Section 15.1.6, "Duplicating a Campaign"

15.1.1 Changing a Campaign's Description or Sponsor
You can change the text describing a Campaign; however, you cannot change the 
Campaign's name. You can also edit the Sponsor field, which describes the purpose of 
the Campaign or who it affects.

Perform the following steps to update a Campaign's description or sponsor:

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign whose description or sponsor you want 
to modify.

4. In the Campaign Details tab, click Name & Description.
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5. Enter the new Description or Sponsor. The Sponsor field describe the purpose of 
the Campaign or who it affects.

6. Click Save.

15.1.2 Changing a Campaign Start or Stop Date
Perform the following steps to change a Campaign start or stop date:

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign you want to modify. 

4. In the Campaign Details tab, click Campaign Properties, as shown in Figure 15–1.

Figure 15–1 Change a Campaign Property

8. Click the calendar icon next to the Start Date or Stop Date fields. Use the 
month and year drop-down menus to select the month and year. You can also 
use the left and right arrows at the top of the Calendar window to select the 
month and year. Select a number in the Date section to select a day. Use the up 
and down arrows in the Time section to select a specific time of day. You must 
click each field in the Time section before you can modify it and click Done.

9. Click Save in the Edit Campaign Properties dialog to save the Campaign's 
new start or stop dates. 

10. Click Reset Campaign for the new dates to take effect.

15.1.3 Activating and Deactivating a Campaign
Perform the following steps to start a Campaign:

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign you want to activate. 
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4. In the Campaign Details tab, click Campaign Properties.

5. In the Edit Campaign Properties window, click the Status drop-down list, select 
Active, and click Save, as shown in Figure 15–2.

Figure 15–2 Select Active to Start a Campaign

6. In the Campaign Details tab, click Reset Campaign for the new dates to take 
effect.

The Campaign is now active.

Perform the following steps to stop a Campaign:

1. Start the Administration Console.

2. Choose Interaction > Campaigns

3. In the Resource Tree, select the Campaign you want to deactivate. 

4. In the Campaign Details tab, click Campaign Properties.

5. In the Edit Campaign Properties dialog, click the Status drop-down list, select Not 
Active, and click Save. 

6. In the Campaign Details tab, click Reset Campaign for the new dates to take 
effect.

The Campaign is no longer active. The targeted user will see default content rather 
than specific Campaign content in the Campaign's Placeholder.

15.1.4 Turning Off a Campaign
To turn off a Campaign so that is does not fire Campaign events, you can remove the 
CampaignEventListener.

Perform the following steps to turn off a Campaign:

1. Start the Administration Console.

2. Choose Configuration & Monitoring > Service Administration.

3. In the Resource Tree, expand the Personalization folder and select Event Service.

4. In the Browse tab, select the Delete check box next to the 
com.bea.campaign.internal.CampaignEventListener class and click 
Delete. Campaign events will no longer be fired, but if you set up other Behavior 
Tracking or other event listeners, those events will continue to fire.

Tip: The following steps in the WebLogic Portal Administration 
Console work for a portal that is deployed as an exploded EAR file. If 
your portal is a compressed EAR file, you will need to do these steps 
manually and then re-build and deploy the EAR file.
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15.1.5 Resetting Campaign Settings
You can reset specific Campaign components.

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign you want to reset. 

4. In the Campaign Details tab, click Reset Campaign. 

5. In the dialog, click Reset Campaign to reset all of the Campaign components.

15.1.6 Duplicating a Campaign
You can save time and reduce errors by creating a copy of a Campaign and then 
making changes to it.

Perform the following steps to duplicate a Campaign:

1. Start the Administration Console.

2. Choose Interaction > Campaigns

3. In the Resource Tree, select the Campaign you want to copy.

4. Right-click the Campaign, and choose Copy.

5. In the Copy Campaign dialog, enter the name and a description for the new 
Campaign and click OK. 

The new Campaign appears in the Resource Tree.

15.2 Modifying a Rule
As an administrator, you can modify a content action within a Campaign to change the 
content query, change the Placeholder, change the conditions, and so on. 

Campaigns can include the following actions:

■ Section 15.2.1, "Modifying a Content Action"

■ Section 15.2.2, "Modifying an E-Mail Action"

■ Section 15.2.3, "Previewing a Modified Campaign Action"

15.2.1 Modifying a Content Action
Perform the following steps to modify a Content Action in a Campaign:

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign, the scenario, and the rule you want to 
modify.

4. In the Rule Details tab, click the Edit icon next to the condition you want to 
change, as shown in Figure 15–3.

Note: If you want to activate the Campaign later, add the 
CampaignEventListener as a Synchronous Listener in the Browse tab.
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Figure 15–3 Click Edit to Change a Content Action

For example, you can change the following items:

■ Bind a variable

■ Invoke an instance method

■ If the visitor has specific characteristics 

■ If the visitor is a member of a predefined User Segment 

■ The visitor's HTTP session has specific properties

■ The visitor's HTTP request has specific properties

■ An application property has specific values

■ An event has specific characteristics

■ An event has occurred

■ The event characteristics 

■ The current date 

■ The current date is after a particular date 

■ The current date and time is after a given date and time 

■ The current time is between two particular times 

■ The current date is between two particular dates 

■ The current date and time are between two particular dates and times 

■ A random number between one and 100 that falls between one and 100 (this 
defines 100 percent of the qualifying visitors) 

5. Make the changes and click Save.

6. After you modify the Content Action characteristics, you can modify the Content 
Action further by specifying the specific content to retrieve for the visitor and the 
specific Placeholder for it. To modify the retrieved content, click Edit next to the 
property in the Action Properties section in the Rule Details tab.

7. Make the changes and click Save.
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15.2.2 Modifying an E-Mail Action
As an administrator, you can modify an E-mail Action within a Campaign to change 
the action conditions, descriptions, User Segments, and so on. 

Perform the following steps to modify an e-mail action:

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign, scenario, and e-mail action rule you 
want to modify.

4. In the Rule Details tab, click ANY or ALL to determine if any or all conditions 
apply.

5. Click Edit next to a condition.

6. Make the changes and click Save.

7. Specify the e-mail action to perform by clicking Edit next to the action.

8. You can change the e-mail location, title, and sent by address and click Save.

15.2.3 Previewing a Modified Campaign Action
Portal administrators can use the Administration Console to preview a modified 
Content Action, E-mail Action, or Discount Action in a Campaign. 

You can modify any of these actions in the Administration Console by changing the 
conditions or content queries of these actions. After changing an action, you can 
preview it to verify the change is correct.

Perform the following steps to preview a modified Campaign Action:

1. Start the Administration Console.

2. Choose Interaction > Campaigns.

3. In the Resource Tree, select the Campaign, scenario and action rule that you want 
to modify.

4. Modify the conditions and actions for the Discount, E-mail, or Content Action and 
save your changes.

5. In the Resource Tree, select the modified rule to display in the Rule Details tab.

6. Click Show Previews. The modified content does not show in the preview until 
you refresh the tree.

7. Close the Resource Tree and then expand it to refresh it. 

8. In the Resource Tree, select the Campaign and subsequent action you want to 
preview. 

9. Click Show Previews to see the modified content.

15.3 Managing a Campaign for Optimal Performance
Placeholders can become crowded with many queries, especially if more than one 
Campaign uses a Placeholder to display content. Campaign queries can remain in 
Placeholders indefinitely unless something specific occurs to remove them. 

Perform the following steps to remove unwanted queries and control the content that 
is displayed in a Placeholder:



Managing a Campaign for Optimal Performance

Managing a Campaign 15-7

1. When you create default queries in a Placeholder, perform the following steps to 
designate that default queries do not run when a Placeholder contains Campaign 
queries:

a. In the Portal Perspective in Oracle Enterprise Pack for Eclipse, open the 
Placeholder file in the \<data>\src\placeholders folder in the Package 
Explorer View.

b. Select the default query by selecting the Placeholder Editor tab.

c. In the Properties tab, set the Mix Globals property to false. This setting 
suppresses default queries when Campaign queries are present.

2. When you create a Content Action in a Campaign in Oracle Enterprise Pack for 
Eclipse, use the Remove (all) existing content option to minimize the number of 
queries held in a Placeholder at a given time.

3. For Campaign content actions, set the Time to Live (duration) field to an 
appropriate time so that the content action stops putting queries in the Placeholder 
when you want it to stop. Locate the Time to Live field in the Administration 
Console by choosing Configuration & Monitoring > Service Administration. 
Select Cache Manager in the Resource Tree and click a specific cache name to edit 
the Time to Live field.

4. To control the Campaign content that is displayed in a Placeholder, create a 
Content Action for each event that occurs. Use the previous recommendations to 
display a fresh rotation of content in the Placeholder.

5. To clear any content that has been put in a Placeholder, reset the previously placed 
content using the reset feature as described in Section 15.1.5, "Resetting Campaign 
Settings."

6. Enable Campaign content caches by following the steps in Section 8.6.2.1, "Setting 
Campaign Content Caches."
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Part IV
Part IV Production

The Production phase allows you to update and change Personalization in your 
production environment.

Some of the Interaction Management tasks you can perform in the Production phase 
could include the following:

■ Change a Campaign to revise its end date – See Section 15.1, "Modifying a 
Campaign".

■ Edit a Placeholder or Content Selector to change the content they display – See 
Section 7.3, "Modifying a Placeholder" or Section 6.4, "Deleting a Content Selector 
Query".

■ Update property set properties to change your audience – See Section 4.3, 
"Modifying Properties and Conditions".

■ Fine tune Content Selectors to change how often content is refreshed – See 
Section 13.1, "Modifying a Content Selector".

■ Enable an audit trail of content changes to the virtual content repository – See 
Section 9.13, "Tracking Content Changes".

■ Add custom events, listeners, and property sets to a deployed application – These 
changes require application redeployment for the events and CLASSPATH 
updates, and you must run the Propagation Utility to update the event properties 
in the database. See the Oracle Fusion Middleware Production Operations Guide for 
Oracle WebLogic Portal.

If you change Personalization features in your portal application in the Production 
phase, you should return to the Staging phase to test the functionality. This staging 
environment should simulate a Production environment. The one exception to this 
process is using the rules files. During development, the rules files reload when they 
change (just like JSPs), so you can quickly develop with Content Selectors. However, 
when the server is in production mode, Content Selectors are loaded into the database 
(from the file-based definitions in the application) where they can be modified in the 
WebLogic Portal Administration Portal without redeploying the application or 
restarting the server.

The Production phase can be ongoing; you can move iteratively between the Staging 
phase and the Production phase.

You might also modify other features, such as Delegated Administration and Visitor 
Entitlement roles and assignments, in the Production phase. See the Security Guide for 
more information.

For a detailed description of the production phase of the portal life cycle, see the Oracle 
Fusion Middleware Overview for Oracle WebLogic Portal. 
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